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Important Information

SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH
EMBEDDED OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR
PROVIDE LIMITED ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE
EMBEDDED OR BUNDLED SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY
OTHER TIBCO SOFTWARE OR FOR ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND
CONDITIONS OF A LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED
SOFTWARE LICENSE AGREEMENT, OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE
CLICKWRAP END USER LICENSE AGREEMENT WHICH IS DISPLAYED DURING DOWNLOAD
OR INSTALLATION OF THE SOFTWARE (AND WHICH IS DUPLICATED IN THE LICENSE FILE)
OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR CLICKWRAP END USER
LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF THE
SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE
BOUND BY THE SAME.

This document contains confidential information that is subject to U.S. and international copyright laws
and treaties. No part of this document may be reproduced in any form without the written
authorization of TIBCO Software Inc.

TIBCO, Two-Second Advantage, TIBCO ActiveMatrix BPM, TIBCO Administrator, TIBCO Business
Studio, TIBCO Enterprise Message Service, TIBCO General Interface, TIBCO Hawk, TIBCO iProcess,
TIBCO JasperReports, TIBCO Spotfire, TIBCO Spotfire Server, and TIBCO Spotfire Web Player are
either registered trademarks or trademarks of TIBCO Software Inc. in the United States and/or other
countries.

Enterprise Java Beans (EJB), Java Platform Enterprise Edition (Java EE), Java 2 Platform Enterprise
Edition (J2EE), and all Java-based trademarks and logos are trademarks or registered trademarks of
Oracle Corporation in the U.S. and other countries.

All other product and company names and marks mentioned in this document are the property of their
respective owners and are mentioned for identification purposes only.

THIS SOFTWARE MAY BE AVAILABLE ON MULTIPLE OPERATING SYSTEMS. HOWEVER, NOT
ALL OPERATING SYSTEM PLATFORMS FOR A SPECIFIC SOFTWARE VERSION ARE RELEASED
AT THE SAME TIME. SEE THE README FILE FOR THE AVAILABILITY OF THIS SOFTWARE
VERSION ON A SPECIFIC OPERATING SYSTEM PLATFORM.

THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL
ERRORS. CHANGES ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE
CHANGES WILL BE INCORPORATED IN NEW EDITIONS OF THIS DOCUMENT. TIBCO
SOFTWARE INC. MAY MAKE IMPROVEMENTS AND/OR CHANGES IN THE PRODUCT(S)
AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE,
INCLUDING BUT NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

Copyright © 2005-2017 TIBCO Software Inc. All rights reserved.

TIBCO Software Inc. Confidential Information
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TIBCO Documentation and Support Services

Documentation for this and other TIBCO products is available on the TIBCO Documentation site. This
site is updated more frequently than any documentation that might be included with the product. To
ensure that you are accessing the latest available help topics, visit:

https://docs.tibco.com

Product-Specific Documentation

Documentation for TIBCO products is not bundled with the software. Instead, it is available on the
TIBCO Documentation site. To directly access documentation for this product, double-click the
following file:

TIBCO_HOME/release_notes/TIB_amx-bpm_version_docinfo.html

where TIBCO_HOME is the top-level directory in which TIBCO products are installed. On Windows,
the default TIBCO_HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME is /opt/tibco.

The following documents for this product can be found on the TIBCO Documentation site:

● TIBCO ActiveMatrix BPM SOA Concepts

● TIBCO ActiveMatrix BPM Concepts

● TIBCO ActiveMatrix BPM Developer's Guide

● TIBCO ActiveMatrix BPM Web Client Developer's Guide

● TIBCO ActiveMatrix BPM Tutorials

● TIBCO ActiveMatrix BPM Business Data Services Developer Guide

● TIBCO ActiveMatrix BPM Case Data User Guide

● TIBCO ActiveMatrix BPM Event Collector Schema Reference

● TIBCO ActiveMatrix BPM - Integration with Content Management Systems

● TIBCO ActiveMatrix BPM SOA Composite Development

● TIBCO ActiveMatrix BPM Java Component Development

● TIBCO ActiveMatrix BPM Mediation Component Development

● TIBCO ActiveMatrix BPM Mediation API Reference

● TIBCO ActiveMatrix BPM WebApp Component Development

● TIBCO ActiveMatrix BPM Administration

● TIBCO ActiveMatrix BPM Performance Tuning Guide

● TIBCO ActiveMatrix BPM SOA Administration

● TIBCO ActiveMatrix BPM SOA Administration Tutorials

● TIBCO ActiveMatrix BPM SOA Development Tutorials

● TIBCO ActiveMatrix BPM Client Application Management Guide

● TIBCO ActiveMatrix BPM Client Application Developer's Guide

● TIBCO Openspace User's Guide

● TIBCO Openspace Customization Guide

● TIBCO ActiveMatrix BPM Organization Browser User's Guide (Openspace)

● TIBCO ActiveMatrix BPM Organization Browser User's Guide (Workspace)
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● TIBCO ActiveMatrix BPM Spotfire Visualizations

● TIBCO Workspace User's Guide

● TIBCO Workspace Configuration and Customization

● TIBCO Workspace Components Developer Guide

● TIBCO ActiveMatrix BPM Troubleshooting Guide

● TIBCO ActiveMatrix BPM Deployment

● TIBCO ActiveMatrix BPM Hawk Plug-in User's Guide

● TIBCO ActiveMatrix BPM Installation: Developer Server

● TIBCO ActiveMatrix BPM Installation and Configuration

● TIBCO ActiveMatrix BPM Log Viewer

● TIBCO ActiveMatrix BPM Single Sign-On

● Using TIBCO JasperReports for ActiveMatrix BPM

How to Contact TIBCO Support

For comments or problems with this manual or the software it addresses, contact TIBCO Support:

● For an overview of TIBCO Support, and information about getting started with TIBCO Support,
visit this site:

http://www.tibco.com/services/support

● If you already have a valid maintenance or support contract, visit this site:

https://support.tibco.com

Entry to this site requires a user name and password. If you do not have a user name, you can
request one.

How to Join TIBCO Community

TIBCO Community is an online destination for TIBCO customers, partners, and resident experts. It is a
place to share and access the collective experience of the TIBCO community. TIBCO Community offers
forums, blogs, and access to a variety of resources. To register, go to the following web address:

https://community.tibco.com
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Introduction

TIBCO® Workspace (simply called “Workspace” throughout the documentation) is a Business Process
Management (BPM) application that runs over the internet or an intranet.

To run Workspace, you start an Internet browser, then enter a web address that points to the Workspace
application.

Workspace interacts with a server to authenticate you (log in) so that you can access the information
needed to perform your job. (Descriptions of the server is beyond the scope of this document.)

As a BPM application, Workspace is used to manage your business processes. It allows you to perform
the following types of functions:

● View your “work items”. Each work item represents of some sort of function you are responsible for
performing. This could consist of things like filling out a form, reviewing information, approving/
denying an application, etc. It depends on the design of your application.

— Your work item list may contain work items that were sent specifically to you. These work items
are flagged in the list as “allocated” so that you know they have been allocated specifically to
you.

— Or your work item list may contain work items sent to a “group” of users of which you are a
member — all members of the group (for example, “loan reviewer” group) receive the work
item in their work item list, and any of the members can work on that work item. These work
items are flagged in the list as “offered” so that you know they have been offered to all users in
the group.

● Apply filter and/or sort parameters so that only the desired work items are listed in the desired
order in your work list (inbox).

● Open individual work items.

● Enter information into forms that are displayed when you open a work item.

● Start a business service.

● View instances of processes that are started by business services.

While these are the primary functions you’ll be performing, there are many additional functions that
can be performed with Workspace. These are described in the remainder of this document.

Each company that uses Workspace will customize it to fit their specific needs. Each company defines
their own business processes, based on the industry they are in. For instance, one company may have a
business process for processing an auto loan, whereas another company amy design one for processing
an insurance claim.
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Understanding a Business Process
At the heart of Workspace is the “process”, which defines the flow of information in your application.
Processes are defined with a TIBCO tool called TIBCO Business Studio™.

A process consists of a number of “tasks,” including manual tasks (which require user action),
automatic tasks (which are executed automatically by the server), and conditional tasks, as knows as
“gateways” (which branch based on the result of a condition).

An example of a very simple process is shown below.

Someone using Workspace starts an “instance” of a process, which typically causes a form to be
displayed, onto which the user enters information. For example, if the process defines the processing of
a loan application, the first screen may involve entering demographic information for the applicant. The
next task might involve another person reviewing the application — the process would be defined such
that the information entered in the application screen is automatically sent to the person(s) responsible
for reviewing it. The application will progress through the tasks of the process until it is completed.

The following table provides definitions of terms that are used throughout this document and in your
Workspace.

Term Description

Process Represents the definition of a business process, which ensures that information
flows in a consistent and timely manner through the system. A process is
defined using TIBCO Business Studio. An example is shown in the illustration
above.

Workspace displays a list of all available processes. When you select a process
from the list, Workspace displays another list of the instances of that process
that had been started in the past.

Process instance A process instance is created when a process is “started,” and remains in
existence until that instance of the process is purged from the system.

As mentioned above, when you select a process from the list, Workspace
displays a list of the instances of that process that had been started in the past.

Process instances are typically started when you start a “business service”. A
business service is a set of actions that accomplishes some sort of business
function. For example, a business service could be designed to handle an
incoming insurance claim.

Inbox This is analogous to an Inbox in an email program. It contains work items (see
below) that you can open and work on.

You can also create additional “views” of your Inbox, which are your Inbox
filtered and/or sorted in a different way. Each view contains a subset of the
work items in your Inbox.

12

TIBCO® Workspace User's Guide



Term Description

Work Item A work item represents an action item. It relates to a task in an active process
instance. A user manages the work items in their work list by performing some
sort of action upon them, such as entering data on a form, forwarding the item
to another user or group, saving it and placing it back in the work list for
further action at a later time, or by “submitting” it (completing the required
action and sending it on to the next task in the process).

Workspace displays a list of all work items that have been allocated specifically
to you, or offered to you because you are a member of the group to which the
work item was sent. These work items are listed in your Inbox (see above).

You may not necessarily need to understand the entire structure of the process(es) you are working on.
Generally, users are focused on performing some sort of work on the work items that appear in their
Inbox. The type of work you perform will depend on the type of business you are in and how your
process was designed.

The Workspace Screen Layout
Workspace provides a number of layout options, allowing you to choose the orientation and location of
components on the screen.

The layout options are as follows:

● Side-by-side - All lists are docked on the left and the right, and the view selection buttons are
displayed in the lower left part of the screen.

● Stacked - All views are displayed on the top of the screen, as tabs, and work item, process instance,
and business service lists are displayed on the bottom part of the screen.

● Floating - All lists are displayed as floating windows. For each floating window, a button is
displayed in the task bar, which when clicked, brings the corresponding window to the front.

Note that the side-by-side layout is the default when Workspace is first started. Therefore, throughout
this document, the side-by-side layout is shown when describing the functions in the application.

Screen layout is modified using user options. For information about this user option, see Layout.

Using the side-by-side layout option, the following illustrates the primary sections of the Workspace
screen:
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These sections are described below.

● The View Type Selection section contains Work Views, Process Views, Case Views, and Event
Views buttons that, when clicked, display your personalized views (see below) for that type of item
in the Views section.

Note that this section also contains two buttons that present “view-like” displays, although that are
not technically views in the sense that you cannot create custom views of these. They are:

— Business Services: This button presents a file/directory-like display of the business services
available to you. For more information, see Accessing Workspace.

— Organization Browser: This button displays a graphical representation of the organization
model for the purpose of mapping resources to groups and positions that are available in the
organization model. For more information, see the Organization Browser User’s Guide. (Note that
the Organization Browser is inaccessible by default — the appropriate user access control must
be enabled for the Organization Browser button to appear. For more information, see Accessing
the Organization Browser).

● The Views section contains one or more views of the following types:

— Work Views - When you click a work view, the work items in that view are displayed in the
Details List. You will always have one view named “Inbox”. You can create additional views
that list work items filtered and/or sorted in different ways.

— Process Views - When you click a process view, the process instances in that view are listed in
the Details List.

Note that by default there are no process views shown. You must create a process view using
the provided wizard.

— Event Views - When you click an event view, the list of events stored in that view is displayed.
— Case Views - When you click a case view, the list of case views that have been created is

displayed.

Note that if the Business Services button is clicked in the View Type Selection area, the Views
area will contain a list of the business services that are available. Technically, this list is not a
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view, although it is displayed in the same area as other views. For more information, see 
Accessing Workspace.

If the Organization Browser button is clicked in the View Type Selection area, the Views area
will contain a graphical representation of the organization model for the purpose of mapping
resources to groups and positions that are available in the organization model. For more
information, see the Organization Browser User’s Guide.

For more information about using and creating views, see Views.

● The Detailed List section shows lists of individual work items, process instances, or events,
depending on the type of view you had selected. You can select one of the individual work items or
process instances in the list to perform some sort of function or view information about it.

For information about working with each of the types of items that can appear in the Detailed List
section, see the following:

— Accessing Workspace

— Work Items

— Process Instances

● The Preview Pane is an area of the screen in which either summary or detail information is
displayed, depending on what you are viewing and how you selected it.

The preview pane can be turned on or off, as desired. For more information, see Using the Column
Selector.

The Preview Pane
The preview pane is the lower right area of the screen, in which you can display summary information
about work items or process instances that you have selected in their respective lists. Work item forms
can also be opened in the preview pane rather than in a floating window.

Default preview pane settings for both the work item and process instance lists are available in user
options. The default settings specify in user options are the initial preview settings on all work item and
process instance lists until it is changed for a specific list via the procedure described in this section.
Once a preview setting is specified for a specific list, that setting is persisted for that list. All other lists
will continue to use the default setting in user options until their preview setting is changed using the
procedure described in this section.

To change the preview setting for the currently displayed list, select Preview from the View menu on
either the work item list or process instance list. One of the menus shown below is displayed:

Preview menu from the work item list:

Preview menu from the process instance list:

The preview pane options are as follows:
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● Show Preview - Dock Forms/Details in Preview Pane: When you select (single-click) a work item or
process instance in their respective list, the work item or process instance summary is displayed in
the preview pane.

When you open (double-click) a work item or process instance, the work item form or process
instance details are displayed in the preview pane, replacing the summary information.

● Show Preview - Float Forms/Details: When you select (single-click) a work item or process instance
in their respective list, the work item or process instance summary is displayed in the preview pane.

When you open (double-click) a work item or process instance, the work item form or process
instance details are displayed in a floating window.

● Preview Off - Float Forms/Details: When the preview pane is turned off, single-clicking a work
item or process instance in their respective lists has no effect.

When you open (double-click) a work item or process instance, the work item form or process
instance details are displayed in a floating window.

Selections you make on the Preview menu are applied only to the currently displayed list, and they are
persisted for that specific list. Note that persisted settings are saved on the server, so if you log onto a
different machine, those settings will be in effect on that machine also.

Resizing the Preview Pane

You can specify that the preview pane automatically resize when you open a work item or a process
instance. For instance, you may want the process instance details to open so that the preview pane
encompasses 80% of the right side of the dialog. It will then revert to its original size when you close
the work item or process instance.

To configure the preview pane to automatically resize, see Work Item Preview and Appearance Options
for work item lists and process instance lists, respectively.

Floating Windows

If you are choosing to display the work item form in a floating window, the floating window may be
either a dialog or a separate browser window, depending on the setting of a user option for the logged-
in user.

For more information, see Work Item Forms.

The following shows you the general differences in appearance between a dialog and a separate
browser window. Note, however, that there are configuration settings available to the system
administrator that allows some customization of separate browser windows, such as whether the
window is resizable, whether a status line is shown in the window, etc. Therefore, if you are displaying
work item forms in separate browser windows, they may appear somewhat different then what is
shown below.
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Work Item Form in a Dialog:

Work Item Form in a Separate Browser Window:

If you are choosing to display process instance details in a floating window, the floating window will
always be a dialog — process instance details cannot be displayed in a separate browser window.

If Workspace is configured to open work item forms in a separate browser window, but a pop-up
blocker or an error condition prevents the window from opening, the form will instead automatically
be opened in a dialog.

Moving a Floating Window

You can move a floating window around the screen by placing the cursor in the window’s header bar,
then clicking and holding the left mouse button while moving the window to the desired location.

Resizing a Floating Window

Floating windows provide the following methods of resizing the window.

● Minimize Toggle - Clicking this button causes the window to minimize — the window is removed
from the screen, and a button representing the window appears on the task bar.

17

TIBCO® Workspace User's Guide



Note, however, if you are displaying a dialog, the button representing the window appears in the
task bar of the Workspace; if you are displaying a separate browser window, the button appears in
the main task bar of your computer.

Click the button on the task bar to cause the window to reappear.

● Maximize Toggle - Clicking this button toggles between the window expanding to cover the entire
screen, and collapsing to its original size.

Note that the “x” button in the upper-right corner of the floating window is a “close” button.

— If you are displaying a work item form in a floating window, do not close the window using
this button — the window will close, but the work item will remain open (and locked),
requiring you to use the Cancel Work Item function to close it, which will result is a loss of data
that had been entered on the form (see Canceling Changes).

Work item forms should be closed using the buttons provided on the form.

— If you are displaying process instance details in a floating window, closing the window using
the “x” button is acceptable.

● Dragging to Desired Size - You can resize a floating window by placing the cursor in the lower
right corner of the floating window, pressing and holding the left mouse button, then moving the
mouse to resize the window to the desired size. (Note - If you are displaying floating windows in
separate browser windows, you may be unable to do this, depending on a configuration setting.)

Lists
Much of the information you work with in Workspace is displayed in lists of various sorts — work item
lists, process instance lists, event lists, etc.

There are a number of common functions available from these lists that are described below:

● Selecting items in a list — see Selecting Items in a List

● Refreshing information in a list — see Refreshing Information in a List

● Customizing columns in a list — see Customizing Columns in a List

● Number of items in a list — Number of Items in a List

● List page size — List Page Size

Selecting Items in a List
The way in which you select items in a list depends on the type of list you are viewing.

Views List

In the lists of views, you can only select one view at a time. To select a view:

● Click the desired line with the cursor, or

● use the keyboard up/down arrow keys to move the highlight up or down to select the desired item.
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Selecting a view causes the work items, process instances, or events that are in that view to be displayed
in the Detailed List section to the right.

Work Item Lists and Process Instance Lists

The effect of selecting an item from the work item or process instance list depends on whether or not
the preview feature is turned on (see Using the Column Selector):

● If preview is turned off, selecting an item from the work item or process instance list has no effect.

● If preview is turned on:

— selecting a work item from the work item list causes the work item summary to be displayed in
the preview pane section.

— selecting a process instance from the process instance list causes the process instance summary
to be displayed in the preview pane section.

Event Lists

Only a single event can be selected at one time in an event list. Selecting an event causes the attributes
pertaining to that event to be displayed in the lower right pane.

Case View Lists

Selecting a case view causes a list of the case references that satisfy the filter criteria for the case view to
be displayed in the upper-right pane.

Only a single case view can be selected at one time.

Selecting a Single Item

For many functions, you will select a single item in a list.

To select a single item in a list, either:

● click the desired line with the cursor, or

● use the keyboard up/down arrow keys to move the highlight up or down to the desired item.

The selected item is shown in a different color than the rest of the items in the list:
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Note that double-clicking an item on a work item or process instance list opens that item. When you
open a work item, the work item form is displayed. When you open a process instance, the process
instance details are displayed in a tabbed window.

For more information about working with work items and process instances, see Work Items and 
Process Instances, respectively.

Selecting Multiple Items

You can also select multiple items at one time on the work item and process instance lists, as some of
the functions available from these lists can be applied to more than one item at a time (e.g., Open
Selected Work Item(s)).

Note, however, if you select multiple items in a work item list or process instance list, and have the
preview feature turned on, the preview pane will show the summary information only for the last work
item / process instance selected.

You cannot select multiple views. Each view must be looked at individually.

To select multiple items that are not grouped together:

● Select one of the desired items, press and hold the Ctrl key, then click the other desired items. All
selected items are shown in a different color than the rest of the items in the list.

To select multiple items in a list that are grouped together:

● Select the first item in the group, press and hold the Shift key, then either click the last item in the
group, or move the arrow key until all desired items are selected. All selected items are shown in a
different color than the rest of the items in the list.
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Also notice that if you move the scroll bar with the cursor to locate an item to select in the list, help text
is displayed that tells you which rows in the list are currently being displayed. See the example below:

Refreshing Information in a List
The work item and process instance lists contain a snapshot of the information in the list when the list
was displayed.

For example, if you click on a work view to display a list of work items, the list contains all of the work
items (possibly filtered) at the moment the list was displayed. It is not automatically updated to provide
the latest items. You must “refresh” the list to get the latest information from the server.

Refresh a list by clicking the Refresh button in the window containing the list, or by selecting Refresh...
from the View menu.

The Refresh button is always the right-most button on lists that can be refreshed.

Note that refreshing the list causes Workspace to ask the server to re-send the information in the list.
This can take some time, depending on the number of items in the list, the speed of your computer, etc.

If you are working with a work item list, you can also specify that the list automatically refresh at
specified intervals. For information see, Auto-Refresh of Work Item Lists.

Customizing Columns in a List
The very first time you display each type of list (work item, process instance, or event list), a pre-
determined default set of columns is displayed. This set of columns will continue to be displayed until
you change them using the Column Selector.

For information about using the Column Selector, see Using the Column Selector.
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The Column Default

Each list type has an initial default set of columns. You can change the default set of columns by

displaying the desired columns, then clicking the  button or selecting Set as Default Columns from
the View menu. This selection causes the set of columns, and their widths and positions, for the
currently displayed list, to become the new default for that list type.

After you select Set as Default Columns, all new lists of that type, plus all existing lists of that type will
now display the columns you specified as the default, except lists on which you have specified columns
using the Column Selector.

Lists on which you had previously set columns using the Column Selector will continue to use the
columns you specified until you explicitly change them again using the Column Selector, or you click
the Use Default button on the Column Selector, which causes that particular list to use the currently set
default.

Using the Column Selector

The Column Selector allows you to customize the columns for a particular list — it does not affect the
columns in other lists. For instance, if you customize the columns for your Inbox, the columns in your
other work views are not affected.

There is no Column Selector available in case view lists.

Columns displayed via the Column Selector are persisted until you change them again. Note that
persisted settings are saved on the server, so if you log onto a different machine, those settings will be in
effect on that machine also.

Each column in a list represents an attribute, which holds information about some aspect of the item in
the list. Note, however, that there are differences in the way the columns are listed in the Column
Selector, as described below:

● Work item list - All available columns are listed in alphabetical order — see the illustration in step 1
below.

● Process instance list - Both System and Custom columns are listed in the Column Selector(1). System
columns/attributes contain information that the system entered in the attribute, such as the instance
start date, current status, etc. Custom columns/attributes represent customer-specified fields that are
added to a process when it is defined. Those fields can then be added to forms. When a user enters
information in the fields on a form (e.g., customer name, address, loan amount, etc.), that
information is stored in the custom attribute for that field.

Note that for process instance lists, the Column Selector will always show all system columns/
attributes, because they are available in every process instance. However, it will only show the
custom columns/attributes that are common to all process instances that were included in the
process view.

● Event lists - The Column Selector lists the available columns/attributes in a tree structure
categorized by the components that write values to the attributes. You can expand or collapse the
list below each component name, as needed, by clicking the + or - icon to the left of the component
name.

To customize the columns in a list using the Column Selector, follow these steps:

Click the  button or choose Select Columns from the View menu. The following dialog is displayed
(this is an example Column Selector from the work item list — the other lists will offer different
available columns):

1 The listing of custom columns/attributes is controlled via user access profiles. They are shown in the Column Selector only if you have
the proper access.
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If a Work List Facade is deployed, attributes are displayed showing the display names.

This dialog is used to specify which columns to display. Move the columns that you don’t want
displayed to the list on the left. Move the columns you do want displayed to the list on the right.

Procedure

1. Select the desired columns, using the following actions:

● Individual columns can be selected by clicking the desired name.

● Multiple columns can be selected by holding down the Ctrl key while clicking the desired
names.

● A group of columns can be selected by clicking one name, then holding down the Shift key
and clicking the last name in the desired group.

2. Move columns to the desired list in the Column Selector:

● Columns can be moved back and forth between lists by selecting the desired column(s), then
clicking the “” or “<“ buttons.

● An individual column can be moved from one list to the other by double-clicking the column
name.

● Columns can also be moved from one list to the other by using a “drag and drop” method —
click on the desired column name (or group of selected column names), and while holding the
mouse button, drag them to the desired list and release the mouse button.

● All columns can be moved from one list to the other by clicking the “ > ” or “<<“ buttons.

You can also change the columns to the current default for that list type by clicking the Use
Default button — for more information, see The Column Default.

3. Once the columns you want displayed are shown in the list on the right, you can change the order
in which they will appear on the work item list by doing one of the following:

● Using the Order buttons. Click on the column whose order you would like to change, then

click the  or  Order button to move the column up or down in the list.
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● Using the drag and drop method. Click on a column and drag it to the desired location in the
list.

4. Click OK when the list on the right contains the columns you would like displayed, in the order you
would like them displayed.

Result

The list is displayed with the chosen columns.

Number of Items in a List
The number of items (work items, process instances, events, etc.) in a list is indicated in the area directly
below the list.

In this example, there are 27 work items in the work item list shown; there are 20 displayed on page 1,
and 7 on page 2 (for information about “pages”, see List Page Size).

Note that this number may indicate the number of items in the list after it has been filtered — for
information about filtering lists, see Filtering Lists.

To reduce server overhead, counts are not provided on “All Work Items” views, as well as on case view
lists. On these views, only the page number is displayed:

In addition, the “Last Page” button is always disabled. You can page forward until no more items are
available in the view, at which point a “You have reached the end of the list” message is displayed.

Your system may also be configured to not display the total number of events when viewing a list of
events. This is to improve performance when there are a large number of events.

List Page Size
When a list of items (work items, process instances, events, etc.) is displayed on your screen, only a page
of items is displayed at one time. This is done to speed up the display, especially if there are a very large
number of items in the database.

If the list contains more items than the number specified for the page, you can step through the
multiple pages by clicking the arrow icons in the lower right corner of the list.
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The number of items on a page defaults to 20. You can change this number by selecting Page Size from
the View menu on the work item list. The following dialog is displayed:

Enter the number of items you would like displayed on each page.

If you click OK without checking the Make this the default page size... box, the new page size setting
will be in effect only on the current list for the current login session. Once you log out, then log back in,
the page size returns to the previous setting.

You can also make the specified page size persistent on all lists of the type you are currently on (work
item list, process instance list, etc.) by checking the Make this the default page size... box. If checked,
the size specified is persisted and becomes the default page size for all lists of the type you are currently
on. Note that persisted settings are saved on the server, so if you log onto a different machine, those
settings will be in effect on that machine also.

For work item lists and process instance lists in particular, from a performance standpoint it’s important
that you understand that when a page is displayed, the information about the work items / process
instances in the page is downloaded from the server. Because of that, you should keep the page size at a
reasonable number. If the page size is a large number, you could experience a delay when displaying a
work item or process instance list due to the amount of information that must be downloaded.

If you click a column header to sort the items by that column, the sort may apply to only the currently
displayed page, or it may apply to the entire list, even pages that have not been displayed, depending
on how your system has been configured. For more information, see Sorting a List Using Column
Headers.

Help
There are two kinds of help available in Workspace: tool-tip and on-line help.

● Tool-tip Help - This type of help allows you to place the cursor on a tool icon to cause a box to
appear that describes the purpose of the tool.
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Tool-tip help can also be helpful to view column header text when the column width is too narrow
to see the text. For example:

● On-line Help - An on-line help system is available that provides descriptions of the functions
available in Workspace, as well as the Organization Browser. This help can be accessed by clicking

the  button in the upper right part of the screen. The following menu is displayed:

Access the on-line help using the following selections:

— Help - Displays help for Workspace.

— Organization Browser Help - Displays help for the Organization Browser.

Access Privileges
Before any user can use Workspace, they must be added to a user database by a system administrator.
This database of users is maintained using the Organization Browser.

Using the Organization Browser is described in the Organization Browser User’s Guide.

System administrators also specify access privileges for each user that uses Workspace. These privileges
specify which functions each user is allowed to perform, as well as which icons and menu items are
displayed when the user logs in. These access privileges are specified via configuration files.

Note that this document describes all functions, and shows all buttons and menu selections, that are
available in Workspace, even though you may not be able to see/use those functions because of your
access privileges.

Determining User Access
A function is provided in Workspace that allows you to determine the access permissions of the
currently logged-in user. This would typically be done only at the request of Support personnel.

To display user access information, select User Access Privileges from the Help button menu on the
Workspace main toolbar.

The following dialog is displayed:

26

TIBCO® Workspace User's Guide



This dialog displays the following columns of information:

● Privileges - These are the privileges held by the logged-in user, based on the groups and/or
positions to which the user has been mapped.

● System Actions - This is an alphabetical list of all systems actions. The Authorized column indicates
whether or not the user has that system action.

● User Access Sets - This is an alphabetical list of all user access controls. The Authorized column
indicates whether or not the user has access to the associated function. If the logged-in user does not
have access to the associated function, the Revoked By column contains one of the following:

— User Access - This indicates that the user does not have access to the associated function
because the user does not possess the needed user access control for that function. To cross-
check the function that is accessible by having this user access control, use the table in the
"Available Functions" section in the TIBCO Workspace Configuration and Customization guide.

— System Action This indicates that the user does not have access to the associated function
because the user does not possess the needed system action for that function. To cross-check the
function that is accessible by having this system access, use the table in the "User Access Control
to System Action Mapping" section in the TIBCO Workspace Configuration and Customization
guide.

Accessing the Organization Browser
The Organization Browser is used to browse the organization model, create LDAP containers to hold
resources, map resources to groups or positions so that they receive work items, etc.

For details about all of the functions available from the Organization Browser, see the Organization
Browser User’s Guide.

The Organization Browser can be accessed from within Workspace using the Organization Browser
button:
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Note, however, that the Organization Browser button is not displayed by default. For this button to be
displayed, the logged-in user must have the ShowMainOrganizationBrowser user access control, as
well as the OrganizationBrowser user access control to be able to use the functions in the Organization
Browser. To gain these user access controls, a user with access to the Configuration Administrator can
enable them.

The following shows the aforementioned user access controls in the Configuration Administrator
(which is accessed via the Admin > Configuration selection on the Workspace main toolbar):

For details about using the Configuration Administrator, as well as more about user access controls, see
the TIBCO Workspace Configuration and Customization guide.

Setting the Language
The header in the Workspace application contains a Language selection field that allows you to set the
language to display on all of the screens and windows in Workspace.

This performs the same function as the “Language” user option available on the Options dialog. For
information about that user option, see Language .

Specify the desired language from the Language field on the Workspace header:

A particular language appears in this drop-down list only if the “language pack” for that language has
been installed on your system, or the appropriate files have been manually translated (for details, see
the TIBCO Workspace Configuration and Customization guide).

The language change takes effect immediately, and is persisted (i.e., the application will continue to be
displayed in the selected language until it is changed again, either using this function, or the Language
user option on the Options dialog).

Note that when the language is changed, the names of views do not change to the selected language
(with the exception of the Inbox). View names are user-specified when the views are created; they do
not get translated by language packs. The Inbox name, however, is not user-defined, nor changable by
the user, therefore it changes when the language is changed.
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Accessing Workspace

Before you can access Workspace, your user name must be mapped to groups and/or positions in the
organization model. This mapping allows you to log in to the application, as well as causes work items
to be sent to you so that you can access them once you’ve logged in.

Mapping your user name to groups/positions in the organization model will be performed by a System
Administrator.

This chapter provides information about the following:

● Logging Into Workspace - Once mapped to a group or position in the organization model, a user can
log into Workspace.

● Logging Out of Workspace - Using the Logout button is the proper method of leaving Workspace
when you are finished with your work.

Logging Into Workspace
Logging in to Workspace validates your user name and password to ensure you are authorized to use
the system. It also looks at your access privileges to determine how much functionality you are
authorized to perform.

Your system administrator will determine how you actually start Workspace. It may involve starting a
browser and entering a URL (Universal Resource Locator, or “website address”), or you may click on a
link on a specified web page.

If multiple instances of a WCC application (including the Workspace application) are executed at the
same time from a single machine, they must be running in different HTTP sessions. (Note that a WCC
application in which work item forms have been opened in separate browser windows is considered a
single instance of an application, even though the work item forms are opened in separate browser
windows.)

A workaround for this issue is to open multiple instances of a WCC application in different types of
browsers (for example, one can be opened in Internet Explorer and another in Firefox).

Another workaround using Internet Explorer is to select New Session from the browser File menu,
then point that browser instance at the WCC application. (Other browsers may offer a similar method
of starting multiple instances in different HTTP sessions.)

After the browser connects to the proper web site, you are presented with a login dialog:
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Procedure

1. Enter your user name in the User Name field.

The user name may or may not be case sensitive, depending on a property set on the
server.

2. Enter your password in the Password field.

3. If you would like your user name to be automatically entered in the User Name field the next time
you login to Workspace on this computer, check the Remember User Name box.

4. Click Login.

If the login is successful, the view that has been chosen as the default view is displayed (for
information about specifying a default view, see Default View).

If your password has expired, a Change Password dialog may be displayed (this dialog is displayed
only if the appropriate access privilege is enabled for you). If the Change Password dialog is
displayed, you must change your password before you can proceed.

If there is a problem with the login (e.g., you’ve entered an invalid user name or password, an error
dialog is displayed.

The Login dialog may also contain a hyperlink that when clicked displays a web page in
the browser. This is a custom feature that may or may not be on your Login dialog.

Login Session Timeout
If there is no activity in Workspace for a certain period of time, the login session will timeout,
automatically logging you out. The period of time before the timeout is customizable — the default is
30 minutes.

Before it times out, a warning message is displayed telling you that the session is about to timeout. If
you do not respond to the warning dialog by clicking OK, you are logged out and the following dialog
is displayed:

Click OK to remove the dialog. You can then log back into the application.

Logging Out of Workspace
When you are finished doing the work you need to do, you should log out of Workspace.

If you just close your browser rather than log out, you will eventually be logged out internally.
However, the proper “clean up” is performed internally when you log out, making the most efficient
use of resources. Also, if there is no activity in Workspace for a certain period of time, the application
will timeout, automatically logging you out. For more information, see Login Session Timeout.
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Procedure

1. Close any currently open work items.

2. Click the  button the upper right part of the Workspace screen.
When you are successfully logged out, the Login window is displayed. You can either log in again,
go to another web site, or close the browser.
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Views

In general, a view is merely a way of viewing different types of items in Workspace.

There are the following types of views:

● Work Views - These display lists of work items.

● Process Views - These display lists of process instances.

● Event Views - These display lists of events that have taken place in Workspace.

● System Views - These are views that a supervisor defines that will automatically appear in user’s
view lists.

● Case Views - These views allow you to see global case data, as well as lists of work items, process
instances, and events that relate to the case data.

Each view can be filtered and/or sorted in a particular way so that only the items (i.e., work items,
process instances, events, or case data) that you are interested in are displayed, in the order in which
you want to see them.

The lower left pane of the Workspace screen contains buttons that allow you to access each type of
view:

In this example, clicking the Work Views button causes the list of available work views to be displayed.
Clicking on one of the work views displays the list of work items in that view.
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Note that there are two buttons that present “view-like” displays, although they are not technically
views in the sense that you cannot created custom views of these. They are:
● Business Services: This button presents a file/directory-like display of the business services

available to you. For more information, see Accessing Workspace .

● Organization Browser: This button displays a graphical representation of the organization model
for the purpose of mapping resources to the available groups and positions. For more information,
see the Organization Browser User’s Guide. (Note that this button is not displayed by default; for more
information, see Accessing the Organization Browser .)

All view lists contain a Type column that indicates whether the view is a User view or a System view:

User views are those that you have created yourself; system views have been created by a supervisor
and appear in your view list automatically. For information about system views, see System Views.

Permanent and Temporary Views
Depending on how a view is created, it can be either permanent or temporary.

● A permanent view is saved and will remain in the view list until you explicitly delete it.

● A temporary view will be automatically deleted from the view list when you log out. If you want to
retain a view that is currently temporary, you must explicitly save it (making it permanent) before
logging out, otherwise it is lost.

There is also a Remove All Temporary Views button ( )and menu selection on the view lists that
allow you to delate all views that are temporary.

Views that are created in a temporary state are considered the type of view that you would probably
not have a desire to save, although you can if you want to. For example, you can quickly create a list
of outstanding work items for the selected process instance — the resulting work view is created in
a temporary state because it’s probably not a view you want to keep.

Creating views in a temporary state allows you to not worry about them building up in your view
list — they will be automatically removed when you log out.

This information is not applicable to case views. Case views are automatically permanent.

You can tell whether a view is permanent or temporary by the icon in the view list; the icons for
temporary views are "grayed out", whereas the icons for permanent views are displayed in color:
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Also, if a temporary view is selected in the view list, both the Save View and Save View As... buttons
are enabled on the list of items in the view.

For information about saving permanent and temporary views, see Saving Views.

The following summarizes the ways in which permanent and temporary views are created:

● Permanent Views:

— Any view created using the view wizard.

— The default views. Each of the view lists have a default view: the Inbox in the work view list,
the All Instances view in the process view list, and the My Activity Today view in the event
view list. All of these views can be modified. The All Instances and My Activity Today views
can be deleted; the Inbox cannot be deleted.

The Inbox in the work view list and the All Instances view in the process view list are
controlled by user access elements. Therefore, if you do not have the proper user
access, you will not have those views.

● Temporary Views:

— Work views created by using either the Show Outstanding Work Items or Show Supervised
List of Outstanding Work Items functions on the process instance list.

For information about these functions, see Outstanding Work Items.

— Any contextual event view, which displays a list of events from a specific context. For instance,
from a work item list you can display a list of events that pertain to a particular work item, or
from a process instance list you can create a list of events that pertain to a particular process
instance, etc.

For more information, see Creating a Contextual List of Events.
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Saving Views
There are two save functions for saving a view: Save View and Save View As. These functions are

available on the work item list, process instance list, and event list in the form of Save View ( ) and

Save View As ( ) buttons, as well as the same selections on the Tools menu.

This information is not applicable to case views. There are no Save View and Save View As functions
available on case views.

These functions are described below:

● Save View - This saves the view using the same name that it currently has. This function is only
available under the following circumstances:

— When you currently have a temporary view selected. When temporary views are created, they
are given a default name. This allows you to save it using this default name.

For more information about temporary views, see Permanent and Temporary Views.

— When you have defined a refined filter for the current view. This allows you to add the refined
filter to the base filter and save the view without changing its name.

For more information about refined filters, see Base Filter and Refined Filter.

● Save View As - This allows you to save the current view using a different name, without affecting
the original view. For example, suppose you displayed a work view named “My Work”, then
specified a refined filter on the view. Using the Save View As function, you could save the view as
“My Work 2” — a new “My Work 2” work view is created in which the refined filter expression is
added to the original work view’s base filter (if there was one). The original “My Work” work view
is unchanged.

The Save View As function is available for both temporary and permanent views, meaning you can
always save the currently selected view using a new name without affecting the original view.

Work Views
Work views display lists of work items. You can create as many work views as needed, each displaying
a list of work items that are possibly filtered and/or sorted in a different way.

To display work views, click the Work Views button in the lower left part of the Workspace screen. A
list of your work views is displayed. For example:
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Notice that work views are presented in a folder/file type of display, where My Work and Supervised
Work appear as folders, and work views you create under those categories appear as files. You can
expand and collapse the folders by clicking the - / + icon to the left of My Work and Supervised Work.

When you click a work view, a list of the work items in that view is displayed. For example:

You can specify which specific work view to display by default when you log in. For instance, using the
example above, you could specify that the Requests work view be displayed (selected) whenever you
log in and display the work view list (by default, the Inbox is displayed). To set this option, see Default
View.
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Personal Work Views vs. Supervised Work Views
Work views are subdivided into personal work views and supervised work views.

● Personal Work Views - These work views contain work items that are currently offered or allocated
to you. They are shown under the My Work folder in the work view list.

There is always at least one work view listed under My Work: your Inbox(1). The Inbox, by default,
is a view of all work items that have been offered or allocated to you. It is analogous to an inbox in
an email program, which lists all of your emails. The Inbox cannot be removed. Note, however, that
you can filter and/or sort your Inbox so that it actually displays a subset of all work items offered or
allocated to you.

You can create additional work views under My Work that contain different views of your work
items, that is, they can be filtered and/or sorted different from the work items in your Inbox. This is
explained in Creating Work Views.

● Supervised Work Views - These work views, which are shown under the Supervised Work folder,
are of two types:

— For an individual resource - This type of supervised work view contains the work items that
are currently in the Inbox (unfiltered) of the resource.

To supervise work views of other users, you must have been given access permission(2) to view
work items in a specific position held by the user.

— For an organizational entity - This type of supervised work view contains the work items that
were sent to the selected organizational entity (group, organization unit, or position).

To supervise work views of specific groups, organization units, or positions, you must have
been given access permission1 to view work items in that specific group, organization unit, or
position.

Supervised work views of an organizational entity can contain the following types of work
items:

— Offered - These are work items that were offered to the selected organizational entity, and that
still have a state of Offered.

— Allocated - These are work items that were offered to the selected organizational entity, that are
now allocated to a user (i.e., their state is Allocated).

When viewing a supervised work view for an organizational entity, you will be able to see work
items that are offered directly to that entity — it does not cause the supervised work view to
contain work items that are offered or allocated to all of the members of the chosen organization
entity.

— All Work Items - This supervised work view shows all work items, irrespective of the resource
or organizational entity to which the work items are offered or allocated. This type of view
contains work items of all states: opened, offered, allocated, pended, etc.

To create this type of work view, you must have the appropriate user access control
(AllWorkItems), as well as the View Global Work List (BRM.viewGlobalWorkList) system
action.

Note that for “All Work Items” views, a total work item count value is not provided on the work
item list to reduce server overhead. This means that the paging area on the work item list does
not provide any work item counts like other work item lists. In addition, the “Last Page” button
is always disabled. You can page forward until no more items are available in the “All Work
Items” view, at which point a “You have reached the end of the list” message is displayed.

2 The Inbox view in the work view list is controlled by a user access element. Therefore, if you do not have the proper user access, you
will not have this view.

3 This permission is granted via the View Work List (BRM.viewWorkList) scoped system action — for information, see the Configuring
User Access chapter in the TIBCO Workspace Configuration and Customization guide).
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The icons in the list of supervised work views indicate the type of supervised work view, as
follows:

Icon Meaning

The supervised work view is for an individual resource.

The supervised work view is for an organizational entity that contains
offered work items.

The supervised work view is for an organizational entity that contains
allocated work items.

The supervised work view lists all work items.

Also note that the following functions are not available from any type of supervised work view:

● Open Work Item(s) (as well as the associated functions, Open Next Work Item and Auto-Repeat
Open)

● Allocate Work Item(s) to Self
● Pend Work Item(s)
By default, there are no work views in the Supervised Work folder. You must create them using one of
the methods described in Creating Work Views.

Creating Work Views
A work view can be created either by using a wizard or by using the Outstanding Work Items Function.

● Using the Wizard - This method steps you through a series of dialogs that allow you to name the
work view and specify filter and/or sort criteria.

When using the wizard, you can choose to create a work view under "My Work" (which will contain
work items offered/allocated to you), or under "Supervised Work" (which contain work items that
are offered/allocated to a user you supervise, that were sent to a specified organizational entity, or
all work items regardless to whom they have been offered or allocated).

Work views created using the wizard are always permanent, that is, they will remain in your work
view list until you explicitly remove them.

For more information, see:

— Creating a Personal Work View Using the Wizard
— Creating a Supervised Work View Using the Wizard

● Using the Outstanding Work Items Function - The process instance list contains two functions that
allow you to display the currently outstanding work items for the selected process instance:

— Show Outstanding Work Item(s) for ID - This function causes a temporary work view to be
created under the My Work folder in the work view list. This work view will contain all of the
outstanding work items for the selected process instance that are currently offered or allocated
to you.

— Show Supervised List of Outstanding Work Item(s) for ID - This function causes a temporary
work view to be created under the Supervised Work folder in the work view list. This work
view will contain all of the outstanding work items for the selected process instance that are
currently offered or allocated to the specified user, that were sent to the specified organizational
entity, or all work items regardless to whom they have been offered or allocated.
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To view a list of outstanding work items of specific groups, organization units, or positions, you
must have been given access permission to view work items in that specific group, organization
unit, or position (this permission is granted via the View Work List (BRM.viewWorkList) scoped
system action — for information, see the Configuring User Access chapter in the TIBCO Workspace
Configuration and Customization guide).

Because the work view that is created with these functions is temporary, it must be saved,
otherwise it will be lost when you log out.

For more information about creating a work view containing outstanding work items, see 
Outstanding Work Items.

Creating a Personal Work View Using the Wizard

Personal work views can be created using a wizard.

Procedure

1. Click the My Work folder in the work view list.

2. Click the Create New View button ( ) on the work view list menu bar (or select New from the
Tools menu).

A dialog is displayed that allows you to specify whether you are creating a user view or a system
view.

This dialog with the user view / system view selections displays only if you have the user
access authority to create system views.

3. Choose the type of work view to create, as follows:

● A user view is one that you create to list work items filtered and sorted as desired.

If you are creating a user view, select This is my own user view, then click Next.
● A system view is one that is automatically available to specified users, or to users that have been

assigned to specific groups or positions.

Creating a system view is typically a supervisory or administrative function. Therefore, the
discussion of creating a system view is provided in a separate section of the documentation.

If you are creating a system view, select This is a system view assigned to groups/positions or
users, which causes additional items to be displayed on the dialog. Refer to the information in 
System Views to complete that dialog, then return to this step to complete the creation of the
work view.

4. Enter the desired name for the work view in the Name field and an optional description in the
Description field(1), then click Next.

4 You cannot use any of the four following characters in the view name or description: < (less than), > (greater than), & (ampersand), or
" (double quote). The application will not allow you to enter any of these characters.
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Note that you could actually click Finish at this point, which means you are creating a work view
that contains all of the work items that are in your Inbox, not filtered nor sorted — basically
resulting in an Inbox with a different name.

5. On the Filter dialog, do one of the following:

● Enter filter criteria for the view, then click Next to advance to the Sort dialog to specify how to
sort the work items in the view.

● Enter filter criteria for the view, then click Finish if you have no desire to specify how to sort
the work items in the view.

● Click Next to advance directly to the Sort dialog if you have no desire to specify filter criteria.

Note that any filter criteria you specify through the wizard is considered the “base” filter for
the work view (as opposed to a “refined” filter that is set through the Filter function on the
work item list). For more information, see Base Filter and Refined Filter.

Because filtering work item lists is basically the same as filtering other types of lists in
Workspace (with the exception of the specific fields on which you can filter), details of filtering
is explained in a single chapter — see Filtering Lists.

6. On the Sort dialog, do one of the following:

● Enter sort criteria for the view, then click Next to advance to the Column dialog to specify the
columns to display in the view.

● Enter sort criteria for the view, then click Finish if you have no desire to specify columns for
the view.

● Click Next to advance directly to the Column dialog if you have no desire to specify sort
criteria.

Because sorting work item lists is basically the same as sorting other types of lists in Workspace
(with the exception of the specific attributes on which you can sort), details of sorting is
explained in a single chapter — see Work Items.

7. From the Specify Display Columns for the View dialog, move the columns you would like
displayed in the view to the list on the right, then click Finish to complete the creation of the view.

This dialog works in the same way as the Column Selector dialog available from all other lists in
Workspace. For information about using the Column Selector, see Customizing Columns in a List.

Result

The new view will appear in the list of work views.

Creating a Supervised Work View Using the Wizard

Supervised work views can be created using a wizard.

Procedure

1. Click the Supervised Work folder in the work view list.

2. Click the Create New View button ( ) on the work view list menu bar (or select New from the
Tools menu).

A dialog is displayed that allows you to specify whether you are creating a user view or a system
view.
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This dialog with the user view / system view selections displays only if you have the user
access authority to create system views.

3. Choose the type of work view to create by selecting the appropriate option:

● A user view is one that you create to list work items filtered and sorted as desired.

If you are creating a user view, select This is my own user view, then click Next.
● A system view is one that is automatically available to specified users, or to users that have been

assigned to specific groups or positions.

Creating a system view is typically a supervisory or administrative function. Therefore, the
discussion of creating a system view is provided in a separate section of the documentation.

If you are creating a system view, select This is a system view assigned to groups/positions or
users, which causes additional items to be displayed on the dialog. Refer to the information in 
System Views to complete that dialog, then return to this step to complete the creation of the
work view.

4. On the next dialog, enter the desired name for the supervised work view in the Name field and an
optional description in the Description field(1).

5. Ensure that the appropriate organization model version is selected. This is shown in the first row of
the organization model (Version 3 in the following example):

Use the Version drop-down list to change the version, if required.

6. In the Select Work List for View section, choose the type of work items that are to appear in the
supervised work view, as follows:

● Offered Work Items for an Organizational Entity - This causes the supervised work view to
contain only work items that were sent directly to the selected organizational entity(2), and that
still have a state of Offered.

● Allocated Work Items for an Organizational Entity - This causes the supervised work view to
contain only work items that were originally sent directly to the selected organizational entity,1
but have since been allocated to a specific resource (their state = Allocated). Note that when
viewing this type of supervised work view, it does not show you to whom the work item has
been allocated. However, you can easily determine that by selecting a work item, then selecting

5 You cannot use any of the four following characters in the view name or description: < (less than), > (greater than), & (ampersand), or
" (double quote). The application will not allow you to enter any of these characters.

6 Note that this type of supervised work view will contain work items that are offered directly to that entity — it does not contain work
items that are offered or allocated to all of the members of the chosen organization entity.
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Open Event Viewer > This Work Item. The allocation event shows to whom the work item
was allocated (in the Resource name attribute). The Description column also shows that
information if it has not been changed from the default.

● Work Items for a Resource - This causes the supervised work view to contain work items that
are currently in the Inbox of a specified resource, offered and allocated.

If the message “Insufficient rights to view the resource list for a group or position” is displayed
when you select Work Items for a Resource, it means you don’t have the appropriate system
action. To view the resource list, you must have the Resource Admin (DE.resourceAdmin)
system action, which is available at the organization model level. For more information, see the
Configuring User Access chapter in the TIBCO Workspace Configuration and Customization guide).

● All Work Items - This causes the supervised work view to contain all work items irrespective
of the resource or organizational entity to which the work items are offered or allocated
(although the list can still be filtered).

Note that this option appears only if you have the appropriate user access control
(AllWorkItems), as well as the View Global Work List (BRM.viewGlobalWorkList) system
action.

If you choose the All Work Items option, proceed to step 9.
7. Optionally, choose whether unique names or display names are shown in the list of organizational

entities.

When organizational entities are created in TIBCO Business Studio, they are given both "unique
names" and "display names" (also called "labels").

The Tools menu contains a Show unique names for organizational entities selection that toggles
between the two displays. By default, the display names are shown.

You can also hover the mouse pointer over an organizational entity to view both names for a
particular organizational entity:

8. Select the desired organizational entity or an individual resource:

● If the supervised work view is to contain work items (either offered or allocated) sent to an
organizational entity, select the desired organization unit, position, or group. For example:
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Note that only organizational entities to which you have been given access permission are
selectable — all others are grayed out. This permission is granted via the View Work List
(BRM.viewWorkList) scoped system action. For more information, see the Configuring User
Access chapter in the TIBCO Workspace Configuration and Customization guide.

● If the supervised work view is to contain work items sent to an individual resource, you must
first select one of the positions to which that resource has been mapped (you cannot select
resources from groups, only from positions), then select the resource in the right pane. For
example, if you want to create a supervised work view for a resource that has been mapped to
the CustomerServiceRepresentative position, select that position, then select the desired
resource. For example:

You may not be able to see all resources mapped to a particular position because there are
resources mapped to that position that were created in an LDAP container for which you don’t
have visibility (because of an organization relationship). (This applies only to positions, not to
groups.)

Note, however, the counts shown to the right of the position name in the left pane is the total
count for the resources in the position. From this count, you can determine if there are resources
mapped to the position that you cannot see.

For more information, see the Container Organization Relationships section in the Organization
Browser User’s Guide.

9. Click either the Next button to continue defining the work view, or the Finish button to complete
the work view:

● Clicking Next allows you to define a filter, sort criteria, and columns for the work view —
proceed to step 10.

● Clicking Finish completes the work view without specifying a filter, sort criteria, and columns.
You are returned to the Work View list.

10. From the Filter dialog, you can do one of the following:

● Enter filter criteria for the view, then click Next to advance to the Sort dialog to specify how to
sort the work items in the view.

● Enter filter criteria for the view, then click Finish if you have no desire to specify how to sort
the work items in the view.

● Click Next to advance directly to the Sort dialog if you have no desire to specify filter criteria.

Note that any filter criteria you specify through the wizard is considered the “base” filter for
the work view (as opposed to a “refined” filter that is set through the Filter function on the
work item list). For more information, see Base Filter and Refined Filter.

Because filtering work item lists is basically the same as filtering other types of lists in
Workspace (with the exception of the specific fields on which you can filter), details of filtering
is explained in a single chapter — see Filtering Lists.
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11. From the Sort dialog, you can do one of the following:

● Enter sort criteria for the view, then click Next to advance to the Column dialog to specify the
columns to display in the view.

● Enter sort criteria for the view, then click Finish if you have no desire to specify columns for
the view.

● Click Next to advance directly to the Column dialog if you have no desire to specify sort
criteria.

Because sorting work item lists is basically the same as sorting other types of lists in Workspace
(with the exception of the specific attributes on which you can sort), details of sorting is
explained in a single chapter — see Work Items.

12. From the Specify Display Columns for the View dialog, move the columns you would like
displayed in the view to the list on the right, then click Finish to complete the creation of the view.

This dialog works in the same way as the Column Selector dialog available from all other lists in
Workspace. For information about using the Column Selector, see Customizing Columns in a List.

Result

The new view will appear in the list of work views.

Editing an Existing Work View
You can edit any part of the definition of a work view, i.e., the name, description, filter criteria, or sort
criteria. For supervised work views, you can also change the supervised user or organizational entity
whose work items are appearing in the work view.

You can also edit your default work view, the Inbox. By default, the Inbox displays all work items
offered to you. By editing it, you can filter the list so that only a subset of the work items are listed. (The
Inbox cannot be deleted, however.)

Procedure

1. Select the desired work view in the work view list.

2. Click the Edit Work View button ( ), or select Edit from the Tools menu.

Result

The same dialogs are displayed as when the view was originally created. For information about those
dialogs, see Creating Work Views.

Editing a System Work View

The extent to which you can edit a system view depends on whether you are the owner, author, or
recipient of the view.

For more information, see System Views.
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Deleting a Work View
If you don’t need a view any longer, you can delete it from the work view list.

Your default personal work view, the Inbox, cannot be deleted.

Also remember that temporary views are automatically deleted when you log out. However, there is a

Remove All Temporary Views button ( )and menu selection available on the work view list that
allows you to delete all temporary work views without having to log out.

Procedure

1. Select the desired work view in the work view list.

2. Click the Remove View button ( ), or select Remove from the Tools menu.
You will be asked to confirm the deletion before it is removed from the work view list.

Deleting a System Work View

The extent to which you can delete a system view depends on whether you are the owner, author, or
recipient of the view.

For more information, see System Views.

Process Views
Process views display lists of process instances. You can create as many process views as needed, each
displaying a list of process instances that are possibly filtered and/or sorted in a different way.

To display process views, click the Process Views button in the lower left part of the Workspace screen.
A list of your process views is displayed. For example:

Each process view allows you to display a list of process instances for the process(es) included in the
process view, possibly filtered and sorted.

Clicking on the view in the process view list causes the process instances in that view to be displayed in
the list on the right. For example:
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You can create multiple process views that display process instance lists that are customized in the
following ways:

● They can contain process instances from one or more process.

● They can be filtered and/or sorted in different ways.

This allows you to create customized process instance lists that display only the process instances you
are interested in.

You can also specify which specific process view to display by default when you log in. For instance,
using the example above, you could specify that the Loans process view be displayed (selected)
whenever you log in and display the process view list. To set this option, see Default View.

The Default Process View
By default, one process view is provided when you first start Workspace for the first time — the All
Instances view.

The All Instances view in the process view list is controlled by a user access element. Therefore, if you
do not have the proper user access, you will not have this view.

The All Instances view, by default, contains all instances of all processes. You can edit this view,
however, so that it contains a subset of the available processes, if desired. It can also be deleted (unlike
the default work view, Inbox). For information about editing a process view, see Editing an Existing
Process View.

Note that the All Instances process view will also contain future processes. In other words, whenever
you display the All Instances view (assuming you have not edited it), it requests all of the processes
that exist at that time, not only the processes that existed at the time the view was created. For more
information about including all current and future processes in a process view, see Creating Process
Views.

Creating Process Views
A wizard is provided to create a new process view.

Procedure

1. Click the Create New View button ( ) on the process view list menu bar (or select New from the
Tools menu).

A dialog is displayed that allows you to specify whether you are creating a user view or a system
view.
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This dialog with the user view / system view selections displays only if you have the user
access authority to create system views.

2. Choose the type of process view to create:

● A user view is one that you create to list process instances filtered and sorted as desired.

If you are creating a user view, select This is my own user view, then click Next.
● A system view is one that is automatically available to specified users, or to users that have been

assigned to specific groups or positions.

Creating a system view is typically a supervisory or administrative function. Therefore, the
discussion of creating a system view is provided in a separate section of the documentation.

If you are creating a system view, select This is a system view assigned to groups/positions or
users, which causes additional items to be displayed on the dialog. Refer to the information in 
System Views to complete that dialog, then return to this step to complete the creation of the
process view.

3. Complete the New Process View dialog as follows:
a) Enter the desired name for the process view in the Name field.
b) Optionally enter a description for the process view in the Description field(1).
c) Select one of the following options to specify the process instances that will appear in the view:

● Include selected processes - Selecting this option causes the list of processes that currently
exist on the server to be displayed (as in the example above). This allows you to select the
desired processes whose instances you want to appear in the process view you are creating.

● Include all processes - Selecting this option causes all processes to be included in the view,
which in turn causes all instances of those processes to appear in the process instance list
when the view is selected.

If you select this option, the process view you are creating will include all instances of all
processes that exist when the view is selected, not when the view was created. Note that this is
an important distinction from selecting the Include selected processes option and adding all
of the processes to the view — when that process view is selected, the process instance list
will include the instances from all of the processes that existed when the view was created, not
when it is selected. If new processes are added to the system, a process view created with the
Include all processes option selected will include those processes as well.

Note that the default “All Instances” process view has the Include all processes option
selected by default.

If you select the Include all processes option, the list of processes on the Select Processes to
include in the View dialog goes away, since you don’t need the list to select from. If you
selected this option, proceed to step 3e.

d) Select the process(es) whose instances you would like to appear in the process view you are
creating.

7 You cannot use any of the four following characters in the view name or description: < (less than), > (greater than), & (ampersand), or
" (double quote). The application will not allow you to enter any of these characters.
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You can expand each of the processes to list all of the versions that are available for that process

by clicking the  button:

You can select processes you want to include in the process view in the following ways:

● Clicking the boxes to the left of the version numbers selects only those specific versions.

● Clicking a top-level box (i.e., next to the process name) causes all versions of the process to
automatically be selected. Note that if you select the top-level box, it causes all future versions
of the process to also be included in the process view.

e) Choose whether you are creating a standard instance view or a halted instance view by selecting
the appropriate option (note that these options appear on the dialog only if you have the
appropriate user access authority):

● A standard instance view is one in which you will see the normal information about process
instances. This type of process view does not, however, include details about halted processes
instances (although it does list halted instances, just not the detail information).

This option may also provide (depending on your user access authority) sub-selections to
specify that the standard instance view contain only active instances, only terminal state
instances, or both. Terminal state instances are those that have a status of Completed or
Cancelled. Note that your system would need to be configured by an Administrator to show
Completed and Cancelled process instances; they may be automatically purged, depending
on configuration.

● A halted instance view contains attributes that provide information about why a process
instance has become halted. This is a special-use process view that is typically only used by
supervisory personnel for troubleshooting halted process instances.

For more information about halted process instances, see Halted Process Instances.

4. After selecting the desired processes/versions and choosing the type of process view to create, you
can do one of the following:

● Click the Finish button if you have no desire to specify filter, sort, or column criteria for this
process view. The New Process View dialog is closed and the new view appears in the process
view list.

● Click the Next button to display the Filter dialog.

5. From the Filter dialog, you can do one of the following:

● Enter filter criteria for the view, then click Next to advance to the Sort dialog to specify how to
sort the process instances in the view, then to the Column dialog to specify the columns to
display in the view.

● Enter filter criteria for the view, then click Finish if you have no desire to either specify how to
sort the process instances in the view, nor to specify the columns in the view.

● Click Next to advance directly to the Sort dialog if you have no desire to specify filter criteria.

Note that any filter criteria you specify through the wizard is considered the “base” filter for
the process view (as opposed to a “refined” filter that is set through the Filter function on the
process instance list). For more information, see Base Filter and Refined Filter.
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Because filtering process instance lists is basically the same as filtering other types of lists in
Workspace (with the exception of the specific attributes on which you can filter), details of
filtering is explained in a single chapter — see Filtering Lists.

6. From the Sort dialog, you can do one of the following:

● Enter sort criteria for the view, then click Next to advance to the Column dialog to specify the
columns to display in the view.

● Enter sort criteria for the view, then click Finish if you have no desire to specify columns for
the view.

● Click Next to advance directly to the Column dialog if you have no desire to specify sort
criteria.

Because sorting process instance lists is basically the same as sorting other types of lists in
Workspace (with the exception of the specific attributes on which you can sort), details of
sorting is explained in a single chapter — see Work Items.

7. From the Specify Display Columns for the View dialog, move the columns you would like
displayed in the view to the list on the right, then click Finish to complete the creation of the view.

This dialog works in the same way as the Column Selector dialog available from all other lists in
Workspace. For information about using the Column Selector, see Customizing Columns in a List.

Also note that if multiple processes were selected to be included in the process view, the columns
listed on the Specify Display Columns for the View dialog will only include the intersection of the
columns from all of the selected processes. In other words, it will list only the columns that appear
in every process included in the view.

Result

The new view will appear in the list of process views.

Editing an Existing Process View
You can edit any part of the definition of an existing process view, that is, the name, description, the
processes to include in the view, filter criteria, or sort criteria.

Procedure

1. Select the desired view in the process view list.

2. Click the Edit Process View button ( ), or select Edit from the Tools menu.

Result

The same dialogs are displayed as when the view was originally created. For information about those
dialogs, see Creating Process Views.

Editing a System Process View

The extent to which you can edit a system view depends on whether you are the owner, author, or
recipient of the view.

For more information, see System Views.
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Deleting a Process View
If you don’t need a process view any longer, you can delete it from the process view list.

Procedure

1. Select the desired process view in the process view list.

2. Click the Remove Process View button ( ), or select Remove from the Tools menu.

You will be asked to confirm the deletion before it is removed from the process view list.

Deleting a System Process View

The extent to which you can delete a system process view depends on whether you are the owner,
author, or recipient of the view.

For more information, see System Views.

Event Views
Event views display lists of events that have taken place in the application.

To display event views, click the Event Views button in the lower left part of the Workspace screen. A
list of your event views is displayed. For example:

Each event view allows you to display a list of events that are related to some entity in Workspace, such
as a work item, process instance, user, etc.

A number of event views may be displayed by default the first time you log into Workspace (the
specific event view displayed by default is configurable by the system administrator).

You can create additional event views using one of the methods described in Creating Event Views.

You can also delete event views that you don’t need — see Deleting an Event View.
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Clicking on the view in the event view list causes the events in that view to be displayed in the list on
the right. For example:

For information about the functions you can perform from the event list, see Events.

Creating Event Views
There are a couple of ways in which you can create event views, which provide access to event lists:
contextually or by using the wizard.

● Contextually - This displays a list of events from a specific context, such as from a work item, or a
process instance, etc.

For example, from a work item list you can select a work item, then display a list of events that are
related to that work item. Or you could choose to display a list of events related to the process
instance the selected work item is a part of.

Note that the specific types of events you can display from a context is customizable. Therefore, the
selections you see on your system may vary from those you see in this document.

You can create a contextual list of events from various locations in Workspace. For more
information, see Creating a Contextual List of Events.

● Using the Wizard - A wizard is provided that allows you to create a list of events, filtered and/or
sorted in whatever way you desire.

The wizard provides some templates that have preset filters that allow you to quickly create an
event list. For more information, see Creating a List of Events Using the Wizard.

Creating a Contextual List of Events

The way in which you create contextual lists of events depends on whether you are creating them from
the work item or process instance list in Workspace, or from the organization model or resource list in
the Organization Browser.

● Work item list - From the work item list:

1. Select the desired work item.

2. Either click the  button on the work item list toolbar, select Open Event Viewer from the
work item list Tools menu, or right-click the selected work item and select Open Event Viewer

All three methods display a drop-down list.

3. From the drop-down list, select one of the available pre-defined filters. For example:
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This creates an event view containing events of the type you selected in the drop-down list, that are
associated with the selected work item. For example, if you select “This instance”, the event list will
contain all events pertaining to the process instance that is associated with the selected work item.

Note that the selections in the drop-down list are customizable — those appearing on your system
may differ from those shown here.

● Process instance list - From the process instance list:

1. Select the desired process instance.

2. Either click the  button on the process instance list toolbar, select Open Event Viewer from the
process instance list Tools menu, or right-click the selected process instance and select Open Event
Viewer.

All three methods display a drop-down list.

3. From the drop-down list, select one of the available pre-defined filters. For example:

This creates an event view containing events of the type you selected in the drop-down list, that are
associated with the selected process instance. For example, if you select “My activity for this
instance”, the event list will contain all events that were generated by actions you performed
pertaining to the selected process instance.

Note that the selections in the drop-down list are customizable — those appearing on your system
may differ from those shown here.

● Organization Model - From the Organization Browser:

1. Select the desired organizational entity from the organization model graphic.
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2. Either click the  button on the organization model graphic toolbar, select Open Event Viewer
from the organization model graphic Tools menu, or right-click the selected organizational entity
and select Open Event Viewer.

All three methods display a drop-down list.
3. From the drop-down list, select one of the available pre-defined filters. For example:

This creates an event view containing events of the type you selected in the drop-down list, that are
associated with the selected organizational entity.

● Resource list - From the Organization Browser:

1. In the organization model graphic in the left pane, select a group or position to which the desired
resource has been mapped.

2. Select the desired resource from the resource list in the right pane.

3. Either click the  button on the resource list toolbar, select Open Event Viewer from the resource
list Tools menu, or right-click the selected resource and select Open Event Viewer.

All three methods display a drop-down list.
4. From the drop-down list, select one of the available pre-defined filters.

For example:

This creates an event view containing events of the type you selected in the drop-down list, that are
associated with the selected resource. For example, if you select “Activity by this resource”, the
event list will contain all events that relate to the selected resource.

The selections in the drop-down list are customizable — those appearing on your system may differ
from those shown here.

Result

Note that all of the methods listed above that create a contextual list of events cause a temporary event
view to be created in the event view list. For example, if work item 4 is selected in the work item list,
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then “This work item” is selected from the Open Event Viewer drop-down list, the following event
view is created:

Notice that the icon for the view in the event view list is grayed out, plus both the Save and Save View
As buttons in the Event Viewer are enabled, indicating that the event is temporary. If you want to save
the event view, it must be saved prior to logging out, otherwise it will be lost.

For more information about temporary views, see Saving Views.

Creating a List of Events Using the Wizard

A wizard is provided that allows you to create a list of events, filtered and/or sorted in whatever way
you desire.

The wizard provides some templates that have preset filters that allow you to quickly create an event
list.

Procedure

1. Display the event view list by clicking the Event Views button in the lower-left part of the
Workspace screen.

2. Click the  button on the event view list toolbar (or select New from the Tools menu):

A dialog is displayed that allows you to specify whether you are creating a user view or a system
view.

This dialog, with the user view / system view selections, displays only if you have the user
access authority to create system views.

3. Choose the type of event view to create by selecting the appropriate option:
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● A user view is one that you create to list events filtered and sorted as desired.

If you are creating a user view, select This is my own user view, then click Next.
● A system view is one that is automatically available to specified users, or to users that have been

assigned to specific groups or positions.

Creating a system view is typically a supervisory or administrative function. Therefore, the
discussion of creating a system view is provided in a separate section of the documentation.

If you are creating a system view, select This is a system view assigned to groups/positions or
users, which causes additional items to be displayed on the dialog. Refer to the information in 
System Views to complete that dialog, then return to this step to complete the creation of the
event view.

The New Event View dialog is displayed:

4. Enter the desired name for the event view in the Name field, and optionally enter a description for
the event view in the Description field(1).

5. Choose how you want the event view created by selecting the appropriate option, as follows:

Selecting the Create a custom view by specifying a filter option causes the list of filter templates on
the dialog to be removed from the dialog. Choose this option if you want to create an event view by
specifying your own filter and/or sort criteria.

After choosing the Create a custom view by specifying a filter option, clicking Next causes the
Filter dialog to be displayed — see step 6.

8 You cannot use any of the four following characters in the view name or description: < (less than), > (greater than), & (ampersand), or
" (double quote). The application will not allow you to enter any of these characters.
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Choose the Create a view by selecting a filter template option if you want to use one of the pre-
defined filter templates shown in the list below the options.

The templates shown in the illustration above are examples that are provided in Workspace by
default. However, the templates are customizable and will likely be different on your system. The
Description column provides information about the type of filter that is imposed for each template.

If you choose the Create a view by selecting a filter template option, select one of the available
templates. You can then do one of the following:

● Click Next to advance to the Filter and Sort dialogs. This allows you to enter additional filter
criteria if desired, or to sort the event list as desired. If you click Next, proceed to step 6.

● Click Finish to directly create the event view based on the filter template.
6. The Filter dialog allows you to enter criteria so that only the events you are interested in are

displayed in the view you are creating:

Note that if you had selected a filter template in step 5, you might expect the filter for that template
to appear on the Filter dialog. However, the filters for the available templates are specified through
a configuration file by an administrator, not through the Filter dialog.

Also, if you had selected a filter template in step 5, you can enter additional filter criteria to further
pare down the event list.

From the Filter dialog, you can do one of the following:

● Enter filter criteria for the event view, then click Next to advance to the Sort dialog to specify
how to sort the events in the view.

● Enter filter criteria for the view, then click Finish if you have no desire to specify how to sort
the events in the view.

● Click Next to advance directly to the Sort dialog if you have no desire to specify filter criteria.

Note that any filter criteria you specify through the wizard is considered the “base” filter for
the process view (as opposed to a “refined” filter that is set through the Filter function on the
event list itself). For more information, see Base Filter and Refined Filter.
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Because filtering event lists is basically the same as filtering other types of lists in Workspace
(with the exception of the specific fields on which you can filter), details of filtering is explained
in a single chapter — see Filtering Lists.

7. From the Sort dialog, you can do one of the following:

● Enter sort criteria for the view, then click Next to advance to the Column dialog to specify the
columns to display in the view.

● Enter sort criteria for the view, then click Finish if you have no desire to specify columns for
the view.

● Click Next to advance directly to the Column dialog if you have no desire to specify sort
criteria.

Because sorting event lists is basically the same as sorting other types of lists in Workspace
(with the exception of the specific attributes on which you can sort), details of sorting are
explained in a single chapter — see Work Items.

8. From the Specify Display Columns for the View dialog, move the columns you would like
displayed in the view to the list on the right, then click Finish to complete the creation of the view.

This dialog works in the same way as the Column Selector dialog available from all other lists in
Workspace. For information about using the Column Selector, see Customizing Columns in a List.

Result

The new view will appear in the list of event views.

Editing an Existing Event View
You can edit the definition of an existing event view, that is, the name, description, filter template (if
applicable), filter criteria, or sort criteria.

Procedure

1. Select the desired view in the event view list.

2. Click the Edit Event View button ( ), or select Edit from the Tools menu.

The same dialogs are displayed as when the view was originally created. For information about
those dialogs, see Creating Event Views.

Editing a System Event View

The extent to which you can edit a system view depends on whether you are the owner, author, or
recipient of the view.

For more information, see System Views.

Deleting an Event View
If you don’t need an event view any longer, you can delete it from the event view list.

Procedure

1. Select the desired event view in the event view list.

2. Click the  button, or select Remove from the Tools menu.

Result

You will be asked to confirm the deletion before it is removed from the event view list.
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Also remember that temporary views are automatically deleted when you log out. However, there is a

Remove All Temporary Views button ( )and menu selection available on the event view list that
allows you to delete all temporary event views without having to log out.

Deleting a System Event View

The extent to which you can delete a system view depends on whether you are the owner, author, or
recipient of the view.

For more information, see System Views.

System Views
Supervisors can define a work view, process view, or event view and assign it to individual users, or to
members of specified groups and positions; these views are called system views. Users that have been
assigned system views automatically get a copy of the view in their view list, along with their own
user-defined views.

System views are not applicable to case views.

System views are defined with the view wizard, in much the same way as user-defined views are
created, by specifying a name, description, filter, sort, columns, etc. The view wizard, however, contains
an additional dialog when creating or editing system views, which is used to specify the resources,
groups, or positions that will inherit the system view, as well as which characteristics of the system
view can be modified by the users that inherit them.

System views are distinguishable from user views (that is, user-defined views) by the designation in the
Type column in the view list:

Owners Authors and Recipients
There are three types of users associated with system views: owners, authors, and recipients.

● Owners - These are the users who create system views. The system view appears in the owner’s
view list, and that user has the authority to delete the system view, or edit any aspect of the view.

The system view that appears in the owner’s view list is considered the master copy of the view, that
is, it is the view definition controlled by the owner (and possibly also by authors — as described
below). The master copy of the view is denoted by “(Master)” appearing with the view name, as
shown in the following example:
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Note that the owner of a system view could also be a recipient of the view (recipients are described
below), in which case, two system views of the same name appear in the owner’s view list, one that
contains “(Master)” in the name, and one without. This is the case for the “Manpower” view shown
in the illustration above. This occurs if the system view is assigned to a group or position in which
the owner is also a member.

For more information about the master copy vs. the recipient copy of the view, see Editing a System
View.

The system view definition can contain effective dates for the view. If the system view is no longer
in effect because of a specified effective end date, the view is removed from the recipient’s view list,
but the Master view still appears in the owner’s view list (as well as the author’s view list) until it is
explicitly deleted by the owner (or author).

● Authors - When owners create system views, they can optionally designate one or more authors for
the view. Authors are typically team members that the owner wants to have control over the system
view definition. When an owner specifies an author for a system view, the author will also receive a
master copy of the view, just like the owner.

Because the author has a master copy, the author also has the authority to delete the view, or edit
any aspect of the view, including specifying recipients, additional authors, effective dates, and the
properties of the view that recipients can modify.

And like owners, authors may see two copies of the system view in their view list: the master copy,
plus the recipient’s copy if the author happens to be a member of a group or position to which the
system view is assigned.

Authors can be specified to be either individual resources, or the members of groups and positions.

Users that possess the “All System Actions” privilege are automatically assigned as an
author, and given a Master copy, of all system views that are created. This is to prevent the
situation where no one can access a system view Master copy because the system view
owner and any designated authors are no longer available.

● Recipients - These are the users to which the system view is being targeted. The recipients
automatically receive the system view in their view list.

Recipients cannot delete system views from their view lists, nor can they edit some properties of the
system view, such as the recipients and authors of the view, or the effective dates of the view.

Recipients may, however, be able to modify some properties of the view, such as the description,
filter, sort specification, and columns in the view, depending on how the view was defined by the
owner or an author.
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User Access
The ability to manage system views is controlled by user access elements, and may be restricted to
certain organizational entities or individuals.

The following user access elements are used to control system view access:

● CreateSystemView - This user access element is required to create a system view for a particular
view type (work view, process view, or event view).

● AuthorSystemView - This user access element is required to author a system view for a particular
view type (work view, process view, or event view).

For more information about user access elements, see the TIBCO Workspace Configuration and
Customization guide.

Creating a System View
System views are created with the view wizard.

Note that work views are used throughout this procedure to show how system views are created. Note,
however, the same procedure is used to create system views for process and event views.

Procedure

1. Begin the process of creating a work, process, or event view, as described in the following sections:

● Work view - Creating Work Views

● Process view - Creating Process Views

● Event view - Creating Event Views

2. In the first step of the procedure to create a view, select the This is a system view assigned to
groups/positions or user option.

The following dialog is displayed:
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This dialog displays only if you have the user access authority to create system views.

3. Specify the recipients of the system view. These users will automatically receive the view in their
view list.
a) Ensure that the Recipients tab is selected.
b) Choose whether members of groups and positions will receive the view, or whether individual

resources will receive the view:

● To send the view to members of groups and positions, select Assign system view to Groups
and Positions, then select one or more groups and positions in the Select Recipients of this
system view pane. Also ensure that the correct organization model version is displayed; it can
be changed using the Versions drop-down list.

Note that selecting a group or position in the organizational tree automatically selects all of its
subordinate elements. The system view is assigned to all subordinate groups or positions as
well.

If you assign the system view to a group or position, users that are assigned to the
group or position must have the DE.browsemodel system action, otherwise they will
not see the system view.

● To send the view to individual resources, select Assign system view to Resources, then move
one or more resources from the Available Resources list to the Recipients list.

The number of resources that can be selected to receive a system view is limited to 200; if more
than 200 is needed, the resources should be assigned to a group, then assign the system view to
a group.

System views cannot be assigned to both groups/positions and individual resources.

4. If you want the newly created system view to replace a view of the same name in the recipient’s
view list, select the Replace view if user already has a view of the same name check box.
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This check box can have two purposes: to overwrite a user-defined view of the same name, or to
specify whether or not to update a recipient’s existing system view.

For the initial creation, you will probably want to ensure this box is selected to push the system
view out to all recipients. However, for subsequent changes to the system view, you may not want
to update the recipient’s copy of the view. For more information, see Editing a System View.

5. Optionally, specify one or more authors for the system view. These users get a Master copy of the
system view in their view list.
a) Ensure that the Authors tab is selected.
b) Choose whether members of groups and positions, or individual resources, will receive a Master

copy of the system view:

● To assign a Master copy of the view to members of groups and positions, select Select Authors
from Groups and Positions, then select one or more groups and positions in the Select
Authors pane. Also ensure that the correct organization model version is displayed; it can be
changed using the Versions drop-down list.

Note that selecting a group or position in the organizational tree automatically selects all of its
subordinate elements. The Master system view is assigned to all subordinate groups or
positions as well.

If you assign the system view to a group or position, users that are assigned to the
group or position must have the DE.browsemodel system action, otherwise they will
not see the system view.

● To assign a Master copy of the view to individual resources, select Select Authors from
Resources, then move one or more resources from the Available Resources list to the Authors
list.

6. Optionally, specify the effective dates of the system view.

If no start date is specified, the system view takes effect immediately, that is, it appears immediately
in your view list; it will appear in the author’s and recipient’s view list the next time they log in. If a
start date is specified, the system view appears immediately in your view list as well as any author’s
view list, and will appear in the recipients view list the next time they log in after the effective date
and time.

If no end date is specified, the system view is in effect indefinitely. If an end date is specified, when
it is reached, the system view no longer appears in the recipient’s view list the next time the
recipient logs in after the specified date and time, but the Master view will remain in your view list
as well as any author’s view list.

To specify effective dates:
a) Choose whether the effective dates will be relative or absolute:

● Relative - The specified dates and times take effect at that date\time in each client’s local
time. That is, the effective date is relative to the client’s local time. For example, a system view
set to start on “Oct. 30, 2012 8:00 a.m.” will start at that specific local time for every client,
regardless the time zone the client is located.

● Absolute - The specified dates and times must be entered in UTC time, and will take effect at
that absolute point in time for all time zones. For example, if a UTC time of "Oct. 30, 2012 8:00
a.m." is specified, all users around the world will receive the system view at 8:00 a.m. October
30, 2012 GMT. The start and end time calculations for absolute dates and times are based on
the date/time setting of the server, which is converted to UTC and compared against the
effective UTC dates.

The following website can be used to determine your current time in UTC:

http://www.worldtimeserver.com/current_time_in_UTC.aspx

This website can be used convert time zones:
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http://www.timezoneconverter.com/cgi-bin/tzc.tzc
b) Enter the desired start and end dates/times; you can use the calendar icon to the right of the date
fields.

7. Using the check boxes in the lower right part of the dialog, select the properties you want recipients
to be able to modify in their copy of the system view.

If you clear a check box, the recipient loses the ability to modify that property of the view.

Note that owners and authors always have the ability to modify properties of the Master view;
these check boxes control the ability to modify the recipient copy.

The available properties are:

● Description - This controls whether the recipient can modify the system view description in
the view wizard.

● Filter - This controls whether the recipient can modify the refined filter for the system view,
which is the filter defined using the Filter function from the work item list, process instance list,
or event list.

● Base Filter - This controls whether the recipient can modify the base filter for the system view,
which is the filter defined using the view wizard.

If this property is turned off, the Save View function is also removed from the work item list,
process instance list, or event list. That’s because the Save View function is used to add a
refined filter to the view base filter, which is not allowed if this property is turned off.

● Sort - This controls whether the recipient can modify the sort order for the system view. This
affects using the Sort function from the work item list, process instance list, or event list, as well
as using the view wizard.

● Columns - This controls whether the recipient can define which columns to display in the view
using the Column Selector from the work item list, process instance list, or event list, as well as
using the view wizard.

● Select Process [process system views only] - This controls whether the recipient can modify
which processes are included in the process system view, using the view wizard.

● Select Template [event system views only] - This controls whether the recipient can modify
which filter template is used to create the event system view, using the view wizard.

● Select Work List [supervised system work views only] - This controls whether the recipient
can modify the selection of work lists for organizational entities or resources.

Note that many of these functions are also controlled via user access controls. Therefore, even
though the system view definition gives the recipient the ability to modify the view in some
way, the recipient must also possess the appropriate user access.

8. Click Next to proceed to the next dialog in the view creation procedure. Refer to one of the
following steps, depending on the type of view you are creating:

● Work view:

— personal work view: Creating a Personal Work View - step 4

— supervised work view: Creating a Supervised Work View - step 4

● Process view: Creating a Process View - step 3

● Event view: Creating an Event View - step 4
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Editing a System View
If you are a recipient of a system view, you can edit the copy of the view to the extent allowed by the
view definition; the view definition specifies which properties are editable by recipients (filter, sort,
columns, and so on.).

If you are the owner or author of a system view, you can edit the master view definition:

Editing the master system view definition allows you to change aspects of the system view, such as the
recipients, authors, effective dates, and which properties the recipients can modify in their view copy.

There may be occasions when you want to edit a system view definition, but you don’t want to modify
the view definition for recipients that already have the system view in their view list. In these cases, you
can clear the Replace View if user already has a view of the same name check box when you edit the
view. Then if you add additional recipients to the view definition while you are editing it, that view
definition is not pushed out to the recipients that already had it; their view definition remains what it
was. The new definition is pushed out only to the new recipients you added to the view definition.

Procedure

1. Select the view in the view list.

2. Click the Edit View button ( ), or select Edit from the Tools menu.

Deleting a System View
System views can be deleted only by the owner or a designated author; the recipients of a system view
cannot delete the system view from their view list.

Procedure

1. Select the view in the view list.

2. Click the  button, or select Remove from the Tools menu.

You are asked to confirm the deletion before it is removed from the view list.

If a user is currently logged in when a system view for which they are the recipient is deleted, the
view is removed from their view list the next time they log out and log back in.

Case Views
Case views are filtered and sorted views of global case data.

Global case data represents data that is defined as global in scope, and that can be accessed and
updated by multiple BPM applications. It is defined in a Business Object Model (BOM) using TIBCO
Business Studio.

Global case data is defined as a case class, with attributes that contain specific pieces of information
about the class. For example, there could be a Customer class, with attributes for first name, last name,
social security number, date of birth, and so on. A process can create an instance of the Customer class
for each customer. Then other processes can access, and possibly update, that same instance of the
Customer class.
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In Workspace you can create views that allow you to see the instances of global case data that have been
created, as well as see the work items, process instances, and events that reference each instance of case
data.

Creating Case Views
A case view wizard is provided to create case views.
When creating a case view, you can choose to place the view in a category, or make it uncategorized.
Placing a case view in a category is like placing a file in a folder. For example, in the following, the
"Prospects" case view is uncategorized (because it is not under a folder icon), and the other case views
are in two categories: Customers and Orders:

Procedure

1. Display the case views list by clicking the Case Views button in Workspace.
The way in which you proceed depends on whether you want to create an uncategorized or
categorized case view:

● To create an uncategorized case view:

1. Click anywhere in the white space of the Case Views list so that nothing is selected in the
list.

2. Click the  button, or select New from the Tools menu

3. Proceed to Step 2.

● To create a case view in a category that already exists:

1. Select the existing category.

2. Click the  button, or select New from the Tools menu

3. Proceed to Step 2.

● To create a case view in a category that does not yet exist:
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1. Create the category: either click anywhere in the white space (to create the category at the

top level), or select an existing category (to create a subordinate category), then click the 
button.

2. On the Add Category dialog, name the category, then click OK.

The category name can be any arbitrary name desired; just like a folder name. However, all
category names at the same level in the tree must be unique.

3. Select the category you just created.

4. Click the  button, or select New from the Tools menu.

5. Proceed to Step 2.

2. On the New Case View dialog, specify the name and an optional description for the case view.

All case view names must be unique, even at different levels in the tree.

3. Optionally select a category by clicking the Category selection, then choose a category from the list.
This is more applicable to editing an existing case view; it allows you to move a case view to
another category.

4. In the Select a case class for the Case View section, expand the object model reference to expose the
case classes:

5. Select the case class for which you want to create a case view, then click Next, or double-click the
case class to proceed.

6. Specify a filter for the case view so that only the cases that satisfy the filter are displayed.

Filtering the case view consists of the following sub-tasks:
a) Choose the grouping for the filter.

For general information about choosing a filter grouping, see Choosing a Filter Grouping.
b) Select the filter attributes.

For general information about selecting filter attributes, see Selecting Filter Attributes.

The attributes available for filtering case views are those that were specified as searchable when
the selected data class that was selected was defined in TIBCO Business Studio. For information
about the attribute types used with case data, see Case View Filter Attribute Types.

c) Specify a logical operator and value on which to filter.

The logical operators available depends on the data type of the attribute on which you are
filtering. For example:
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Most of the operators are the same as those available when filtering other types of views, as
described in Filtering Lists. However, there are a few operators that are unique to filtering case
views. For information about these, see Logical Operators for Filtering Case Views.

Also note that some attributes may be arrays. Filtering array values is described in Filtering
Array Attributes in Case Views.

7. After choosing a logical operator and entering a value, you can add the filter attribute to the filter
expression by clicking the Add button:

8. Optionally add additional attributes to the filter expression, then either click Next to specify a sort
for the case view or click Finish to view the results.

For information about specifying a sort, see Work Items.

The list of cases that satisfy the filter expression is displayed in the upper-right pane. For example:

You can also optionally display the case references that represent the cases by selecting Show Case
Reference from the View menu. This selection works as a toggle.

9. Select one of the case entries to display details of the case in the lower-right pane. For example:
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The Case Data Preview tab shows the data in each of the attributes of the case.

The Work Items and Process Instances tabs list the work items and process instances associated
with the selected case. These tabs allow you to perform the usual functions available for those types
of items.

Case View Filter Attribute Types

The attributes that can be used in filter expressions when creating case views are of specific types, which
allows only certain types of values.

Attribute Type Description

Boolean True or false. You can test whether the attribute value is equal to true or false,
or whether or not it contains a value (Null or Not Null).

Date The Filter dialog provides a date picker to choose date.

Date Time The Filter dialog provides a date and time picker to choose a date and time.

Date Time and
Time Zone

The Filter dialog provides a date and time picker, plus fields in which you can
specify the time zone offset, which is the number of hours you are located, plus
or minus, from UTC (Coordinated Universal Time):

Decimal Consists of numbers with decimals.

Duration The Filter dialog provides fields (Years, Months, Days, Hours, Minutes, and
Seconds) to specify a duration of time.
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Attribute Type Description

Enumeration Attributes of this type allow you to only choose among a list of valid entries.
For example:

Integer Consists of one or more of the numbers 0-9.

Object An entity that contains its own attributes. For example, lineItems is an
object:

Text Consists of any number of letters, numbers, or special characters (e.g., #, $,
etc.)

Filtering on text is case sensitive.

Note that text attributes are the only attributes for which you can use wildcard
characters. See Wildcard Characters .

And if you are filtering on text that contains any of these special characters in
a case view, they must be “escaped”:

*, ?, ‘, _, % or \

For more information, Filtering on Special Characters .

Time The Filter dialog provides a time picker.

URI Consists of text in the format of a Universal Resource Identifier (URI).

Logical Operators for Filtering Case Views

There are a few logical operators that are unique to filtering case views.

These operators are described in the following table.
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Between

Not Between

Returns true if the attribute value is between (or not between) value1 and
value2 (inclusive). These operators are available for integer and date
attributes. For example:

In

Not In

Returns true if the attribute value is one of the specified values (or not one
of the specified values). For example:

This returns true if the acctNum attribute value begins with 200 or 300
(note that the wildcard character can only be used if the attribute data type
is text).

Add values by entering them in the field, then clicking the  icon. Remove
values from the list by clicking the red X icon to the left of the value.

Null

Not Null

Returns true if the attribute does not contain a value (Null); or it does
contain a value (Not Null).

Size Equal
Size Not Equal
Size Greater Than
            .
           .
           .

These operators are used to return cases based on the number of entries in
the array. For more information, see Returning Cases Based on Number of
Members in an Array .

Wildcard Characters

There are a couple of wildcard characters that are unique to filtering case views.

They are:

● % (percent) - Matches zero or more of any character. This works the same as an asterisk (*).

● _ (underscore) - Matches any single character. This works the same as a question mark (?).

For general information about using wildcard characters, see Using Wild Card Characters.
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Filtering Array Attributes in Case Views

When filtering case views, some of the attributes in the case class may be arrays.

If the attribute is an array, its name is followed by [ ] characters in the case view list. For example:

When you are filtering an array, or an item in an array, a field appears next to the array name on the
Filter dialog. For example:

The field appears for most operators, like Equal, Not Equal, Greater Than, Null, and so on (there are
some exceptions that are described below). The valid entries for this field are:

● ANY - This causes the filter to return the cases in which any of the items in the array match the
specified criteria.

● ALL - This causes the filter to return the cases in which all of the items in the array match the
specified criteria.

● An index number - This causes the filter to return the cases that match the specified criteria at that
index number (zero based).

Nested Arrays

A case view filter can also included nested arrays. For example:

This nested-array filter returns the cases in which any contactNames array, in any lineItems array,
contains the name “Baker”. For example:
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Returning Cases Based on Number of Members in an Array

When you are filtering on an array attribute, a number of Size... operators are available:

These operators allow you to specify that cases be returned that have a certain number of members in
the array.

For example, this filter returns the cases for which the lineItems array contains more than 10
members:

Using Tags in Compound Expressions for an Array

You can use tags in filter expressions to build more complex compound expressions. Tags are used
when you want to stipulate that one or more of the compound expressions are to evaluate the same
members of the array, or different members of the array.

Tags only make sense when you are building compound expressions.
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A tag is entered in the array field on the Filter dialog by entering a $ character followed by a letter (a-z),
optionally followed by additional letters or integers. For example:

The tag value following the $ is arbitrary, although each tag value represents a unique member of the
array.

Examples best illustrate this.

Assume the following represents a single case, which represents an order. The order contains two
items, each represented by a lineItems array:

quantity partNum

lineItems[0] 1000 8829-PPP

lineItems[1] 12 HH2886

And you want a filter that returns cases in which one lineItem has quantity = 1000 and a different
lineItem has partNum = HH2886.

If you built the following filter, it would not return the case (order) because it would require a single
lineItem to match both conditions:

You could, however, use tags in the following way:

Because each of these expressions have different tags ($a and $b), the quantity attribute must equal
1000 in one member of the array, and the partNum attribute must equal HH2886 in a different member of
the array, all within the same case for the case to be returned.

To extend the previous example, assume you want the cases returned in which one lineItem matches:

● lineItems.quantity = 150 and lineItems.partNum = 227749

and another lineItem matches:

● lineItems.quantity = 75 and lineItems.partNum = 3883930

You would use the following filter expression:
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Notice that the first two expressions contain “$x” as the tag, which means that those must match in the
same lineItem. And the second two expressions contain “$y” as the tag, which means that those two
must match in the same lineItem.

Editing an Existing Case View
You can edit any part of the definition of a case view, that is, the name, description, filter criteria, or sort
criteria.

Procedure

1. Select the desired case view in the case view list.

2. Click the  icon, or select Edit from the Tools menu.

Result

The same dialogs are displayed as when the view was originally created. For information about those
dialogs, see Creating Case Views.

Deleting a Case View
If you don’t need a case view any longer, you can delete it from the case view list.

Procedure

1. Select the desired case view in the case view list.

2. Click the  icon, or select Remove from the Tools menu.

You will be asked to confirm the deletion before it is removed from the case view list.

Result

If you remove a case view, and it is the only view in a category, the category is automatically removed.
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Business Services

Workspace can be used to start and process business services.

A business service is a set of actions that accomplishes some sort of business function. For example, a
business service could be designed to handle an incoming insurance claim. This business service may
consist of the following actions:

● When the business service is started, a form is displayed that allows you to enter the claimant’s
policy number.

● When the form with the policy number is submitted, a database is accessed to retrieve the claimant’s
policy information.

● Another form is displayed that contains the policy information.

● After reviewing the policy information, and deciding it is a valid claim, submitting the form may
start an instance of a process that is used to process the claim.

● The process instance that is started causes a work item to be sent to the appropriate user, who must
open it and work on it.

Note that business services are stateless, meaning that if it consists of a number of forms, and you enter
data into some forms, then cancel the business service (by clicking the Cancel button on a form) before
completing the business service, none of the data you entered on the previous forms is saved.

If a business performs a stateful action, that is, something that cannot be reversed (e.g., writing to a
database, starting a process instance, etc.), typically it will be the last action performed by the business
service.

The example business service described above is just one simple example. Depending on how it is
designed, a business service may consist of the following types of actions:

● Display forms - Multiple forms may be displayed in sequence. When a business service includes
multiple forms, the user that starts the business service will be the one to work through all of the
forms — as soon as the user submits one form, the next one in the sequence is displayed. Note,
however, that if there is an action of some sort in-between forms (database access, script execution,
etc.), there may be a delay in displaying the next form. If this occurs, a shaded mask is shown over
the previous form, and a "Waiting for response" message is displayed. For example:
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● Start process instances - One or more instances of processes may be started by a business service,
resulting in one or more work items being sent to the appropriate users to process them.

If the business service starts process instances, and results in work items, you can see those in the
process instance and work item lists, respectively.

This stateful type of action would typically be done as the last action in the business service.
● Access databases - The business service may access a database to read or write information.
● Scripts - Scripts can perform various functions, such as calculations, validation, etc.
● Web services - External web service may also be called to perform some custom function.
● Logical branching - The flow of the business service may branch in various ways, depending on its

design.

Displaying the Available Business Services
To display the available business services, click the Business Services button in the lower-left pane.

The list of business services that are available to you (because of your access privileges) are displayed in
an expandable/collapsible folder/file structure.

There are three main sections in the business service list:

● Recent - These are the business services that you started recently. It allows you to quickly access
those that you start frequently.

The number of business services that are listed in the Recent section is customizable on the Options
dialog, from 0 to 10 (see Business Service Options).

76

TIBCO® Workspace User's Guide



● Favorites - This is analogous to Favorites in a web browser. You can add, edit, or remove business
services from the Favorites section, as follows:

— Add to Favorites - Click on a business service in the All Business Services section, then click

the  button on business service list toolbar.

— Edit Description - This is used to edit the description of a business service in the Favorites
section. Click on a business service in the Favorites section whose description you want to edit,

then click the  button on business service list toolbar.

— Remove from Favorites - Click on a business service in the Favorites section, then click the 
button on business service list toolbar.

● All Business Services - This is a categorized list of all business services to which you have access.
The categorization is specified when the business service is created using TIBCO Business Studio.

There is special folder/category in this section named uncategorized that includes any business
services that were not given categories when they were created.

There is also a forth section (Query Business Services) that is added once you use the Find
function — see Finding a Business Service .

You can refresh the list at any time to get the most recent business services from the server by clicking

the  button or selecting Refresh Business Services on the View menu.

Finding a Business Service
A Find function is provided to help you locate a business service in the business service list.

To use the Find function, click the  button, or select Find Business Services from the Tools menu.
The following field is displayed in the business service list toolbar.

Enter a query path, then click the  button (which is activated when you enter a path in the Query
path field).

The results of the query are displayed in a new a Query Business Services category in the business
service list. For example:

The query path must be in one of the following forms:

● /Category/**

● */Category/**

where Category is one or more category names. If you start the query with a / character, the category
you name must be at the root level, which is All Business Services. If you start the query with a *
(wildcard) character, the category you name can be subordinate to categories in the root level.

The following shows two example queries:
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Query 1:
/CustomerService/**

Returns all business services in the CustomerService category that is in the root directory (it must be in
the root folder since there is no leading * in the query string):

Query 2:
*/Fields/**

Returns all business services in the Fields category (which must be a subordinate category because of
the leading * in the query string):

Starting a Business Service
There are a number of ways in which a business service can be started.

To start a business service, make a selection in the business service list, then do one of the following:

● Click the  button,

● double-click on the business service name,

● press Enter, or

● select Start Business Service from the Tools menu.

The business service will start and display a form. Fill in the form and complete the business service
according to the instructions for the particular business service you are using.

Business Service Forms
The forms that are displayed when you start a business service can be displayed either in the Preview
Pane or in a floating dialog.

To specify the placement of business service forms, select either Dock Forms or Float Forms from the
business service list View menu.

Note, however, that selecting the placement of forms in this way is only applied during the current
login session. To specify the default business service form placement, set it on the Options dialog — see 
Business Service Options.
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Work Items

A work item represents an action item. It relates to a task in an active process instance. A user manages
the work items in their work list by performing some sort of action upon them, such as entering data on
a form, forwarding the item to another user or group, saving it and placing it back in the work list for
further action at a later time, or by “submitting” it (completing the required action and sending it on to
the next task in the process).

Work Item Lists
A work item list presents all of the work items that are in a particular work view.

To display a work item list, select (single click) a work view in the work view list. Initially, the default
work view — the Inbox — displays all work items that you can work on. Although you can modify the
filter and sort specifications for the Inbox so that it displays a subset of those work items.

The Inbox in the work view list is controlled by a user access element. Therefore, if you do not have the
proper user access, you will not have this view.

There may also be other work views available that display the work item list filtered and sorted in
different ways. For more information about using views, see Views.

Information about each work item is provided in the columns of the work item list. The specific
information that is displayed on your system will depend on how your system was set up — see Work
Item List Columns.

Why Are Work Items Sent to Your Work Item List
When a business process is being defined, a “distribution strategy” is specified for each user task (each
work item results from a user task in a business process). The distribution strategy specifies how to
distribute, at runtime, a work item that is generated from the user task.

The distribution strategy is shown in the Distribution Strategy column in the work item list. For
example:

The order of your columns may appear different than what is shown here. Use the Column Selector to
change them — see Customizing Columns in a List .

The distribution strategy will be one of the following:

● Offer - This means the work item is being offered to you to work on. Note that depending on how the
user task that resulted in the work item was defined, the work item may be offered exclusively to
you, or it may be offered to a group of users, any of which can open and work on it.

If a work item is offered to a group of users, and you open and work on it (i.e., you enter or change
some data in the work item), the work item is removed from the work list of all other users.

● Allocate - This means the work item was given only to you to work on.

Don’t confuse distribution strategy with work item state. The distribution strategy never changes — it
stays either “offer” or “allocate”, indicating whether the work item was initially offered or allocated to
you. Whereas the work item’s state changes throughout the work item’s lifetime (note, however, that
two of the possible work item states are “offered” and “allocated”). For more information about work
item state, see Displaying Visible Hidden Work Items.
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Selecting Items in a Work Item List
The effect of selecting an item from the work item list (i.e., single-clicking an item, or moving the
highlight bar with the keyboard arrow keys) depends on whether or not the preview feature is turned
on.

Note that double-clicking a work item in the work item list constitutes opening the work item. Opening
the work item causes the form for that work item to be displayed. For information about opening work
items, see Opening Work Items.

● If preview is turned off, selecting an item from the work item list has no effect.
● If preview is turned on, a “preview pane” is displayed below the work item list. The preview pane

presents two tabs:

— Summary - This tab provides all of the available information about the work item (whereas the
columns in the work item list may not provide all information because the columns that are
displayed can be customized). For example:

— Data Preview - This tab provides a preview of the data for the selected work item. It allows you
to see any data that has been saved without having to open the work item. For example:

Note that if you do not have the necessary access privileges to preview work item data, the
Data Preview tab is not displayed (in this case, neither “tab” is displayed; the work item
summary data is shown with no tabs in the preview pane).

The preview pane can be turned on and off by selecting Preview from the View menu on the work item
list. The following drop-down menu is displayed:
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You can turn preview on by selecting either of the first two selections — the difference between the two
is where the work item form will be displayed when you open (double-click) the work item in the work
item list. You can turn off the preview feature by selecting the Preview Off selection. For more
information about the preview feature, see The Preview Pane.

For additional information about selecting items in general from lists, see Selecting Items in a List.

Refreshing the Work Item List
When a work item list is initially displayed, it is a snap shot of the work items at that point in time. You
can refresh the list to get the most recent list of work items from the server.

Select Refresh Work Items from the View menu, or click the  button on the work item list.

If you have defined filter and/or sort criteria for the work item list, they will be applied on the refreshed
list of work items.

If you have a work item selected in the work item list when you refresh the list, that same work item
will be selected after the list is refreshed — assuming that that work item is still in the list (it could have
been allocated to another user since the last time your list was refreshed, in which case, it will no longer
appear in your list). If the work item you had selected is no longer in the list, the work item in that
physical location in the list will be selected after the list is refreshed (e.g., if you have the third work
item on page 3 selected, but that particular work item is no longer in the list, the third work item on the
page 3 will still be selected after you refresh the list — it will just be a different work item).

Auto-Refresh of Work Item Lists

Work item lists also have an “auto-refresh” feature that, when enabled, causes the work item list to be
automatically refreshed at specified intervals.

When auto-refresh is either turned on or off using this feature from a work item list, it applies only to
the list from which you set it. You can also turn auto-refresh on or off globally so that it affects all work
item lists (except the individual lists on which it was set) using a setting in user options (for
information, see Auto-Refresh).

To enable or disable the auto-refresh feature for the currently displayed work item list, either select

Auto-Refresh from the work item list View menu, or click the  button on the work item list.

The following dialog is displayed:

To enable auto-refresh, check the Auto-refresh check box, specify the number of seconds you would
like between refreshes (the minimum you can specify is 30 seconds), then click OK.

There is an indicator on the left side of the work item list status bar that tells you the current state of the
auto-refresh feature:
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This indicator will change to “Refreshing...” when the list is in the process of being refreshed.

The auto-refresh setting for an individual list is persisted, that is, it is remembered between logins. Note
that persisted settings are saved on the server, so if you log onto a different machine, those settings will
be in effect on that machine also.

Filtering a Work Item List
Filtering a list of work items involves entering filter criteria so that only some of the work items are
shown in the list, rather than all of them. Filtering a list of work items allows you to display only the
work items you are interested in.

For example, you may only be interested in work items that arrived in the work item list after Dec. 15,
2007. You can filter the list so that only those work items are shown.

The filtering function allows you to build a “filter expression” that is applied to all work items in the
list. If the work item satisfies the filter expression (e.g., it arrived after Dec. 15, 2007), it is shown in the
work item list; if it does not satisfy the filter expression, it is not shown in the list (and is not
downloaded from the server).

Because filtering work item lists is basically the same as filtering other types of lists in Workspace (with
the exception of the specific fields on which you can filter), details of filtering is explained in a single
chapter — see Filtering Lists.

Sorting a Work Item List
Workspace allows you to sort the information in the work item list so that work items are listed in the
desired order.

For example, you may want to list all work items by priority number, then sort those by work item ID.
The sort function allows you to choose which columns on the work item list to sort on.

Because sorting work item lists is basically the same as sorting other types of lists in Workspace (with
the exception of the specific fields on which you can sort), details of sorting is explained in a single
chapter — see Work Items.

Displaying Visible Hidden Work Items
There may be work items in your work item list that are actually hidden.

The reasons they may be hidden are:

● They are work items that are associated with a process instance that has been suspended (see 
Suspending a Process Instance).

● They are work items that have been pended, that is, a timer has been set to make them hidden until a
specified date/time, or for a specified period of time (see Pending Work Items).

You can display hidden work items in your work item list by selecting either Only show hidden work
items or Show visible and hidden work items from the View menu on the work item list:
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There is also a Visibility column you can display (it’s not displayed by default) using the Column
Selector that indicates whether or not each work item in the list is visible or hidden.

Work Item List Columns
By default, certain columns are displayed in a work item list. You can easily customize the columns that
are displayed by either using the Column Selector, or manually.

For information, see Customizing Columns in a List.

The following table describes the columns of information that can be displayed on the work item list:

Column Description

Activity ID Identifies the user activity within the process that generated the work item. This
number can be used in the event viewer to identify the work item across all
components.

Attribute #1 - #40 These attributes, which can be populated via a script in the process, can contain
various information.

Deadline Contains a clock icon if the work item has a deadline by which the work item
must be worked on and submitted.

Description A description of the user task associated with the work item. This is specified in
TIBCO Business Studio when the process / user task is defined.

Distribution
Strategy

Describes the method used to distribute the work item when it was originally
created, either offered or allocated.

For more information, see Why Are Work Items Sent to Your Work Item List .

Target Date A date and time in this column indicates the work item has a deadline. For
more information, see Work Item Deadlines .

Group ID This identifies a number of work items that are grouped together in the process
definition for some purpose.

Instance
Description

A description of the process instance. This may or may not have been specified,
depending on how the process was defined.

ID A unique alphanumeric value identifying the process instance from which the
work item was created.

Name The name of the user task associated with the work item.

Process Name The name of process that was started to create this work item.

Schedule Status This indicates if the work item is inside its schedule period, which is considered
from the start date/time (Start Date column) to the target date/time (Target
Date column). The possible values are: BEFORE, DURING, AFTER and
NO_SCHEDULE.

Start Date The date and time the work item is scheduled to start. If a scheduled start date/
time was not defined, this column is empty.

State The work item’s current state. For more information, see Work Item State .
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Column Description

State Image An icon that indicates the work item’s current state. For more information, see 
Work Item State .

Visibility Indicates whether or not the work item is visible. For information, see 
Displaying Visible Hidden Work Items .

Work Item ID A unique number identifying the work item.

Work Item
Priority

A numeric value indicating the relative importance of the work item. This
defaults to 50, but can be modified; see Setting Work Item Priority .

Work Item
Version

Indicates how many times the work item has changed state. The version
number starts at 0 when the work item is created, and is incremented by one
each time it changes state.

Finding a Work Item
A Find function is provided to help you locate a work item in the work item list.

Note that this function searches through the entire work item list, not just the currently displayed page.
However, if there is a filter currently applied to the list, it only searches through the work items that
satisfy the filter.

Procedure

1. Click the  button on the work item list toolbar, or select Find Work Items from the Tools menu.
The following fields are displayed in the work item list toolbar.

2. From the drop-down list in the first field, choose an attribute that you want to search on. For
example, to find a work item that has a certain description, choose “Description”.

3. From the drop-down list in the second field, choose the operator that is appropriate for your search.

4. In the last field, enter the value you want to search for.

You can use the * character as a wildcard. For example, the following finds all work items whose
description begins with “C”:

If you select a date attribute to search on, a calendar icon is displayed from which you can select a
date, plus fields are displayed to the right of the calendar icon in which you can enter a time.

5. Click the  button (which is activated when you enter a value to search on) to display the find
results.

The Find fields can be closed by either clicking the X to the left of the fields, or by clicking the 
button again.
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Work Item State
There are two columns available on the work item list that indicate the work item’s current state: State
Image and State. The only difference is that one is an image and the other is text.

By default, the first column in the work item list displays icons that indicate the work item’s status. The
following table shows the possible icons and their meanings:

State
Image State Description

Offered The work item is being offered to you to work on. When a work
item is in an Offered state, you can:

● open and work on the work item (while it is open, its state
changes to Opened),

● allocate the work item to yourself, causing it to be removed
from all other user’s work lists,

● allocate the work item to another user, causing it to be removed
from all work lists other than the user’s to which it was
allocated, or

● skip the work item, causing it to be submitted and the process
to advance to the next task (all required fields must be filled in.

For more information, see Allocating Work Items and Skipping
Work Items .

Allocated A work item with an allocated state appears only in your work list.

Work items can be allocated to a specific user in the following
ways:

● by the system when it is initially distributed,

● you can allocate a work item to yourself, or

● you can allocate a work item to another user.

For more information, see Allocating Work Items.

Created The work item has been created, but not yet enabled. The
functionality needed to get a work item to this state has not been
implemented.
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State
Image State Description

Opened The work item is currently open by the logged-in user. Opening a
work item implicitly allocates it to the user who opened it. The
work item is removed from the work lists of other users to whom
the work item had been offered.

Pended This occurs when you open a work item, perform some work on it,
then close it without submitting it. Once it is in this state, the work
item will appear only in your Inbox.

Pend Hidden The work item has been pended until a specific date/time, or for a
specified period of time. (Note that to see this state, you must be
viewing hidden work items — see Displaying Visible Hidden
Work Items .)

For more information, see Pending Work Items .

Suspended The process instance to which this work item is associated is
currently suspended. (Note that to see this state, you must be
viewing hidden work items — see Displaying Visible Hidden
Work Items .)

Allocating Work Items
A work item can be allocated to a specific user. This means that the work item is supposed to be worked
on by that specific user — the work item appears only in that user’s Inbox, with a state of Allocated.

A work item can be allocated to a specific user by the system when the work item is created (for more
information, see Why Are Work Items Sent to Your Work Item List).

There are also functions available from the work item list that allow you to allocate a work item to
yourself or to another user.

You can also change a work item that is allocated to you back to an Offered state, so that other users can
work on it.

These functions are described in the following subsections.

Allocate Work Item(s) To Yourself
This function allows you to allocate one or more work items to yourself. It changes the state of the work
items to Allocated so that only you can work on them. The work items are removed from the Inbox of
all other users.

This function can be used only if the work items are currently being offered to you; i.e., their state =
Offered.

Also note that if you want to allocate work items to yourself from a supervised work view, the work
items must also be offered to you (the creator of the supervised work view), that is, the work items
must be listed in your Inbox with a state of Offered.

Procedure

1. Select one or more work items in the work item list that currently have a state of Offered.

2. Click the  button, or select Allocate Work Item(s) To Self from the Tools menu on the work item
list.
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Result

The work items are now allocated only to you, and are removed from all other user’s Inboxes.

Re-Offering Work Item(s)
This function allows you to change work items that are currently allocated to you (state = Allocated) or
that you have modified (state = Pended), back to an Offered state. They are offered to the users to whom
they were originally offered.

Procedure

1. Select one or more work items in the work item list that currently have a state of Allocated or
Pended.

2. Click the  button, or select Re-Offer Work Item(s) from the Tools menu on the work item list.

The work item’s state changes to Offered, and it reappears in the Inbox of the users to whom it was
originally offered.

Result

Note that if the work item’s state is Pended, and data had been added/changed on the form when it was
open, that data is retained in the work item when it is re-offered.

Allocate Work Item(s) to Another User
This function allows you to allocate work items to another user. It removes the work items from your
work item list, then adds them to the Inbox of the user to whom you have allocated them, with a state
of Allocated.

You can choose the user to whom you want the work items to be allocated, as follows:

● the original "offer set", that is, the group of users to whom the work item was originally offered —
see Allocate Work Item(s) To Offer Set.

● the "world", that is, all available users — see Allocate Work Item(s) To World.

Allocate Work Item(s) To Offer Set

This function allows you to allocate one or more work items to a user from the original offer set, that is,
the group of users to which the work items were originally offered.

Work items allocated to the original offer set can have a state of Offered, Allocated, or Pended.

Procedure

1. Select one or more work items in your work item list.

2. Click the  button, or the Allocate Work Item(s) To Offer Set menu selection from the Tools
menu on the work item list.

A screen similar to the following is displayed:
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This screen allows you to choose the user to whom you would like to allocate the work item(s).

3. Click on the user to whom you would like to allocate the work item(s).

You can optionally use the Find button ( ), or select Find Resource(s) from the Tools menu, to
help locate the desired resource. For information about using the Find function, see Finding a
Resource.

If desired, you can either display or hide the resource details in the lower details pane by clicking

the Hide/show resource details button ( ), or by selecting Show Resource Details from the Tools
menu — this selection is a toggle.

You can also choose which attributes and capabilities to display in the columns by clicking the

Select Columns button ( ), or by selecting Select Columns from the Tools menu. For more
information, see Using the Column Selector.

4. Optionally check the Revert Work Item Data check box. If this box is checked, it causes any data
that had been entered/modified in the work item prior to allocating it to revert to its original value.
(If any data in the work item had been entered/modified, the work item will have a state of Pended.)

5. Click the OK button.

Result

The work item(s) will appear in the Inbox of the user that you selected, with a state of Allocated.

Allocate Work Item(s) To World

This function allows you to allocate one or more work items to any available user.
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Procedure

1. Select one or more work items in your work item list.

2. Click the  button, or the Allocate Work Item(s) To World menu selection from the Tools menu
on the work item list.

A screen similar to the following is displayed:

This screen allows you to choose the user to whom you would like to allocate the work item(s).

3. Optionally, choose whether unique names or display names are shown in the list of organizational
entities.

When organizational entities are created in TIBCO Business Studio, they are given both "unique
names" and "display names" (also called "labels"). The Tools menu contains a Show unique names
for organizational entities selection that toggles between the two displays. By default, the display
names are shown. Hover the mouse pointer over an organizational entity to view both names for a
particular organizational entity:
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You can also choose which attributes and capabilities to display in the columns by clicking the

Select Columns button ( ), or by selecting Select Columns from the Tools menu. For more
information, see Using the Column Selector.

4. Select an organizational entity to which the user has been mapped, in the left pane.

The users that have mapped to the selected entity are listed in the resource list in the upper-right
pane.

You may not be able to see all resources mapped to a particular position because there are
resources mapped to that position that were created in an LDAP container for which you
don’t have visibility (because of an organization relationship). (This applies only to
positions, not to groups.)

Note, however, the counts shown to the right of the position name in the left pane is the
total count for the resources in the position. From this count, you can determine if there are
resources mapped to the position that you cannot see.

For more information, see the Container Organization Relationships section in the
Organization Browser User’s Guide.

Also, if a resource has been mapped to a position or group with a start date that has not yet
occurred, or an end date that has passed, that resource will not appear in the resource list.
However, the total count of resources shown to the right of the group or position name in
the left pane also reflects those resources that are not yet “effective” because their start
date has not occurred.

5. From the resource list, select the user to whom you would like to allocate the work item(s).

You can optionally use the Find button ( ), or select Find Resource(s) from the Tools menu on the
resource list, to help locate the desired resource. For information about using the Find function, see 
Finding a Resource.

If desired, you can either display or hide the resource details in the lower details pane by clicking

the Hide/show resource details button ( ) or by selecting Show Resource Details from the Tools
menu — this selection is a toggle.

Refresh the list at any time my clicking the Refresh button ( ) or my selecting Refresh List from
the Tools menu on the resource list.

You can also choose which attributes and capabilities to display in the columns by clicking the

Select Columns button ( ), or by selecting Select Columns from the Tools menu. For more
information, see Using the Column Selector.
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6. Optionally check the Revert Work Item Data check box. If this box is checked, it causes any data
that had been entered/modified in the work item prior to allocating it to revert to its original value.
(If any data in the work item had been entered/modified, the work item will have a state of Pended.)

7. Click the OK button.

Result

The work item(s) will appear in the Inbox of the user that you selected, with a state of Allocated.

Finding a Resource

A Find function is available from the Allocate Work Item(s) To Offer Set and Allocate Work Item(s) To
World dialogs.

Also see Allocate Work Item(s) To Offer Set and Allocate Work Item(s) To World, respectively.

The Find function allows you to find the desired resource(s) in a list of resources. Using the Find
function, you can search for any matching text in any of the columns on the list of resources. For
example, you can search for all resources who have a resource name containing “Johnson” by searching
on the Resource Name column.

Procedure

1. On the Allocate Work Item(s) To Offer Set or Allocate Work Item(s) To World dialog toolbar, click

the  button, or select Find Resource(s) from the Tools menu.

This causes the Find fields to be displayed above the list of resources:

2. From the drop-down list on the second Find function field, select the column on which you want to
search:
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This list contains the following:

● Resource Name

● Container Name

● Resource attribute fields - These are used to store information about resources. For example, a
“Cellphone” resource attribute (as in the example above) can be used to store each resource’s
cell phone number.

The resource attributes available on each system is different, depending on how the
organization model was designed. For more information about resource attributes, see the
Organization Browser User’s Guide.

3. Enter the text you want to search for, then click the  icon to the right of the Find field. For
example, if you selected “Resource Name” in the second Find function field, then entered “John” in
the Find field, the Find function will return all resources whose Resource Name contains “John”
anywhere in the Resource Name value:

4. After finding the desired resource, you can perform any of the available functions as described in
this document.

The Find function can be turned off by clicking the  button.

Work Item Deadlines
When a user task is defined in a process, a deadline may be specified on that task. Work items that are
created as a result of the user task will have a deadline, which is specified either as a certain date, or a
period of time from when the work item was created.

If a work item has a deadline, a clock icon is shown in the Deadline column, and the deadline date is
shown in the Target Date column:

If the deadline expires while the work item is still in the list, the deadline icon turns red.

Note that when calculating deadlines that are defined to expire in a specified period of time, only
working days and times are used to determine when a deadline should expire. Working days and times
are specified in one or more TIBCO ActiveMatrix BPM calendars that are defined on your system. For
information about TIBCO ActiveMatrix BPM calendars, see the TIBCO Openspace User’s Guide.
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Outstanding Work Items
The "outstanding work items" for a process instance are all of the work items associated with that
process instance that are sitting in users work item lists, waiting to be completed and submitted. They
represent the user task(s) at which the process flow is currently sitting.

An active process instance may have only a single outstanding work item, or it might have many
because the process flow may have taken multiple paths, depending on how it was designed.

The process instance list contains two functions that allow you to display the currently outstanding
work items for the selected process instance:

● Show Outstanding Work Items - This function causes a temporary work view to be created under
the My Work folder in the work view list. This work view will contain all of the outstanding work
items for the selected process instance that are currently offered or allocated to you.

For more information see, Show Outstanding Work Items.

● Show Supervised List of Outstanding Work Items - This function causes a temporary work view to
be created under the Supervised Work folder that contains one of the following:

— Outstanding work items that were sent to selected organizational entities (groups, organization
units, or positions) that are associated with the selected process instance.

To view work items that were sent to specific groups, organization units, or positions, you must
have been given access permission(1) to view work items in that specific group, organization
unit, or position.

— Outstanding work items in that are currently in the Inbox of another user that you supervise.

To view outstanding work items of other users, you must have been given access permission1 to
view work items in a specific position held by the user.

— All work items, for the selected process instance, irrespective of the resource or organizational
entity to which the work items are offered or allocated.

For more information see, Show Supervised List of Outstanding Work Items.

Show Outstanding Work Items
This function causes a temporary work view to be created under the My Work folder in the work view
list. This work view will contain all of the outstanding work items for the selected process instance that
are currently offered or allocated to you.

To display a process instance’s outstanding work items that have been offered or allocated to you, select

the process instance whose outstanding work items you are interested in, then click the  button, or
select Show Outstanding Work Item(s) from the Tools menu on the process instance list.

This causes a temporary work view to be created in the My Work folder in the work view list.

After selecting Show Outstanding Work Item(s), the work view list is automatically displayed, with
the newly created work view selected. For example:

9 This permission is granted via the View Work List (BRM.viewWorkList) scoped system action — for information, see the Configuring
User Access chapter in the TIBCO Workspace Configuration and Customization guide).

93

TIBCO® Workspace User's Guide



From the work item list containing the outstanding work items, you can perform any of the available
functions, just like on any other work item list.

Remember that this work view is temporary — if you do not save it, it is automatically removed when
you log out (you can also manually remove using the Remove button or menu selection on the work
view list).

You can save the temporary work view in the following ways:

● From the work item list, click the Save View button ( ) or select Save View from the View menu.
This saves the work view using its current name as shown in the work view list.

● From the work item list, click the Save View As button ( ) or select Save View As from the View
menu. This displays a dialog that allows you to enter a new name and/or description for the work
view. After entering a new name and/or description, click the OK button to save the work view.

● From the work view list, click the Edit View button or select Edit from the Tools menu. This opens a
wizard, which allows you to change the name, description, filter criteria, or sort criteria for the work
view. (Note that if you change the filter criteria using the wizard, you are changing the “base” filter
for the work view, as opposed to changing it through the work item list, which is the “refined” filter
— for more information, see Accessing the Filter Function.)

After saving the temporary work view, it is considered permanent, meaning it will remain in your work
view list until you explicitly remove it.

Show Supervised List of Outstanding Work Items
This function causes a temporary work view to be created under the Supervised Work folder.

This temporaty folder contains one of the following:

● Outstanding work items, associated with the selected process instance, that are currently in the
Inbox of a user that you supervise.

To view outstanding work items of other users, you must have been given access permission(2) to
view work items in a specific position held by the user.

● Outstanding work items, associated with the selected process instance, that were sent to a selected
organizational entity (group, organization unit, or position).

To view work items that were sent to specific groups, organization units, or positions, you must
have been given access permission1 to view work items in that specific group, organization unit, or
position.

When viewing a supervised list of outstanding work items for an organizational entity, you can
specify that it contain one of the following types of work items:

— Offered - These are work items that were offered directly to the selected organizational entity,
and that still have a state of Offered.

10 This permission is granted via the View Work List (BRM.viewWorkList) scoped system action — for information, see the Configuring
User Access chapter in the TIBCO Workspace Configuration and Customization guide).
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— Allocated - These are work items that were offered directly to the selected organizational entity,
that are now allocated to one or more users (i.e., their state is Allocated).

● All work items, for the selected process instance, irrespective of the resource or organizational entity
to which the work items are offered or allocated.

The icons shown in the work view list for newly created lists of outstanding work items indicate which
type of view it is, as follows:

Icon Meaning

The supervised list of outstanding work items is for an individual resource.

The supervised list of outstanding work items is for an organizational entity that
contains offered work items.

The supervised list of outstanding work items is for an organizational entity that
contains allocated work items.

The supervised list of outstanding work items contains all work items associated
with the process instance whose name appears in the supervised work view.

These icons become non-grayed-out once you save the view — see the table in Personal Work Views vs.
Supervised Work Views.

Select the process instance whose outstanding work items you are interested in, then click the 
button, or select Show Supervised List Outstanding Work Item(s) from the Tools menu on the process
instance list.

Procedure

1. On the New Work View - Supervised Work dialog, ensure that the appropriate organization model
version is selected. This is shown in the first row of the organization model (Version 3 in the
following example):

Use the Version drop-down list to change the version, if required.

2. In the Select Work List for View section, choose the type of work items that are to appear in the
supervised work view that contains outstanding work items, as follows:

● Offered Work Items for an Organizational Entity - This causes the supervised work view to
contain only work items that were sent directly to the selected organizational entity(1), and that
still have a state of Offered.

● Allocated Work Items for an Organizational Entity - This causes the supervised work view to
contain only work items that were originally sent directly to the selected organizational entity,1
but have since been allocated to a specific resource (their state = Allocated). Note that when

11 Note that this type of supervised work view will contain work items that are offered directly to that entity — it does not contain work
items that are offered or allocated to all of the members of the chosen organization entity.
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viewing this type of supervised work view, it does not show you to whom the work item has
been allocated. However, you can easily determine that by selecting a work item, then selecting
Open Event Viewer > This Work Item. The allocation event shows to whom the work item
was allocated (in the Resource name attribute). The Description column also shows that
information if it has not been changed from the default.

● Work Items for a Resource - This causes the supervised work view to contain work items that
are currently in the Inbox of a specified resource, offered and allocated.

If the message “Insufficient rights to view the resource list for a group or position” is displayed
when you select Work Items for a Resource, it means you don’t have the appropriate system
action. To view the resource list, you must have the Resource Admin (DE.resourceAdmin)
system action, which is available at the organization model level. For more information, see the
Configuring User Access chapter in the TIBCO Workspace Configuration and Customization guide).

● All Work Items - This causes the supervised work view to contain all work items irrespective
of the resource or organizational entity to which the work items are offered or allocated
(although the list can still be filtered).

Note that this option appears only if you have the appropriate user access control
(AllWorkItems), as well as the View Global Work List (BRM.viewGlobalWorkList) system
action.

If you choose the All Work Items option, proceed to step 5.

3. Select the desired organizational entity or an individual resource:

● If the supervised work view is to contain work items (either offered or allocated) sent to an
organizational entity, select the desired organization unit, position, or group. For example:

Note that only organizational entities to which you have been given access permission are
selectable — all others are grayed out. This permission is granted via the View Work List
(BRM.viewWorkList) scoped system action. For more information, see the Configuring User
Access chapter in the TIBCO Workspace Configuration and Customization guide.

● If the supervised work view is to contain work items sent to an individual resource, you must
first select one of the positions to which that resource has been mapped (you cannot select
resources from groups, only from positions), then select the resource in the right pane. For
example, if you want to create a supervised work view for a resource that has been mapped to
the CustomerServiceRepresentative position, select that position, then select the desired
resource. For example:
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4. Click OK.

This causes a temporary work view to be created in the Supervised Work folder in the work view
list, and the work view list is automatically displayed, with the newly created work view selected.
For example:

From the work item list containing the outstanding work items, you can perform any of the
available functions, just like on any other work item list.

Remember that this work view is temporary (denoted by a grayed-out icon and text in the work
view list) — if you do not save it, it is automatically removed when you log out (you can also
manually remove it using the Remove button or menu selection on the work view list). (See the
table on page 134 for information about the icons in this list.)

You can save the temporary work view in the following ways:

● From the work item list, click the Save View button ( ) or select Save View from the View
menu. This saves the work view using its current name as shown in the work view list.

● From the work item list, click the Save View As button ( ) or select Save View As from the
View menu. This displays a dialog that allows you to enter a new name and/or description for
the work view. After entering a new name and/or description, click the OK button to save the
work view.

● From the work view list, click the Edit View button or select Edit from the Tools menu. This
opens a wizard, which allows you to change the name, description, filter criteria, or sort criteria
for the work view. (Note that if you change the filter criteria using the wizard, you are
changing the “base” filter for the work view, as opposed to changing it through the work item
list, which is the “refined” filter — for more information, see Accessing the Filter Function.)
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After saving the temporary work view, it is considered permanent, meaning it will remain in
your work view list until you explicitly remove it.

Viewing Events Related to a Work Item
Every action that takes place concerning a work item (e.g., creating, allocating, opening, submitting,
and so on) is recorded in the database as an event.

From the work item list, you can select a work item and view the list of events related to that work item.

Procedure

1. Select the desired work item.

Either click the  button on the work item list toolbar, select Open Event Viewer from the work
item list Tools menu, or right-click the selected work item and select Open Event Viewer.

All three methods display a drop-down list.

2. From the drop-down list, select one of the available pre-defined filters. For example:

This creates a temporary event view containing events of the type you selected in the drop-down list,
that are associated with the selected work item. For example, if you select “This instance”, the event
list will contain all events pertaining to the process instance that is associated with the selected work
item. (Note that the selections in the drop-down list are customizable — those appearing on your
system may differ from those shown here.)

It also causes the event view list to be displayed with the newly created temporary event view
selected. For example:

3. From the list of events for the work item, perform any of the desired functions that are available —
for information, see Events.
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Result

Also, for more information about the temporary nature of the event view that is created, see Creating
Event Views.

Processing Work Items
A work item represents a task in a process. Typically, a work item has an electronic form associated
with it that must be opened and filled out (some forms may only display information and will not have
fields to fill out).

You can then save the work item in your work item list so that it can be opened again and completed at
a later time. When the form is completed, the work item is submitted so that the process instance can
progress, possibly resulting in another work item that represents the next task in the process.

Note that you can also select one or more work items in your work item list, and tell the system to mark
them as complete and submit them. This is called the skip function. For more information, see Skipping
Work Items.

Pageflow definitions can include branching that would require the simultaneous handling of multiple
user tasks, each requiring the display of a form (this same scenario could also occur in embedded sub-
processes set up for chained execution).

Workspace cannot currently display multiple forms resulting from these parallel pageflows. If one is
encountered in Workspace, a warning message is displayed. In some situations, none of the forms can
be displayed and execution of the pageflow (or chaining in the sub-process) cannot proceed. If a
parallel pageflow is encountered inside of a business service, it may be able to arbitrarily display one of
the forms, but an exception may occur later when the form is submitted.

Opening Work Items
Opening a work item causes the form associated with that work item to be displayed.

You can open work items in the following ways:

● Double-click the desired work item in the work item list.

● Select one or more work items in the work item list, then:

— press the Enter key,

— select Open Selected Work Item(s)(1) from the Tools menu on the work item list,

— right-click the mouse button on the desired work item(s) and select Open Selected Work
Item(s) from the drop-down menu, or

— click the  button on the work item list.

● Click the  button on the work item list, or select Open Next Work Item from the Tools menu.
This causes the first available work item in the list to be opened, where “available” means a work
item that is not locked nor suspended.

If you select the Open Next Work Item function, and there are no available work items, a “No
available work items to open” message is displayed.

Work items cannot be opened from supervised work views.

12 You cannot open multiple work items if you are displaying the work item forms in the preview pane. If you are opening forms in the
preview pane, and you select multiple work items, the Open Selected Work Item(s) function is disabled.
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There is also a way to cause work items to automatically open when you are viewing your
Inbox. For information about this, see Automatically Opening Work Items.

Opening a work item causes "Opened" to be shown in the State column, as well as an "open file folder"
image to appear in the State Image column on the work item list:

Opening a work item implicitly allocates the work item to the user that opened it. The work item is
removed from the work item lists of other users to whom the work item had been offered.

Re-Opening a Work Item

If you have a work item opened, and the application is closed (for example, the browser is closed)
without first closing the work item, the work item remains open.

When you restart the application, and attempt to open the work item that is already open, the following
message is displayed:

To re-open the work item, click OK.

The only other option to close the work item is to use the Cancel function (see Canceling Changes).

Work Item Form Location

The location at which the work item form is displayed when you open a work item depends on
whether or not the preview feature is turned on.

● If preview is turned off, the work item form is always opened in a separate floating window. Note
that the window in which the form opens may be either a dialog or a new browser window,
depending on a user options setting — for more information, see Work Item Preview.

● If preview is turned on, the work item form may be opened either in the preview pane or a separate
floating window, depending on the current preview setting.

The preview setting can be viewed or set by selecting Preview from the work item list View menu.
The following drop-down menu is displayed:
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The check mark indicates the currently selected preview option.

● If the Show Preview - Open Forms in Preview Pane selection is checked, the work item form is
opened in the preview pane.

Note that the preview pane may be set to automatically resize when a work item is opened, then
return to the previous size when the work item is closed. For information about how this is done,
see Work Item Preview.

● If the Show Preview - Float Forms selection is checked, the work item form is opened in a
separate floating window. Note that the window in which the form opens may be either a dialog
or a new browser window, depending on a user options setting — for more information, see Work
Item Forms.

When you have a work item form open in the preview pane, all functions available from the
work item list become disabled. This is because you cannot perform any of those functions until
the form is closed, by clicking one of the buttons on the form: Cancel, Close, or Submit.

If you have chosen to display the work item forms in floating windows, and there are
multiple work items selected when you open them, a floating window for each selected
work item is displayed.

But if you have chosen to display the work item forms in the preview pane, you cannot
open multiple work items at one time — if you select more than one work item, the
Open Selected Work Item(s) function becomes disabled.

Automatically Opening Work Items

Work items may be opened automatically.

This can occur because of one of the following reasons:

● Auto-Repeat - This is a feature you can select from the work item list that causes the next available
work item to be opened automatically after you’ve cancelled, closed, or submitted a work item. For
more information, see Auto-Repeat.

● Piling - Work item piling (or piled execution) is a feature that is designed into the process and user
task that causes work items generated by the same user task to be opened automatically. For more
information, see Piling.

● Chaining - Work items can also be chained together when the process is defined. When two or more
user tasks are chained together in the process, the work items that result from those user tasks must
be processed by the same user. For more information, see Chaining.

Auto-Repeat

The work item list provides an auto-repeat feature that causes the next available work item to be
automatically opened after you’ve cancelled, closed, or submitted a work item, where “available”
means a work item that is not locked nor suspended. This allows you to process work items in
succession without manually opening each one.

To turn on the auto-repeat feature, click the  button on the work item list, or select Auto-Repeat
Open Work Item from the Tools menu.

If you select the Auto-Repeat Open Work Item function, and there are no available work items to open,
the function is automatically turned off.
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The auto-repeat feature works as a toggle — successive clicks of the Auto-Repeat Open Work Item
button turns it on and off. When the feature is turned on, the Auto-Repeat Open Work Item button is
highlighted, as follows:

The Auto-Repeat Open Work Item selection on the Tools menu also contains a check mark when this
feature is turned on:

The auto-repeat toggle is persistent — it remains in its current state and is remembered between logins.
Note that persisted settings are saved on the server, so if you log onto a different machine, those
settings will be in effect on that machine also.

When the auto-repeat feature is turned on, the next available work item will automatically display after
you cancel, close, or submit the previously open work item.

Piling

When a user task is defined in a process, the designer specifies whether or not work items generated
from that user task should be piled. If they are piled, when you cancel, close, or submit a work item
generated by that user task, the system will search through your work list to see if there are any other
work items from that user task. If it finds one, it automatically, opens it.

For example, if the "Claim Screening" user task is set up to be piled, when you cancel, close, or submit a
Claim Screening work item, the next Claim Screening work item in your work list is immediately
opened. If there are no more Claim Screening work items, you are returned to your Inbox.

This feature allows the system to be designed so that if your job entails processing a certain type of
work item, the system will automatically open work items of that type, without requiring you to
continually select work items from your work item list — it’s as if you are working on a pile of work
items.

The order in which piled items are presented in the user's work queue is based on the sort order of the
work list. Setting a default sort order will dictate the order of the work list and, therefore, the order of
piled items.

The order of piled items cannot be configured with Work Views.

Chaining

When a process is defined, the designer can chain together multiple user tasks. This specifies that the
user who opens the first work item in the chain, and submits it, must then process all work items in the
chain.

When you submit the first work item in a chain, the form from the first work item is overlaid with a
shaded mask, with a "Waiting for response..." message displayed. For example:
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When the first work item is finished processing, the second work item in the chain is automatically
displayed. This will continue until all work items in the chain have been processed.

Also note that the form for the second work item, as well as all subsequent work items in the chain, is
displayed, the icon in the upper-left part of the form will show an arrow on the normal "letter/
envelope" icon:

Filling in a Work Item Form

The form that appears when you open a work item is specific to your Workspace. Each company that
uses Workspace will create their own forms that relate to the specific business they are in.

Your company will instruct you in properly filling out the forms that they have designed for
Workspace. The following is an example of what a form may look like:
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Note that the form may open in the preview pane, a separate dialog, or a separate browser window,
depending on how your system is set up. For more information, see The Preview Pane.

Use the Tab key to move from field to field on the form.

Some fields may include a drop-down menu from which you can select the valid options — they
contain “- Select -” and an arrow head (see the Claim Type field above). Click on the field to display the
options you can choose from.

A “date picker” may be available to enter dates in date fields. Click the calendar icon next to the date
field. A calendar is displayed from which you can choose a date; clicking a date in the calendar causes it
to be entered in the field.

Saving Work Items
Saving a work item causes any information you have entered in the form to be saved, then the work
item is closed (and unlocked) and placed back in the work item list with a state of Pended. The work
item is then available to be opened and completed at a later time.

To save and close a work item, click the Close button on the work item form.

Note, however, even though you have saved a work item, and it appears only in your work item list, it
is possible for the system or another application to make changes to the pended work item. This can
include changes to data in fields, or other aspects of the work item, such as a deadline date. For more
information, see Work Items Modified by the System of Another Application.

Submitting Work Items
Submitting a work item means that you are done with that work item. If there are any fields on the
form designated as “required” when the form was created, they must be filled in before the system will
allow you to submit the work item.

Submitting the work item causes any information you’ve entered to be saved, then the work item is
closed (and unlocked) and it is removed from the work item list. The process instance advances to the
next task in the process, possibly resulting in another work item appearing in someone’s work item list.

To submit a work item from the work item form, click the Submit button on the form:
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Work Items Modified by the System of Another Application

It is possible for a work item to be modified by the system or another application.

This can occur either:

● after you have opened the work item, made some changes, then closed it; that is, it is currently in
your work item list with a state of Pended.

● while you currently have the work item open.

The change made by the system or another application can include changes to data in fields, or other
aspects of the work item, such as a deadline date.

If the system or another application modifies the work item while it is in your work item list with a
state of Pended, you will see the changes made to it when you reopen it. In this situation, the changes
made by the system or another application may overwrite data that you had previously entered into the
data fields of the work item.

If the system or another application modifies the work item while you have it open, when you click the
Close or Submit button, the following dialog is displayed:

This dialog gives you the following choices:

● Override - This causes any changes made to the work item by the system or another application to
be overridden by the data on the work item form you are closing or submitting.

The Override button is not displayed if the process definition does not allow you to
override data changes made by the system or another application.

● Reload - This causes the work item form to be reloaded so that it will contain any changes that were
made to the work item by the system or another application. Any data you had entered on the form
is lost.

● Cancel - This closes the work item form, cancelling any data you had entered on the form. Changes
that had been made by the system or another application are retained.
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Pending Work Items
Work items can be pended, which causes them to be hidden in the work item list until a specified date/
time, or period of time has expired. The work item becomes visible again when the date/time occurs, or
period of time expires.

Work items can be pended only if they have a state of Allocated, Pended, or Pend Hidden.

This function is not available from supervised work views.

Note that even though pended work items are hidden by default, you can view pended work items, if
desired (see Displaying Visible Hidden Work Items). If you do view pended work items, those that
have been pended have a state of

Do not confuse pended work items (which have a state of Pend Hidden), with work items that you
have worked on and saved (by clicking the Close button on the form) — those work items have a state
of Pended. For more information, see Saving Work Items .

Pend Hidden and a state icon of . For example:

You can also cancel a pend period (see the steps below). If the pend period is cancelled, the work item
becomes visible and its state returns to the state it was prior to it being pended.

Procedure

1. From a work item list, select one or more work items that have a state of Allocated, Pended, or Pend
Hidden.

2. Click the  button, or select Pend Work Item(s) from the Tools menu on the work item list.

If the work item currently has a state of Allocated or Pended, the following dialog is displayed:

If the work item currently has a state of Pend Hidden, an additional selection is displayed:
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3. Choose the appropriate selection:
a) Pend work item until a specific date and time - Select this to specify a date/time for the new

pend period, or to set a current pend period to a different date/time.
b) Pend work item for a period of time - Select this to specify a period of time for the new pend

period, or to set a current pend period to a different period of time.
c) Cancel pend period for work item - Select this to cancel the currently specified pend period.

4. Specify the new pend period using the fields on the Pend Work Item(s) dialog, then click OK, or
just click OK if you are cancelling a current pend period.

Setting Work Item Priority
All work items are assigned a numeric priority, which can be used to indicate the work item’s relative
importance. You can use the priority to filter or sort a list of work items.

Work item priority defaults to 50, but you can modify the value for one or more work items.

Procedure

1. Select one or more work items in a work item list.

2. Either click the Set Priority  button on the work item list toolbar, or select Prioritize Work
Item(s) from the work item list Tools menu.

3. On the Prioritize Work Item(s) dialog, select one of the following:

● Use the default priority - This sets the selected work item(s) priority to the default value of 50.

● Use the average priority of the selected items - This is really only applicable if you have
multiple work items selected. It averages the current priority of all selected work items, and
sets all of them to the average value. The average value of the selected work items is shown in
parentheses:

● Set a custom priority - This allows you to enter a desired priority value, which is given to the
selected work item(s). The valid values are from 0 - 100.

● Increase / Decrease priority by an offset - This either increases or decreases the priority of all
selected work items by the value specified. To decrease the priority, enter a negative value. For
example:

The range of valid offset values is shown in parentheses. You cannot enter an offset value
outside this range.

4. Click OK on the Prioritize Work Item(s) dialog to set the specified priorities.
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Skipping Work Items
The skip function allows you to select one or more work items in your work item list and "skip" them.
This marks the work item(s) as complete, removes them from the work item list, and causes the process
to advance. It has the same affect as opening the work items and submitting them.

To be able to skip a work item, the following must all be true:

● the work item cannot have any required data fields that are not filled in, and

● the work item’s state must currently be Allocated.

Procedure

● From a work item list, select one or more work items that can be skipped according to the
requirements stated above.

Click the  button, or select Skip Work Item(s) from the Tools menu on the work item list.

Note that if the work item cannot be skipped because it does not exist anymore (i.e., your work item
list has not been refreshed since the work item was submitted by someone else), the following
dialog is displayed:

Result

When the work item is successfully skipped, it is submitted and removed from your work item list.

Canceling Changes
Once a work item is opened and data is entered or changed on the work item form, you can cancel
those entries/changes and return the work item to the state it was in when the work item was opened.

This can be done in two ways:

● From the work item form - This is typically the way in which most users will cancel changes on a
work item form that they don’t want to save. To cancel changes in this way, click the Cancel button
on the work item form. The work item is closed and returned to the work item list without saving
changes that had been made.

● From the work item list - The intention of the cancel function via the work item list is for an
administrator-type user to be able to forcibly close a work item left open by another user. This
causes any data that had been entered or changed by the user who opened the work item to be lost.

Typically, this function would be used with a supervised work view, where you can view work
items in the Inbox of users you supervise. For information about supervised work views, see Work
Views.

To close a work item from the work item list, select the opened work item in the work item list, then

either click the  button, or select Cancel Work Item(s) from the Tools menu.

The following dialog is displayed, warning you about the possible loss of data:
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Note that the work item form that was opened by the user who originally opened the work item is
not closed by the cancel function. The form must be manually closed from the workstation from
which it was opened.
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Process Instances

A process instance is created when a process is “started,” and remains in existence until that instance of
the process is purged from the system.

Process instances are typically started when you start a “business service”. A business service is a set of
actions that accomplishes some sort of business function. For example, a business service could be
designed to handle an incoming insurance claim.

Starting an Instance of a Process
Processes are not explicitly started by a user. They are started as part of a business service. When you
start a business service, one or more processes may be started by the service, resulting in process
instances appearing in the process instance list.

For information about starting business services, see Accessing Workspace.

Workspace also provides a Start Process Instance function that allows an authorized user to explicitly
start an instance of a process. A Start Process Instance button is displayed in Workspace for
administrator-type users who have to proper authority. For information about using the Start Process
Instance function, see Starting a Process.

Process Instance List
A process instance list presents all of the process instances that are in a particular process view.

To display a process instance list, click the Process Views button in the lower-left part of the screen,
then select (single click) a process view in the process view list.

Initially, the default process view — All Instances — displays a list of the process instances for all
processes available on your system. Although you can modify the filter and sort specifications for that
view so that it displays a subset of those process instances.

The All Instances view in the process view list is controlled by a user access element. Therefore, if you
do not have the proper user access, you will not have this view.

There may also be other process views available that display the process instance list filtered and sorted
in different ways. For more information about using views, see Views.

Information about each process instance is provided in the columns of the process instance list. The
specific information that is displayed on your system will depend on how your system was set up —
see Process Instance List Columns.

Selecting Process Instances
Selecting a process instance (i.e., single-clicking an item, or moving the highlight bar with the keyboard
arrow keys) from the process instance list causes the process instance summary to be displayed in the
preview pane section.

For example:
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If you select multiple process instances, the last one you select is the one displayed in the preview pane.

For additional information about selecting items in general from lists, see Selecting Items in a List.

Process Instance Details

From the Process Instance Summary, you can also view additional details about the process instance.
This includes values in custom attributes in the process instance (custom attributes represent customer-
specified data fields that are added to a process when it is defined).

Those fields can then be added to forms. When a user enters information in the fields on a form (for
example, customer name, address, loan amount, etc.) in an instance of the process, that information is
stored in the custom attribute for that field, in that process instance. For more information about
custom attributes, see Custom Attributes in Process Instance Lists.

To display process instance details, click the View Details button(1) on the Process Instance Summary.
A dialog similar to the following is displayed:

13 You must have the ShowCustomAttributes user access control for the View Details button to be displayed on the Process Instance
Summary.
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The Process Instance Data dialog contains two tabs:

● View tree of all attributes - This tab, which is displayed by default, contains a tree-view of all
attributes for the process instance, both custom attributes and system attributes.

Notice that this tab also contains the Activity Fault Data, Activity Fault Name, and Failed Activity
Name attributes. These attributes are only applicable to halted process instances; the values in these
attributes can help determine why a process instance has halted.

● View XML for custom attributes - This tab contains the XML for only the custom attributes in the
process instance. For example:
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The XML on this tab can be used in conjunction with the AXM BPM web service API operation,
setAvailableProcessInstanceVariables. Its primary use is in cases of halted process instances.
The XML can be copied from this tab, then used as input to the
setAvailableProcessInstanceVariables operation; this allows you to make changes to the
values in the required attributes in an attempt to get the process instance out of a halted state.

For information about the setAvailableProcessInstanceVariables operation, see the TIBCO
ActiveMatrix BPM Developer’s Guide.

For more information about halted process instances, see Halted Process Instances.

To close the Process Instance Data dialog, click OK.

Refreshing a Process Instance List
When a list of process instances is initially displayed, it is a snap shot of the process instances at that
point in time. You can refresh the list to get the most recent list of process instances from the server by

selecting Refresh Process Instances from the View menu, or by clicking the  button.

If you have defined filter and/or sort criteria for the process instance list, they will be applied on the
refreshed list of process instances.

Note that when the process instance is refreshed, it always returns to page 1 of the list, regardless the
page that was displayed when you refreshed the list. The first process instance in the list will be
selected.

Process Instance List Timeout
The process instance list has a hard-coded timeout value of 30 minutes set on the server.

Anytime you display a process instance list, and don’t do anything with it for 30 minutes or more, then
access the list in any way (select an instance, attempt to refresh it, etc.), the following dialog is
displayed:
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This just means that the server determined that it’s been such a long period of time since you did
anything with the list, it should be refreshed.

Click OK to refresh the list. It is redisplayed at page 1 of the list (regardless the page you were on
before it timed out).

Process Instance List Columns
By default, certain columns are displayed in a process instance list. You can easily customize the
columns that are displayed by either using the Column Selector, or manually.

For information, see Customizing Columns in a List.

The following table describes the columns of information that can be displayed on the process instance
list:

Column Description

ID A unique number identifying the process instance.

Outstanding Count This is the number of outstanding work items in this process instance.

Also see, Outstanding Work Items .

Parent Process ID The instance ID of the parent process — only applicable for re-usable
sub-processes.

Priority This is a numeric value that has been assigned to the process instance by
an administrator. The numeric value assigns a relative importance to the
process instance, which allows users to prioritize their work.

Start Date The date and time the process instance was started.

Status Indicates the current status of the process instance.

For a list of the possible statuses, see Process Instance Status .

Version Identifies the version of the process from which the instance was started.

Module Name This is the path to the XPDL file that defines the "process package".

Process Name The name of the process, of which this is an instance.

Status Image An image that indicates the current status of the process instance.

For a list of the possible status images, see Process Instance Status .

Each column in the process instance list represents an attribute, which holds information about the
process instance.
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When you use the Column Selector to specify the columns to display, both System and Custom columns
are listed(1). System columns/attributes contain information that the system entered in the attribute,
such as the instance start date, current status, etc. Custom columns/attributes represent customer-
specified fields that are added to a process when it is defined. Those fields can then be added to forms.
When a user enters information in the fields on a form (e.g., customer name, address, loan amount,
etc.), that information is stored in the custom attribute for that field.

Note that the Column Selector will always show all of the system columns/attributes listed in the table
above, because those are available in every process instance. However, it will only show the custom
columns/attributes that are common to all process instances that were included in the process view.

Filtering a Process Instance List
Filtering a list of process instances involves entering filter criteria so that only some of the process
instances are shown in the list, rather than all of them. Filtering a list of process instances allows you to
display only the process instances you are interested in.

For example, you may only be interested in process instances that were started earlier then Dec. 15,
2008 You can filter the list so only those process instances are shown.

The filtering function allows you to build a “filter expression” that is applied to all process instances. If
a process instance satisfies the filter expression (e.g., it was started earlier than Dec. 15, 2008), it is
shown in the process instance list; if it does not satisfy the filter expression, it is not shown in the list.

Because filtering process instance lists is basically the same as filtering other types of lists in Workspace
(with the exception of the specific fields on which you can filter), details of filtering is explained in a
single chapter — see Filtering Lists.

Sorting a Process Instance List
Workspace allows you to sort the information in a process instance list so they are in the order you
would like them listed.

For example, you may want to list all process instances that are currently “Active” first, then sort those
by started date/time, from oldest to most recent. The sort function allows you to choose which columns
on the process instance list to sort on.

Because sorting process instance lists is basically the same as sorting other types of lists in Workspace
(with the exception of the specific fields on which you can sort), details of sorting is explained in a
single chapter — see Work Items.

Finding a Process Instance
A Find function is provided to help you locate a process instance in the process instance list. Note that
this function searches through the entire process instance list, not just the currently displayed page.
However, if there is a filter currently applied to the list, it only searches through the process instances
that satisfy the filter.

Procedure

1. Click the  button on the process instances list toolbar, or select Find Process Instances from the
Tools menu.
The following fields are displayed in the work item list toolbar.

14 The listing of custom columns/attributes is controlled via user access profiles. They are shown in the Column Selector only if you have
the proper access.
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2. From the drop-down list in the first field, choose an attribute that you want to search on. For
example, to find a process instance that has a certain process name, choose “Process Name”.

3. From the drop-down list in the second field, choose the operator that is appropriate for your search.

4. In the last field, enter the value you want to search for.

You can use the * character as a wildcard. For example, the following finds all process instances
whose process name begins with “C”:

If you select a date attribute to search on, a calendar icon is displayed from which you can select a
date, plus fields are displayed to the right of the calendar icon in which you can enter a time.

5. Click the  button (which is activated when you enter a value to search on) to display the find
results.

The Find fields can be closed by either clicking the X to the left of the fields, or by clicking the 
button again.

Process Instance Status
There are two Status columns available on the process instance list that indicate the process instance’s
current state: one is an image and the other is text.

By default, the first column in the process instance list displays icons that indicate the process instance’s
status.

The following table shows the possible icons and their meanings.

Status Image Status Text Meaning

Active The process instance is in progress.

Cancelled The process instance has been cancelled. Note that once the list is
refreshed, process instances with a status of cancelled are
removed from the list.

For more information, see Cancelling a Process Instance .

Canceling This is a transitory state where a user has cancelled the process
instance, but the cancel function has not been completed yet. The
amount of time it takes to cancel a process instance depends on
the amount of system resources available and the current load on
the system.
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Status Image Status Text Meaning

Active while
Canceling*

The sub-process instance was active when its cancellation was
initiated by a cancellation event handler, and is now waiting for
the cancellation to complete. (There may also be compensation
handlers that are reversing or undoing previously executed
activities before the status can be changed to Cancelled.)

Suspended
while
Canceling*

The sub-process instance was suspended while it was being
cancelled by a cancellation event handler.

Typically, a sub-process instance has a state of Active while
Canceling upon initiation of the cancellation event handler, but at
that point you can suspend the sub-process instance with the
intention of fixing a possible error before the sub-process instance
changes to the Halted while Canceling state (see below).

And of course, if the sub-process instance is suspended (and an
issue resolved), it must be resumed so the graceful cancellation of
the sub-process can continue to completion.

Halted while
Canceling*

The sub-process instance was halted due to a failure in the
cancellation event handler business logic.

Typically, a sub-process instance has a state of Active while
Canceling upon initiation of the cancellation event handler, but
then may fail (for example, the handler cannot find an external
resource or a dynamic sub-process), at which point its state
changes to Halted while Canceling.

If the state changes to Halted while Canceling, you can use one of
the available functions to progress a halted process instance (for
information about those functions, see Halted Process Instances),
and ideally get back to a Active while Canceling state so that the
graceful cancellation of the sub-process can continue to
completion.

Completing This is a transitory state between the time that final work item for
the process instance has been submitted and the process instance
being set to a Completed status. The amount of time it takes to
complete a process instance depends on the amount of system
resources available and the current load on the system.

Completed The process instance has completed.

Depending on how your system was configured, process
instances with a status of Completed may appear in the process
instance list, or they may be automatically purged as soon as they
complete, and do not appear in the list. And if your system is
configured to show Completed instances, it may be configured to
list them for a specific period of time, then they are purged.

Failing This is a transitory state where the system has detected an error,
but the state has not yet been set to Failed. The amount of time it
takes to set the status to Failed depends on the amount of system
resources available and the current load on the system.
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Status Image Status Text Meaning

Halted A task in the process instance has failed, causing the process
instance to be halted.

For information, see Halted Process Instances .

Halting This is a transitory state — the process instance is being halted
because of a failed task.

Not Started This is a transitory state — the process instance has not started
yet.

Restarting This is a transitory state — the process instance is being restarted.

Resuming This is a transitory state where a user has selected to resume a
suspended process instance, but the Resume function has not
been completed yet. The amount of time it takes to resume a
suspended process instance depends on the amount of system
resources available and the current load on the system.

Starting This is a transitory state between the time a process instance start
has been initiated and the actual starting of the process instance.
The amount of time it takes to start a process instance depends on
the amount of system resources available and the current load on
the system.

Suspended The process instance has been suspended.

For information, see Suspending a Process Instance .

Suspending This is a transitory state where a user has suspended the process
instance, but the Suspend function has not been completed yet.
The amount of time it takes to suspend a process instance
depends on the amount of system resources available and the
current load on the system.

* Sub-processes instances can be cancelled in a "cascading" fashion, which causes them to be cancelled
from the "bottom up". This is done using a "cancellation event handler." When cancelled in this way, the
sub-process instances can take on one of the following states as described above. For more information
about cancellation event handlers, see the TIBCO Business Studio Modeling User's Guide.

● Active while Canceling
● Suspended while Canceling
● Halted while Canceling

Completing a Process Instance
A process instance is completed when the last work item (user task) in the process has been submitted.

Depending on how your system was configured, process instances with a status of Completed may
appear in the process instance list, or they may be automatically purged as soon as they complete, and
do not appear in the list. And if your system is configured to show Completed instances, it may be
configured to list them for a specific period of time, then they are purged.

If your system purges completed process instances, you can still view information about those instances
via the Event Viewer using the pre-defined “Completed Instances” event view template:
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For more information, see Event Views.

Displaying Outstanding Work Items
The "outstanding work items" for a process instance are all of the work items associated with that
process instance that are sitting in users work item lists, waiting to be completed and submitted. They
represent the user task(s) at which the process flow is currently sitting.

An active process instance may have only a single outstanding work item, or it might have many
because the process flow may have taken multiple paths, depending on how it was designed.

The process instance list contains two functions that allow you to view the outstanding work items for a
process instance. They are:

● Show Outstanding Work Item(s) for ID - This function causes a temporary work view to be created
under the My Work folder in the work view list. This work view will contain all of the outstanding
work items for the selected process instance that are currently offered or allocated to you.

● Show Supervised List of Outstanding Work Item(s) for ID - This function causes a temporary
work view to be created under the Supervised Work folder in the work view list. This work view
will contain outstanding work items for the selected process instance that are currently offered or
allocated to the specified user, or that were sent to the specified organizational entity.

For details about these functions, see Outstanding Work Items.

Suspending a Process Instance
You can suspend activity in a process instance, which causes all work items that are associated with that
process instance to also become suspended, and the process flow is halted at that point. Work items that
are suspended cannot be worked on, that is, they cannot be opened, allocated, re-offered, nor cancelled.

Also note that work items that are suspended become hidden in the work item list. You can display
hidden work items by selecting either Only show hidden work items or Show visible and hidden
work items from the View menu on the work item list.
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If a work item is already open when the process instance is suspended, the work item can still be
cancelled, closed or submitted:

● If cancelled, any changes made on the work item form are discarded and the work item is returned
to the work item list with a Suspended state.

● If closed, any changes made on the work item form are saved, and the work item is returned to the
work item list with a state of Suspended.

● If submitted, any new work items that result from the process flow appear in the appropriate work
item lists, but they will have a Suspended state.

The suspended work items cannot be worked on until the process instance is resumed — see Resuming
a Suspended Process Instance.

Also note that if you have:

● work items that have a timer event configured, or

● timer events defined within the process,

and the timer event is reached while the process instance is suspended, the timer event is still
processed. However, you will not see activity until the process instance has resumed. For example:

● If the process is configured to move to the next task when the timer event has processed, the process
moves to the next task when the process resumes.

● If the task that has a timer event is set to withdraw upon expiration, the task is withdrawn when the
process resumes.

Procedure

1. From the process instance list, select one or more process instances, then click the  button, or
select Suspend Process Instance(s) on the Tools menu.

A dialog is displayed to confirm that you want to suspend the selected process instance(s).

2. Click OK to confirm.

Result

When the process instance becomes suspended, the process instance list is automatically refreshed to
update the instance status. This always causes the process instance list to return to page 1 of the list,
regardless the page that was displayed when you suspended the instance.

Suspension Status
A process instance’s suspension status can be viewed in the process instance list either as an image, or
text.

● Status Image Column - When a process instance is suspended, the image in the Status Image
column shows a  icon (which is the same as the Suspend button).

● Status Text Column - When a process instance is suspended, the Instance Text column contains
“Suspended”.
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The same image and text is displayed in the State Image and State columns, respectively, on the work
item list for work items that are part of a process instance that is suspended. For example:

Note that suspended work items are hidden by default. Therefore, you must select either Only show
hidden work items or Show visible and hidden work items from the work item list View menu to be
able to see them in your work item list.

Resuming a Suspended Process Instance
Resuming a suspended process instance causes the process to flow as usual. Work items that were
suspended because their process instance was suspended can now be opened and processed normally.

Procedure

1. From the process instance list, select one or more suspended process instances to resume, then click

the  button, or select Resume Process Instance(s) from the Tools menu.

A dialog is displayed to confirm that you want to resume the selected suspended process
instance(s).

2. Click OK to confirm.

Result

When the process instance is resumed, the process instance list is automatically refreshed to update the
instance status. This always causes the process instance list to return to page 1 of the list, regardless the
page that was displayed when you resumed the instance.

Halted Process Instances
If a task in a process instance fails, it may cause the process instance that is associated with that task to
be halted (depending on how the process was designed; the design may cause the process to
immediately fail if a task fails).

If a process instance is halted for this reason, its status in the process instance list is shown as “Halted”:

You can view additional information about a halted process instance to help determine the cause of the
failure:

● By creating a halted process view, which is a special-use view that displays some attributes specific to
halted process instances. For information about creating this type of view, see Creating a Halted
Process View.
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● By viewing details of the halted process instance, which contains the same attributes that are in the
special-use halted process view. For information about viewing process instance details, see Process
Instance Details.

There are also functions available on the process instance list to progress a process instance that has
halted. These functions can be accessed from the Tools menu or from icons on the process instance list
toolbar:

The available halted process instance functions are:

Resume Halted Process Instance(s)

This resumes the process instance so that the instance itself goes into a failed state because
of the failed task. This would typically be used if the reason for the failed task cannot be
resolved.

Retry Halted Process Instance(s)

This causes the previously failed task to be retried so that the halted process instance can
progress normally. This function is used if the reason for the failed task has been resolved,
for example, if it failed because a database connection had been lost, but has now been
restored.

Ignore Fault For Halted Process Instance(s)

This causes the failed task to be skipped in the halted process instance. The process
instance continues processing from the point in the process after the failed task. This
option only makes sense if the process is capable of continuing successfully without the
skipped task having been performed.

Creating a Halted Process View
A special process view is available that displays process attributes containing information to help
determine the reason a task failed, causing a process instance to be halted.

To create a halted process view, follow the normal procedure to create a process view as described in 
Creating Process Views. In step 3e of the procedure, choose the Halted instance view with fault details
selection. This causes the new process view to contain the halted instance-specific attributes as shown
in the illustration above.
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Sub-Processes
Sub-processes are simply processes that are started by a task in another process. And sub-processes can
be many levels deep, that is, a task in one process can start another process, which can contain a task
that starts another process, and so on.

From the process instance list, you cannot distinguish which process instances are from a main process
or from a sub-process.

You can, however, see when a task starts a sub-process using the Event Viewer. If an event in the Event
Viewer has a  character to the left of the event, it means it is a sub-process start event:

Clicking on the  character expands the list to include the events related to the sub-process that was
started.

For more information, see Sub-Process Events.

Viewing Events Related to a Process Instance
Every action that takes place concerning a process instance (e.g., starting, suspending, cancelling, and
so on) is recorded in the database as an event.

From the process instance list, you can select a process instance and view the list of events related to
that process instance.

Also, for more information about the temporary nature of the event view that is created, see Creating
Event Views.

Procedure

1. Select the desired process instance.

2. Either click the  button on the process instance list toolbar, select Open Event Viewer from the
process instance list Tools menu, or right-click the selected process instance and select Open Event
Viewer.

All three methods display a drop-down list.

3. From the drop-down list, select one of the available pre-defined filters. For example:
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This creates a temporary event view containing events of the type you selected in the drop-down list,
that are associated with the selected process instance. For example, if you select “My activity for this
instance”, the event list will contain all events that were generated by actions you performed
pertaining to the selected process instance. (Note that the selections in the drop-down list are
customizable — those appearing on your system may differ from those shown here.)

It also causes the event view list to be displayed with the newly created temporary event view
selected. For example:

4. From the list of events for the process instance, perform any of the desired functions that are
available — for information, see Events.

Cancelling a Process Instance
You can cancel a process instance, which stops the process flow and deletes all work items that are
associated with that process instance.

Work items that are associated with a cancelled process instance are removed from the work item lists
of the user to whom the work items were offered/allocated the next time their work item lists are
refreshed.

If a user has a work item open when its associated process instance is cancelled, a message is displayed
when the user attempts to cancel, close, or submit the work item form informing the user that the
process instance has been cancelled.

Procedure

1. From the process instance list, select one or more process instances, then click the  button, or
select Cancel Process Instance(s) from the Tools menu.

A dialog is displayed to confirm that you want to cancel the selected process instance(s).

2. Click OK to confirm.
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Result

When a process instance is cancelled, the status changes to Cancelled. Note, however, that depending
on how your system was configured, process instances with a status of Cancelled may remain in the
process instance list after the list is refreshed, or they may be automatically purged from the system
and removed from the list. And if your system is configured to show Cancelled process instances, it
may be configured to list them for a specific period of time, then they are purged.

If your system purges cancelled process instances, you can still view information about cancelled
process instances via the Event Viewer using the pre-defined “Cancelled Instances” event view
template:

For more information, see Event Views.
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Events

Actions that take place in Workspace are recorded as events. These include things like logging in,
opening a work item, submitting a work item, suspending a process instance, etc.

Workspace allows you to display lists of events so that you can see what has occurred with a particular
work item, process instance, user, etc. For example, the following shows events for a work item — it
allows you to see the events that have taken place pertaining to that work item since it was created
(scheduled):

The Event Viewer displays an event list that contains the events in the currently selected event view —
see Event Views. An event list is sometimes referred to as an audit trail because it allows you to audit
the trail of actions that have taken place for a particular thing.

Like other lists in Workspace, you can filter and sort the list of events. For information, see Filtering an
Event List and Sorting an Event List.

Also, some events provide links to related lists of events. For example, from a list of events for a work
item, you can link to a list of events for the process instance to which the work item is related, or to a
list of events pertaining to the user who allocated the work item. For information about using these
links, see Viewing an Additional Event List Using Event Links.

The example list of events above shows that there are a total of 48 events in this list. Note, however, that
the system can be configured to not display the total number of events. This is to improve performance
when there are a large number of events. If your system has been configured to not display the total
count, and you “page” to the end of the list, a “You have reached the end of the list” message is
displayed when you reach the last page.

Event Lists
To display an event list, click the Event Views button in the lower-left part of the screen, then select the
desired view in the event view list.

By default, the event list displays a chronological list of events for the entity in question, in the example
shown above, a work item.

After displaying the event list, you may filter and/or sort the list so that only the events you are
interested in are displayed, in the desired order. For more information, see Filtering an Event List and 
Sorting an Event List.

When you start Workspace for the first time, there is a single default event view called My Activity
Today. This view displays all events related to activity you have performed today. You can modify or
deleted this default event view, if desired.
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You can also create additional event views that display events related to a variety of activity in
Workspace. For information about creating new event views, see Creating Event Views.

Selecting Items in an Event List
You can only select a single event at one time in an event list.

Selecting an event causes the attributes associated with that event to be displayed in the preview pane.
For example:

The available columns in the event list provide information that is common to all event types. Whereas,
the attributes provide additional information that is specific to the type of event selected.

The attribute list is for informational purposes only — there are no functions associated with it. For
more information about event columns and attributes, see Event List Columns Attributes.

Event Descriptions
Each event has two descriptions defined: a detailed description and a summarized description.

For example, for the “Open work item” event:

127

TIBCO® Workspace User's Guide



Summarized Description

Detailed Description

The detailed descriptions provide more information, but you may find that the summarized
descriptions make it easier to scan the event list.

You can easily switch between the two descriptions by either clicking the  button on the event list, or
by selecting Event Descriptions from the event list View menu. Both methods display a drop-down
from which you can select the description type.

The descriptions for events are also customizable by an administrator, therefore, you may see different
descriptions than those shown in the documentation.

Filtering an Event List
Filtering a list of events involves entering filter criteria so that only some of the events are shown in the
list, rather than all of them. Filtering a list of events allows you to display only the events you are
interested in.

For example, you may only be interested in events that occurred between 10 A.M. and 2 P.M. on Jan. 4,
2010, or you may only be interested in seeing certain types of events. You can filter the list so that only
those events are shown.

The filtering function allows you to build a “filter expression” that is applied to all events in the list. If
the event satisfies the filter expression (e.g., the Time Stamp is greater than 10 A.M. on Jan. 4, 2010 and
less than 2 P.M. on Jan. 4, 2010), it is shown in the event list; if it does not satisfy the filter expression, it
is not shown in the list.

Because filtering event lists is basically the same as filtering other types of lists in Workspace (with the
exception of the specific attribute on which you can filter), details of filtering is explained in a single
chapter — see Filtering Lists.

Pre-defined Filters

The event list provides some pre-defined filters that allow you to display a subset of all available events
without requiring you to define a filter.

The available pre-defined filters are selectable from the drop-down list on the toolbar of the Event
Viewer:
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The available pre-defined filters differ, depending on the type of entity for which you are displaying
events. For instance, the list of pre-defined filters for work item events (as shown above) differs from
the list of pre-defined filters for process instance events.

Selecting one of the pre-defined filters causes the event list to be filtered according to the pre-defined
filter. The pre-defined filter is actually specified using configuration files. Therefore, if you select one of
the pre-defined filters, then display the Filter dialog, you will not see the filter expression that is causing
the list to be filtered — it can be seen only by an administrator who opens the configuration file in
which the pre-defined filters are specified.

You are free to further refine any of the pre-defined filters. For example, you could select the “Opened
and completed only” pre-defined filter (as shown in the example above), then open the Filter dialog
and refine the list further. Once you refine a filter, you can save the newly specified refined filter,
causing it to be added to the “base” filter — for more information about refined and base filters, see 
Base Filter and Refined Filter.

By default, there is an “All” pre-defined filter for all event types, which displays all of the events for the
entity type whose events are being displayed.

Pre-defined Filter Definitions

Note that the definitions of the pre-defined filters are customizable by an administrator. Therefore,
those on your system may be different than those shown in the documentation.

Because of this, the documentation also does not provide descriptions of each of the default pre-defined
filters, as an administrator may have changed the filter definition in the configuration file.

However, the following provides guidelines about what you can expect from a pre-defined filter, based
on the filter’s name in the drop-down list:

● All - As mentioned earlier, there is an “All” pre-defined filter for all event types. This filter contains
all events related to the entity.

● Summary - Generally, this filter displays all events, except for those that are considered low-level, or
probably not of interest. The events that are excluded through this filter depends on the entity type
whose events you are viewing, as follows:

— Work items - Excludes all Process Engine-related user task events. (Note that “Process Engine”
is denoted as “BX” in event IDs and descriptions.)

— Process instances - Excludes all Process Engine-related user task, event (e.g., throw and catch
events), and gateway events.

— Resources - Excludes all events related to saving user settings, logging in, and logging out.

● All other pre-defined filters, other than “All” and “Summary” have names that are self-descriptive.
For example, “Opened and completed” only displays work item opened and completed events,
“Started Instances” only displays start-instance events for the process, etc.

Sorting an Event List
The Event Viewer allows you to sort the information in the event list so that events are listed in the
desired order.

For example, you may want to list all events by priority number, then sort those by Time Stamp, from
oldest to most recent. The sort function allows you to choose which columns on the event list to sort on.

Because sorting event lists is basically the same as sorting other types of lists in Workspace (with the
exception of the specific attributes on which you can sort), details of sorting is explained in a single
chapter — see Work Items.
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Event List Column Attributes
Events have attributes that contain information about the event.

Some example attributes are:

● Creation time - The date and time the event occurred.
● Description - Describes the action that triggered the event.
● Principal name - The name of the resource who performed the action.
● Message ID - A unique identifier for the event.

The columns that are displayed in the event list represent event attributes; the column headers are
attribute names, and the values in the columns are the values in the attributes.

Some attributes are common to all event types, whereas some are unique to a particular type of event.

The columns that are shown by default in the event list are those that are common to all event types.

In other words, every event has a Creation Time attribute, and a Description attribute, and a Principal
name attribute, etc.

And when you select an event in an event list, attributes that are applicable to that specific event type
are displayed in the event attribute list below the event list. In the example above, the
BRM_WORKITEM_ALLOCATE event contains the attributes shown in the event attribute list. For each
attribute in the list, you are shown the current value of the attribute, as well as the type of data in the
attribute (e.g., string, date, etc.), and the component in the system that generated the event.

Note that the specific attributes that display in the event attribute list can be specified in two ways:

● a system administrator can specify, via a configuration file, which attributes to display.
● you can specify which to display using the Attribute Selector — for information about the Attribute

Selector, see Specifying the Attributes to Display in Event Attribute Lists.
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The event attribute list also has a couple of features that allow you to view/get information about a
particular attribute:

● Viewing the attribute description - Hovering the mouse pointer over a value in any of the columns
in the event attribute list causes a description of that attribute to be displayed. For example:

Note that the description that is displayed is customizable by your system administrator. Your
system may show a different description than what is shown here.

● Copying the attribute value - Clicking on a value in the Value column causes a text box to be
displayed that contains the value:

You can highlight the value and press Ctrl+C to copy it so that it can be pasted wherever it is
needed.

You can also click the Open in dialog link to open a separate dialog that contains the attribute value.
This is helpful if the value is very long.

Specifying the Columns to Display in Event Lists

The columns that display by default in event lists represent the attributes that are common to all event
types. However, you can customize event lists to display the desired columns.

To do this, click the  button on the event list toolbar, or choose Select Columns from the event list
View menu. The Column Selector dialog is displayed.

The Column Selector lists the available columns/attributes in a tree structure categorized by the
components that write values to the attributes. You can expand or collapse the list below each
component name, as needed, by clicking the + or - icon to the left of the component name.
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Use the Column Selector to choose which columns to display among the available columns. Note that
when you customize columns for an event list, it applies only to that particular event list, not to any of
the others. Customized columns for an event list are persisted, however, i.e., they will stay customized
for that specific event list until you change them again with the Column Selector, or manually. Also,
note that persisted settings are saved on the server, so if you log onto a different machine, those settings
will be in effect on that machine also.

As mentioned above, the default out-of-the-box columns in the event list are those that are common to

all event types. However, you can specify a new default by clicking the  button on the event list
toolbar, or by selecting Set as Default Columns from the event list View menu. For more information,
see The Column Default.

For more information about specifying columns, see Customizing Columns in a List.

Specifying the Attributes to Display in Event Attribute Lists

The event list contains an Attribute Selector that allows you to specify which attributes to display in
the event attribute list.

Procedure

1. Choose Select Attributes from the event list View menu. The following dialog is displayed:

The specific attributes that are listed in the Attribute Selector is customizable by the
system administrator. Therefore, you may see different attributes than are shown in the
example above. You can view a description of an attribute on the Attribute Selector by
hovering the mouse pointer over the attribute name.

This dialog is used to specify which attributes to display in the attribute list.
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● Attributes listed in the Available Attributes list on the left are available, but have not been
designated to display in the event attribute list. The attributes listed in the Available Attributes
section are categorized by the components that write the value to the attribute. Notice that if all
of a particular component’s attributes are moved to the Selected Attributes section on the right,
the component name is still shown in the Available Attributes section, with “empty” shown
below the component name (as is the case for Business Resource Manager, Directory Engine,
and Event Collector in the example above).

● Attributes listed in the Selected Attributes list on the right are the attributes that will be
displayed in the event attribute list. Note, however, that all of the attributes listed are not
applicable to all event types. The attributes in the Selected Attributes list are shown in the
event attribute list only if they are applicable to the type of event selected in the event list.

2. Select the desired attributes, using the following actions:

● Individual attributes can be selected by clicking the desired name.

● Multiple attributes can be selected by holding down the Ctrl key while clicking the desired
names.

● A group of attributes can be selected by clicking one name, then holding down the Shift key
and clicking the last name in the desired group.

3. Move attributes to the desired list in the Attribute Selector:

● Attributes can be moved back and forth between lists by selecting the desired attribute(s), then
clicking the “” or “<“ buttons.

● An individual attribute can be moved from one list to the other by double-clicking the attribute
name.

● Attributes can also be moved from one list to the other by using a “drag and drop” method —
click the desired attribute name (or group of selected attribute names), and while holding the
mouse button, drag them to the desired list and release the mouse button.

● All attributes can be moved from one list to the other by clicking the “ > ” or “<<“ buttons.

You can also change the attributes to the system defaults by clicking the Use Default button.

4. Click OK when the list on the right contains the attributes you would like displayed in the attribute
list.

Viewing Work Item Participants
For events that contain Resource entity GUID and Resource entity names attributes, you can view the
participants for the work item to which the event pertains.

Procedure

1. In the Event Viewer, select an event that contains the Resource entity GUID and Resource entity
names attributes.
For example, an "allocate work item" event contains those attributes:
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2. From the View menu, select Work Item Participants.
The Work Item Participants dialog lists the participants for the work item associated with the
selected event.

If the participant is an organizational entity other than a resource, selecting the entity on the Work
Item Participants dialog lists all of the resources that are currently mapped to that entity. For
example:

134

TIBCO® Workspace User's Guide



The Work Item Participants dialog includes paging controls that can be used if there are a large
number of resources in the list.

Note that a participant can also be a resource (through direct allocation), a group, a position or an
RQL query. The following are a couple other examples:

The participant is a resource:

The participant is an RQL query:
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3. Click the X in the upper-right corner of the Work Item Participants dialog to close the dialog.

Finding an Event
A Find function is provided to help you locate an event in the event list. Note that this function
searches through the entire event list, not just the currently displayed page.

However, if there is a filter currently applied to the list, it only searches through the events that satisfy
the filter.

Procedure

1. Click the  button on the event list toolbar, or select Find Events from the Tools menu.
The following fields are displayed in the event list toolbar.

2. From the drop-down list in the first field, choose an attribute that you want to search on. For
example, to find an event that was initiated by a certain user, choose “Principal name”.

3. From the drop-down list in the second field, choose the operator that is appropriate for your search.
4. In the last field, enter the value you want to search for.

You can use the * character as a wildcard. For example, the following finds all events that were
initiated by a user whose name begins with “C”:

If you select a date attribute to search on, a calendar icon is displayed from which you can select a
date, plus fields are displayed to the right of the calendar icon in which you can enter a time.

5. Click the  button (which is activated when you enter a value to search on) to display the find
results.
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The Find fields can be closed by either clicking the X to the left of the fields, or by clicking the 
button again.

Viewing an Additional Event List Using Event Links
Events in an event list may provide event Links that allow you to link to additional event lists that are
related to the event that contains the link.

For example, an “allocated work item” event may have a link to an event list containing all events
related to that work item, all events related to the process instance from which the allocated work item
was generated, all events related to the resource (user) who allocated the work item, etc. See the
example below.

Procedure

1. Select the desired event, then click the Links button either in the toolbar or in the Event Links
column:

A drop-down menu is displayed that provides selections that create event lists that show you the
events that have been recorded for the related item.

Note that the drop-down menu is customizable, and may contain different types of related items
than are shown in this example.

2. Select the desired item from the drop-down menu.

This causes a new event list to be displayed that contains all events that are associated with the item
selected from the drop-down menu.

For example, if “This instance” is selected from the drop-down menu shown in step 1, the following
event list is displayed:
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This new event list contains the events related to the process instance that generated Work Item 60.

Bread Crumb Trail
A “bread crumb trail” is created as you click event links.

For example, suppose you had the “Work Item 60” event view displayed, then you selected a “This
instance” link, then selected an “Activity by this resource for this work item” link. In this case, the bread
crumb trail might look like the following:

Each of the entries in the bread crumb trail is a link that returns you to that event list:

You can continue to click the Links button in the toolbar or in the Event Links column to display
additional related event lists — as you do this, the bread crumb trail continues to grow, allowing you to
return to any of the previously displayed event lists in that series.
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Viewing Correlated Events
Correlated events are all of the events with the same correlation ID (which can be seen in the
Correlation ID event attribute). And all of the events with the same correlation ID are part of the same
transaction.

Procedure

1. In the Event Viewer, select the event whose correlated events you would like to view.

2. Click either the links button in the event list toolbar, or the Links button in the Event Links column
for the selected event.

3. Select Show Correlated Events from the drop-down menu. (If the drop-down menu does not
contain a Show Correlated Events selection, the selected event does not have a correlation ID, i.e., it
is not part of a transaction.)

A new event list is displayed that contains the events that are correlated to the event that was
selected. For example:

Note that some correlated event lists may only contain the event that you selected in the original
event list, which means that there are no other events with the same correlation ID.

A bread-crumb trail is also created above the toolbar that allows you to easily return to the original
event list:

You can treat a list of correlated events just like any other event list. That is, you can filter and sort
the correlated events, save the event list if desired, or click individual events in the list to display the
attributes for that event in the Event Attributes section. You can also link to additional event lists
using the Link tool (for information, see Viewing an Additional Event List Using Event Links).

Saving an Event View Created Through Event Links
Once you display an additional event list by making a selection from the Links drop-down menu, you
can save this new event list/view by using the Save View As button or menu selection.

If you do not save an event list that is the result of clicking a Links drop-down menu, that event list is
lost when you log out. For example, if you had clicked on an event link twice to produce the following
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event list, then you logged out without saving it, when you log back in, only the original “Work Item 9”
event view will still exist (assuming that that was a permanent view):

Also note that if you specify a filter on an event list anywhere in the bread crumb trail, that filter is
retained as you display additional event lists (by making another selection from the Links drop-down
menu). This allows you to go back to any spot in the bread crumb trail and view that event list as you
left it.

Sub-Process Events

If an event in the Event Viewer has a  character to the left of the event, it means it is a sub-process
start event.

For example:

Clicking on the  character expands the list to include the events related to the sub-process that was
started. The events related to the sub-process are shown indented below the sub-process start event:

Sub-processes can be many levels deep, that is, a task in one process can start another process, which
can contain a task that starts another process, and so on. Each time another sub-process is started, the
event hierarchy is shown with additional  characters that can be expanded. For example:
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By default, a maximum of 100 events will be shown under a sub-process start event (although this
number is configurable by a system administrator). Which means that if there are more than 100 events
related to the expanded sub-process, you will not be able to see them by expanding the list in this way.
An alternative is to select the “Started instance” event, then select “This instance” from the Links menu
to create a new event list containing all of the events related to the sub-process instance that was
started.

Auditing Process Data
Process data may appear in the Event Viewer if your system has been configured to audit process data.

Auditing of process data must be configured at design-time using TIBCO Business Studio (see the
TIBCO Business Studio Modeling Guide).

If your system has been configured to audit process data, you will see the values from data fields in the
Event Viewer. For example:

In this example, two data fields have been mapped to two work item attributes -- Attribute3 and
Attribute8. The values that were entered into those data fields appear in the audit trail (Event Viewer).

If a work list facade has been defined on your system, and display labels have been assigned to Attributes
3 and 8, the labels are shown in the Event Viewer rather than "Attribute3" and "Attribute8". (Work list

141

TIBCO® Workspace User's Guide



facades are defined in TIBCO Business Studio; for information, see the TIBCO Business Studio Modeling
Guide.)

Also note that if process data is being audited, you may see an entry like the following in the Event
Viewer:

This indicates that the value in the attribute has been truncated because the value entered in the data
field is too long to fit in the attribute to which the data field was mapped. The *nn* indicates that the
value has been truncated, where nn is the number of characters that were entered into the data field.
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Filtering Lists

Filtering a list involves entering filter criteria so that only some of the items are shown in the list, rather
than all of them. Filtering a list allows you to display only the items you are interested in.

For example, you may only be interested in work items that arrived in the work item list after Dec. 15,
2008. You can filter the list so that only those work items are shown.

Workspace allows you to filter the following types of lists:

● work item list

● process instance list

● event list

● case reference list

This chapter describes filtering in general — with the exception of the specific attributes you can filter
on, filtering each type of list is essentially the same.

This chapter uses the term “items” at times to refer to either work items, process instances, processes, or
events when describing filtering functions that apply to all list types.

Regardless the type of list, all filter criteria is specified using the Filter dialog:

If a Work List Facade is deployed, attributes are displayed showing the display names.

The only difference in the Filter dialog between the list types is the list of attributes that you can filter
on that is shown in the Attributes section, plus some list types provide a second column in the
Attributes section that provides additional information about the attributes.

For information about how to display the Filter dialog, see Accessing the Filter Function.

Base Filter and Refined Filter
Lists allow you to specify a base filter and a refined filter.

An exception to this is the case reference list; it does not have base and refined filters.

● Base filter - This is a filter that has been permanently saved in the view definition. You can specify a
base filter through the view wizard when creating a view, or later by editing the view. The base filter
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can also be modified by specifying a refined filter (see below), then adding that filter to the base filter
by saving the view after specifying the refined filter.

● Refined filter - This is a filter that is specified through the Filter function on the work item list,
process instance list, or event list. It allows you to refine the base filter if there is one specified.

Defining a Base Filter

A base filter can be specified for a work, process, or event view in one of the following ways:

● By specifying a filter when the view is created.
● By editing an existing view, and specifying/modifying the filter.
● By specifying a refined filter, then saving the view. This causes the refined filter to be added to the

base filter (if one exists), creating a new base filter.
Currently, the only way to tell if there is a base filter defined for a view is to open the view wizard and
look on the Filter dialog.

Defining a Refined Filter

A refined filter can be specified for a work, process, or event view by using the Filter function on the
work item, process instance, or event list, respectively.

Once you specify a refined filter, the Filter button will contain a green check to indicate that a refined
filter is in effect. Also, the Save View button/menu selection becomes enabled, as follows:

You can save a refined filter in one of two ways:

● Save View - This button/menu selection on the list adds the refined filter to the base filter, creating a
new base filter (if there was no base filter defined previously, the refined filter becomes the base
filter).
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● Save View As - This allows you to save the view with a new name. The original view is not
changed. The new view will have the original base filter (if defined) and the refined filter.

If the view is a system view, selecting Save View As causes the view to be saved as a user-defined
view.

When you specify a refined filter, then save the view (with either Save View or Save View As), the
refined filter is added to the base filter, then removed from the work item, process instance, or event
list. This results in the Save View button being disabled, and the check no longer appears next to the
Filter button. So if you open the Filter dialog from the list after saving the view, it will not show a filter.
However, if you open the Filter dialog using the view wizard, you will see that the refined filter has
been added to the base filter.

Refined filters are persisted between log outs and application restarts. If you define a refined filter on a
list, then either log out or restart the application, the refined filter will still appear when you view the
list.

Accessing the Filter Function
The filter function for work item, event, and process instance lists can be accessed either from the view
definition, or from the list itself.

● From the view definition - When you are creating or editing a work view, event view, process view,
or data view using the view wizard, a Filter dialog is displayed from which you can filter the
contents of the view (for information about creating/editing views, see Views). Note that if you
specify a filter in this way, it becomes the base filter for the view — for more information, see Base
Filter and Refined Filter.

● From the list itself - Click the  button, or select Filter from the View menu on the work item,
event, or process instance list (when viewing a case reference list, there is no filter available; they can
only be filtered from the data view definition). Note that if you specify a filter in this way, it is
considered a refined filter for the view — for more information, see Base Filter and Refined Filter.

Filter Expression Examples
Basic filter expressions are very easy to specify in Workspace. Showing how easy it is to create a filter
expression is best done with a couple of examples, then if you need more information, you can read the
rest of this chapter.

Example 1

This example shows how to display all work items that have a work item ID that is less than “2000”,
AND whose priority is set to 1.

Note that this same example can also be used if you need to filter on only a single criteria. In which
case, just skip steps 4 and 5.

1. Display the work item Filter dialog by clicking the Filter button on the work item list.

2. From the Grouping section on the Filter dialog, double-click the AND (All Of) entry:
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The AND (All Of) entry is added to the Filter section:

AND (All Of indicates that if “all of” the filter criteria that is specified below that icon is true for a
work item, the work item is returned from the server and displayed in the work item list.

The filter expression defaults to an “all of” expression. Therefore, this step is technically not
necessary for this type of expression. It is being added here for completeness.

3. From the Attributes section on the Filter dialog, double-click the Work Item ID attribute:

Note that you can also “drag and drop” the Work Item ID attribute into the Filter section, or right
click and select Insert Item.

The Work Item ID data-entry dialog is displayed in the Filter section. This is the first criteria that
must be true for the work item to be displayed in the list.

4. In the Work Item ID data-entry dialog, select “LessThan” from the drop-down list, enter “2000” in
the second field (without the quotes), then click the Add button:
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5. From the Attributes section on the Filter dialog, double-click the Priority attribute:

The Priority data-entry dialog is displayed in the Filter section. This is the second criteria that must
be true for the work item to be displayed in the list.

6. In the Priority data-entry dialog, leave “Equal” selected from the drop-down list, enter “1” (without
the quotes) in the data-entry field, then click the Add button:

The “filter expression” for the two criteria you entered is now shown in a graphical format in the
Filter section:

This specifies that the work items that satisfy “all of” the filter criteria (that is, have a work item ID
of less than 2000 AND have a priority of 1) are returned from the server and displayed in the list.

7. Click the Apply button. The “# items will be returned” text in the upper left part of the Filter section
tells you how many work items satisfied the filter expression.

8. Click OK to display the work item list.
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Example 2

This example shows how to display all process instances that were started on or before May 1, 2009, OR
that have been suspended (i.e., Status = Suspended).

1. Display the process instance Filter dialog by clicking the Filter button on the process instance list.

2. From the Grouping section on the Filter dialog, double-click the OR (Any Of) entry:

The OR (Any Of) entry is added to the Filter section:

The OR (Any Of) icon indicates that if “any of” the filter criteria that is specified below that icon are
true for a process instance, the process instance is returned from the server and displayed in the
process instance list.

3. From the Attributes section on the Filter dialog, double-click the Start Date attribute:

Note that you can also "drag and drop" the Start Date attribute into the Filter section, or right click
and select Insert Item.
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The Start Date data-entry dialog is displayed in the Filter section. This is the first criteria that can be
true for the process instance to be displayed in the list.

4. In the Start Date data-entry dialog, select “LessOrEqualTo” from the drop-down list, click the "date
picker" icon to the right of the date field and select May 1, 2009 from the calendar that is displayed,
then click the Add button:

The “filter expression” for what you have entered so far is added to the Filter section:

5. From the Attributes section on the Filter dialog, double-click the Status attribute:

The Status data-entry dialog is displayed in the Filter section. This is the second criteria that can be
true for the process instance to be displayed in the list.

6. In the Status data-entry dialog, leave “Equal” selected in the first drop-down list, select
"Suspended" from the second drop-down list, then click the Add button:

The “filter expression” for the two criteria you entered is now shown in a graphical format in the
Filter section:
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This specifies that the process instances that satisfy “any of” the filter criteria (that is, has a start date
on or before May 1, 2009 OR has an instance status of "Suspended") are returned from the server
and displayed in the list.

7. Click the Apply button. The “# item will be returned” text in the upper left part of the Filter section
tells you how many work items satisfied the filter expression.

8. Click OK to display the work item list.

The two preceding examples are considered simple examples because they specify either
“All Of” or “Any Of”, but not both. You can construct filter expressions that are a mixture
of “All Of” and “Any Of”. This is described in Combining “AND (All Of)” and “OR (Any
Of)”.

Specifying a Filter Expression
The filtering function allows you to build a “filter expression” that is applied to all items that could
potentially be in the list. If an item satisfies the filter expression, it is shown in the list; if it does not
satisfy the filter expression, it is not shown in the list.

Specifying a filter expression is done using the Filter dialog:

This dialog may be displayed in a number of ways: by clicking the Filter button, by selecting Filter
from the View menu on the list menu bar, or when creating a view with the view wizard.

Specifying a filter expression is done from the Filter dialog. It involves doing the following:

Procedure

1. Choosing a Filter Grouping - This specifies “All Of” or “Any Of” — see Choosing a Filter
Grouping.

2. Selecting Filter Attributes - The values in the attributes you choose determine whether or not each
item is included in the list — see Selecting Filter Attributes.
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3. Applying the Filter Expression - This tells you how many items will be returned from the server
and shown in the list — see Applying the Filter Expression.

Choosing a Filter Grouping
Choosing a filter grouping specifies that you want the list to include the items for which “all of”, “any
of”, or “none of” the specified filter criteria are true.

Note that the “none of” setting is available only when filtering data views; for information, see Creating
Data Views).

Choose the grouping in one of the following ways:

● Double-click the desired entry in the Grouping section,

● click the desired entry and drag it into the Filter section, or

● right-click the desired entry and select Insert Item from the context menu.

This causes the selected entry to appear in the Filter section. For example:

You can specify multiple “AND (All Of)” and “OR (Any Of)” entries in the Filter section. For more
information, see Combining “AND (All Of)” and “OR (Any Of)”.

Default Filter Grouping

The default filter grouping is “AND (All Of)”. If you don’t explicitly add a filter grouping to the Filter
section, then add an attribute, it is displayed without a filter grouping.

For example:

If you apply this filter expression, it will display all items that satisfy the single criteria.

Then if you add another attribute to the Filter section, the system will automatically add the default
“All Of” group. For example:
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Modifying the Filter Grouping

The system also allows you to change an “AND (All Of)” to an “OR (Any Of)”, or vice versa, in the
Filter section in a number of different ways.

You can use theses methods to toggle the grouping:

● double-clicking the entry in the Filter section,

● right-clicking the entry, then selecting Modify Item,

● selecting the entry, then clicking the Modify Expression button in the menu bar, or

● selecting the entry, then selecting the Modify selection on the Tools menu in the Filter section:

Combining “AND (All Of)” and “OR (Any Of)”

Most filter expressions will include a single “AND (All Of)” or “OR (Any Of)” filter grouping.
However, you can also combine them in a single expression to create more complex expressions.

When combining “AND (All Of)” and “OR (Any Of)” you are essentially combining logical ANDs and
ORs in a single expression. Therefore, this will normally only be done by users who have an
understanding of more complex logical expressions.

When combining filter groupings, it is helpful to view the filter syntax as you build the filter expression,
as parentheses are placed in the appropriate location in the syntax as you add groups. To view the filter
syntax, select Show Expression from the Tools menu in the Filter section.

A filter grouping that is added subordinate to another filter grouping is enclosed in parentheses when
the system builds the filter syntax; this means that the subordinate grouping is evaluated separately,
then its result is used to evaluate the parent grouping. See the following examples.

Example 1

To view work items that have a start date earlier than Jan. 1, 2010, and have a priority of 1 or 2, build the
following filter expression:
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Example 2

To view process instances that have been suspended, or that were started this week and have a priority
of 1, build the following filter expression:

Selecting Filter Attributes
Selecting filter attributes involves choosing the attributes upon which you want to filter the items, then
entering a value for each attribute.

For example, you could select the Priority attribute when filtering work items, then enter a value of 1 —
all work items with a priority of 1 are returned from the server and displayed in the work item list.

The following table lists the available attributes on which you can filter work items.

Filter Attributes for Work Item Lists

Attribute Name Description Data Type

Attribute #1 - #40 These attributes, which can be populated via a script in
the process, can contain various information.

#1, #15: Integer

#5: #16: #17: -#18:
Decimal

#6, #7: #19: #20:
DateTime

All others: Text

Description The description of the task associated with the work item. Text
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Filter Attributes for Work Item Lists

Attribute Name Description Data Type

Distribution
Strategy

Describes the way in which a work item was distributed to
users. The possible entries are:

● Allocate - The work item was sent to a specific user’s
work list.

● Offer - This means the work item was offered to either
an individual user, or to a group of users. Any user to
whom the work item was offered can open the work
item and work on it.

For more information, see Why Are Work Items Sent to
Your Work Item List .

Enumeration(1)

Target Date A deadline date/time for the work item. For more
information, see Work Item Deadlines .

DateTime

Instance
Description

A description of the process instance. This may or may not
have been specified, depending on how the process was
defined.

Text

ID A unique alphanumeric value identifying the process
instance from which the work item was created.

Text

Name The name of the user task associated with the work item. Text

Priority Denotes the importance of the work item. This value is
assigned to the user task (which results in a work item)
when the process is defined.

Example: 1

Numeric

Process Name The name of the process that was started to create this
work item.

Text

Start Date The date and time the work item is scheduled to start.

Example: 2010-08-25 14:30:00

DateTime
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Filter Attributes for Work Item Lists

Attribute Name Description Data Type

State The current state of the work item in your work item list.
The possible entries are:

● Offered

● Allocated

● Created

● Opened

● Pended

● Pend Hidden

● Suspended

For more information, see Work Item State .

Enumeration1

Work Item ID A unique identifier for the work item. This is generated by
the system when the work item is created.

Example: 608

Numeric

(1) For enumerations, you can only select from the possible entries on the Filter dialog

The following table lists the available attributes on which you can filter process instances:

Filter Attributes for Process Instance Lists

Attribute
Name(1) Description Data Type

ID Uniquely identifies the process instance. Text

Process Name The name of the process that was started to create this
instance.

Text

Outstanding
Count

This is the number of outstanding work items in this
process instance.

Also see, Outstanding Work Items .

Numeric

Parent Process ID The instance ID of the parent process — only applicable for
re-usable sub-processes.

Text

Priority This is a numeric value that has been assigned to the
process instance by an administrator. The numeric value
assigns a relative importance to the process instance, which
allows users to prioritize their work.

Numeric

Start Date The date and time the process instance was started.

Example: 2008-08-25 14:30:00

DateTime
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Filter Attributes for Process Instance Lists

Attribute
Name(1) Description Data Type

Status The current status of the process instance. The possible
statuses are:

● Active

● Completing

● Canceling

● Halted

● Halting

● Suspended

● Suspending

● Resuming

● Failing

● Starting

● Restarting

● Not Started

For information, see Process Instance Status .

Text

Version The version number of the process from which the instance
was started.

Numeric

Module Name This is the path to the XPDL file that defines the "process
package".

Text

(1) The attributes shown on the Filter dialog for process instances are listed in a tree structure,
categorized by “System” and “Custom”. System attributes contain information that the system
entered in the attribute, such as start date, current status, etc. Custom attributes represent customer-
specified fields that are added to a process when it is defined. Those fields can then be added to
forms. When a user enters information in the fields on a form (e.g., customer name, address, loan
amount, etc.), that information is stored in the custom attribute for that field. For more information,
see Custom Attributes in Process Instance Lists .

When filtering event lists, the Attributes section on the Filter dialog lists all of the filterable attributes,
which is a subset of all available event attributes. They are displayed in a tree structure categorized by
the component that writes values to each attribute. You can expand or collapse the list below each
component name, as needed, by clicking the + or - icon to the left of the component name.

When filtering data views, the Attributes section on the Filter dialog lists all of the attributes that were
specified as searchable when the case class was defined in TIBCO Business Studio. For information about
filtering on case data attributes, see Creating Data Views .

The filter string that is displayed is the filter string that will be sent to the server, using the physical
names of the attributes and not the façade display names.

The Attributes section on the Filter dialog lists all of the attributes on which you can filter.

To specify an attribute to filter on, do one of the following:
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● Double-click the desired attribute in the Attributes section,

● click the desired attribute and drag it into the Filter section, or

● right-click the desired attribute and select Insert Item from the context menu.

This causes the data-entry dialog for the selected attribute to appear in the Filter section. For example:

The data-entry dialog for every attribute contains the following data-entry fields:

● Logical operator - This is a drop-down list that allows you to choose how the specified value is to be
compared to the actual values in the attributes of the item. You can specify “equal to”, “not equal
to”, “less than”, etc.

For example, to display all work items whose start date is prior to Jan. 1, 2010, select the Start Date
attribute, choose the “LessThan” logical operator, then choose Jan. 1, 2010 from the value field date
picker.

The logical operator drop-down list also includes a “Range” selection for DateTime attributes,
which allows you to specify a range of dates/times for which you would like work items or process
instances returned. For information about using the Range operator, see DateTime Ranges.

● Value field(s) - Each data-entry dialog contains one or more value fields in which you enter the
value for the items you want returned.

The way in which you enter a value depends on the data type for the attribute you are adding. The
data type for each attribute is shown in the tables in Selecting Filter Attributes. For information
about data types, see Value Data Types.

After choosing a logical operator and entering a value, you can add the filter attribute to the filter
expression by clicking the Add button (or just press the Enter key):
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The filter attribute is added to the filter expression in the Filter section. For example:

You can add additional filter attributes to the filter expression in the manner described above.

The filter attribute data-entry dialog has a couple other buttons on it that allow you to either close the
dialog without making changes, or remove the attribute from the filter expression:

● To close the data-entry dialog without making any changes, click the Close button:

● To remove the filter attribute currently displayed in the filter expression, click the Remove button:

Value Data Types

The value entered in the Value field must match the data type for the attribute selected.

The following describes the valid data types:

Data Type Description

Numeric Consists of one or more of the numbers 0-9. Used for things like work item
ID and priority. The data entry field for numeric values will not allow you
to enter any characters other than numbers.
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Data Type Description

Text Consists of any number of letters, numbers, or special characters (e.g., #, $,
etc.). Used for things like process instance ID and work item description.

Filtering on text is case sensitive.

Note that text attributes are the only attribute types with which you can use
wildcard characters. For more information, see Using Wild Card
Characters .

And if you are filtering on text that contains any of the four special
characters (*, ?, ‘, or \), they must be “escaped”. For information, see 
Filtering on Special Characters .

DateTime Dates can be entered manually or by using the “date picker” on the filter
data-entry dialog.

Times, if specified, must be entered manually. If you enter a date, but not a
time, it assumes “all times” for the specified date. All times use the 24-hour
clock.

There is also a special "Today" entry that can be used when filtering on
DateTime attributes. This entry always represents the current date.

For more information about entering dates and times in the filter data entry
dialog, see DateTime Attributes.

Enumeration Some attributes only allow you to select a valid entry. These are called
“enumerations”. For example, when filtering work items, the Distribution
Strategy attribute dialog allows you to choose from the two possible
distribution strategies: Allocated and Offered.

The attributes in data views can include types other than those listed here. For information, see 
Creating Data Views .

Custom Attributes in Process Instance Lists

When filtering process instances, the Available Attributes section on the Filter dialog can also list
custom attributes.

For example:
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Custom attributes represent customer-specified data fields that are added to a process when it is
defined. Those fields can then be added to forms. When a user enters information in the fields on a
form (e.g., customer name, address, loan amount, etc.) in an instance of the process, that information is
stored in the custom attribute for that field, in that process instance.

Using custom attributes, you could, for example, filter the process instance list so that only process
instances are displayed in which customer name = "Smith".

Note, however, that only the custom attributes that are common to all of the processes that were
included in the process view when it was created are included in the list of attributes on which you can
filter.

For example, suppose ProcessA and ProcessB were included in a process view, and those processes
include these custom attributes (i.e., customer-specified data fields):

● ProcessA:

— Customer Name

— Customer Address

— Loan Amount

— Job Title

● ProcessB:

— Customer Name

— Customer Address

— Phone Number

— SSN

Only the “Customer Name” and “Customer Address” attributes will appear in the Filter dialog because
those are the only ones that are common to both processes.

Also, the data type (see Value Data Types) must be the same for the common attributes. For example, if
all of the processes have an attribute called “Age”, but it’s defined as a numeric attribute in one process
and as a text attribute in another process, that attribute will not appear in the list of attributes on which
you can filter. It must be the same data type in all processes for it to appear as a filterable attribute.
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DateTime Attributes

Dates and times can be entered in a number of different ways when you are using a DateTime attribute
(for example, Start Date).

Filter data-entry dialogs that contain a DateTime attribute (e.g., Start Date) appear as follows:

Dates and times can be entered for these attributes in the following ways:

● Dates can be entered in two ways:

— Using the “date picker”, which is the calendar icon to the right of the date field. Clicking on the
date picker icon displays a calendar from which you can choose the desired date — the selected
date is automatically entered in the date field.

— Manually enter the date. If entered manually, it must be in the following format:

YYYY-MM-DD

where YYYY = year, MM = month, and DD = day.

For example: 2008-08-25

As you enter the numbers, the hyphens are automatically entered for you.

If desired, you can also manually enter just a portion of the date, starting from the left. For
instance, you can manually enter just "2009" in the date field — this means "all of 2009". Or you
could enter just "2009-05" (the hyphen is automatically entered) — this means "all of May 2009".
Or you can manually enter the entire date.

● Times are optional. If entered, they must be entered manually, in the following format:

hh:mm:ss.nnn

where hh = hour (using the 24-hour clock), mm= minute, ss = second, and nnn = milliseconds.

For example: 15:30:00.000

If the time is not specified, Workspace assumes “all times” for the specified date. For example, if you
specified “Start Date = 2008-10-04”, with no time, it will return all work items that were started on
Oct. 4, 2008, regardless of the time they were started.

If desired, you can enter just a portion of the time, starting from the left. For instance, you can enter
just "10" in the first of the time fields — this means "all times that begin with 10 o’clock".

The data-entry dialog for DateTime attributes may or may not include the field for milliseconds.
This is controlled through a user option. For more information, see Times.

Note that all times that are displayed in Workspace are based on your local time. So even if someone
else in a different time zone than you starts a process instance, when you view the process instance,
the start time is shown in your local time. And it is your local time that you would enter in a Filter
dialog.
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Dynamic Time-Period / Point-in-Time Entries

When filtering on DateTime attributes, there are a number of entries you can select from that
dynamically calculate a time period or point in time. The available dynamic time-period / point-in-time
filter entries are displayed from the drop-down list to the left of the date attribute field:

Each of these special entries calculates the time period or point in time when the filtered list is viewed, not
when the filter was defined.

For example, if you filtered the work item list on the Start Date attribute, and specified it equal to
"Today", the work item list will only list work items that arrived in your work item list on the day on
which you are viewing the list.

Or, for example, if you filtered the process instance list on the Start Date attribute, and specified it equal
to "This month", the process instance list will only list the process instances that were started from the
1st of the month, until the time at which you are viewing the list.

The dynamic time-period / point-in-time entries are not available if you are filtering your Inbox because
of the way the server maintains the Inbox filter. To use this feature when filtering work items, you must
create a view other than your Inbox.

The available dynamic time periods and points in time are described below:

● Today - The current day, from 12:00 A.M. to 12:00 P.M.

● This week - The current week, from 12:00 A.M. Sunday morning to 12:00 P.M. Saturday evening.

● This month - The current month, from the 1st through the last day of the month.

● This quarter - The current 3-month period used as a quarter by your company. The specific three
months to which this refers depends on how your system is configured. As different companies use
different months on which to begin a quarter, this may be referring to:

— This month, and the next two months,

— last month, this month, and next month, or

— the previous two months, and this month.

● This year - The current year, from January 1 through December 31.
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Also note that if you choose any of the Today, This week, This month, This quarter, or This year
dynamic time periods, another field is displayed on the dialog that allows you to also include an
additional number of like time periods, either in the past, or in the future:

In the field on the bottom of the dialog, select previous or future from the drop-down list to also
filter on an additional number of periods in the past or the future, respectively.

For example, if you chose to filter on “Today”, you could have it also return items from any number
of previous days.

● Previous period - This allows you to filter based on a specified number of days, hours, and/or
minutes in the past. Note that this period is calculated from the moment you invoke the filter, plus every
time the list is refreshed. For example, the following filter will return the work items that arrived in the
work item list in the last 4 hours.

This 4-hour time period is re-calculated each time the list is refreshed so that that it always contains
only the work items that arrived in the last 4 hours.

The "Equal" operator returns all items that fall within that time period, and "NotEqual" returns all
items outside of the time period. The "LessThan" and "GreaterThan" operators return all items that
fall previous to the time period, or after the time period, respectively. Note, however, that the
LessOrEqualTo" and "GreaterOrEqualTo" operators return all items that either fall previous to or
after the time period, as well as those that fall within the time period.

● Future period - This allows you to filter based on a specified number of days, hours, and/or minutes
in the future. Note that this period is calculated from the moment you invoke the filter, plus every time
the list is refreshed. For example, the following filter will return the work items that have a deadline
(i.e., they have a target date) that is set to expire in the coming 6 hours.
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This filter is re-applied each time the list is refreshed so that the list always contains only the work
items that have deadlines that will expire in the next 6 hours.

The operators work the same as for "Previous period" — see above.

● Previous time - This specifies a specific point in time in the past, relative to the time at which you
invoke the filter, or refresh the list. This would normally be used with the "greater than" or "less
than" operators, because it defines a point in time, not a time period.

For instance, you may be interested in listing all of the work items that arrived in your work item
list prior to 3 hours and 30 minutes ago:

The point in time is re-calculated each time the list is refreshed so that it always contains the work
items that arrived prior to 3 hours and 30 minutes ago.

Note that if you used the "Equal" operator, the list will contain only those items that match the point
in time exactly.

● Future time - This specifies a specific point in time in the future, relative to the time at which you
invoke the filter, or refresh the list. This would normally be used with the "greater than" or "less
than" operators, because it defines a point in time, not a time period.

For instance, you may be interested in listing all of the work items that have a deadline (target date)
that is less than one hour in the future (which returns all work items that already have expired
deadlines, as well as those that will expire in the next hour):

The point in time is re-calculated each time the list is refreshed so that it always contains the work
items with target dates less than one hour in the future.

Note that if you used the "Equal" operator, the list will contain only those items that match the point
in time exactly.

● Now - This represents the current time. This would normally be used with the "greater than" or "less
than" operators, because it also defines a point in time, the current time.

For instance, to list all work items that have a deadline (a target date) that have not yet expired:
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DateTime Ranges

When filtering on DateTime attributes, you can select a logical operator of "Range". This allows you to
request that all items that fall within a range of dates be displayed in the list. Selecting "Range" causes
another set of fields to be added to the Filter dialog, as follows:

Enter the beginning date/time of the range in the first set of fields, and the ending date/time of the
range in the second set of fields.

The date/time comparison is inclusive. For example, if you are filtering on the start date, and the range
is from May 1, 2009 to May 3, 2009 (with no times specified), all items with a start date on May 1, 2, and
3, are displayed in the list.

Using Wild Card Characters

The wild card characters ’*’ and ’?’ can be used when filtering on text attributes (work item name,
description, and so on) — wild card characters cannot be used with any other attribute type.

The ’*’ and ’?’ characters are evaluated as follows:

● ‘*’ matches zero or more of any character. For example:

— “bo*” matches anything beginning with “bo”. For example, “bo”, “bobbl”, “boulton_anne”, etc.

— “s*s” matches anything beginning with “s” and ending with “s”. For example, “ss”, “sues”,
sid_lewis”, etc.

— “*s” matches anything ending with “s”. For example, “franks”, “ls”, “martha_lyons”, etc.

● ‘?’ matches any single character. For example:

— “bill?” matches anything beginning with “bill”, plus one more character. For example, “bills”,
“bill5”, “billh”, etc.

— “c?ndy” matches “cindy”, “candy”, “c3ndy”, etc.

Also note that all character matching is case sensitive.

Filtering on Special Characters

If you are building a filter expression that is filtering text, and your expression contains special
characters, the special character may need to be “escaped” in the filter expression.

The following are the special characters that need to be escaped:
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● * (asterisk)

● ? (question mark)

● ‘ (single quote)

● \ (backslash)

● " (double quote)

To “escape” a character means to precede that character with another character in the filter expression
so that the system knows that you are filtering on the literal character, rather than intending for the
character to take on its special meaning. For example, if you just included an asterisk or question mark,
it would take on its special meaning as a wild card character (see Using Wild Card Characters).

The character that you precede the special character with depends on what you are filtering (work
items, process instances, events, or cases), as shown in the table below (although it is most often a
backslash). Also note that some special characters do not required escaping, that is, just include the
special character on its own in the filter expression. For example, when filtering cases, a single quote
can be included in the expression without escaping it. Also, in some instances, if you include an escape
character when it is not needed, or do not include the escape character when it is needed, an error is
returned. These are noted in the table below:

Character to
match literally Work Items

Process
Instances Events Cases

* \* \* \* \*

? \? \? \? \?

‘

See footnote (1)

\' '' \‘ '

\ \ \ \\

See footnote (2)

\\

See footnote (2)

" \"

See footnote (3)

" \" "

See footnote (4)

  (1) If you include a single quote in the expression, without escaping it, when filtering work items,
process instances, or events, an error is returned.

  (2) If you include a single backslash in the expression, without escaping it, when filtering events or
cases, an error is returned.

  (3) If you include a double quote in the expression, without escaping it, when filtering work items, an
error is returned.

  (4) If you include a double quote in the expression, that is escaped with a backslash, when filtering
cases, an error is returned.

As an example, if you are filtering for events for a resource (Principal name) by the name “Jon
O’Reilly”, you would need to escape the single quote in the name with a backslash character. For
example:

166

TIBCO® Workspace User's Guide



Applying the Filter Expression
At any point after adding a filter attribute to the filter expression, you can apply it to determine how
many items satisfy the expression.

To apply the filter expression shown in the Filter section:

● Click the OK button (without clicking Apply first). This causes any filter expression you’ve entered
to be applied and the list displayed. But you will not know the number of items that will be
returned in the list until after the list is displayed.

● Click the Apply button. The system will apply the filter expression and calculate how many items
satisfy the expression. This number is shown on the top of the Filter section (17 in this example):

The “xx items will be returned” message is not displayed if you are filtering an “All Work
Items” work view. For this type of work view, a total count of work items is not returned
from the server to reduce overhead. Therefore, the number of items for the filter cannot be
determined. For information about “All Work Items” views, see Work Views .

If you clicked Apply, and the number of items that will be returned from the server is satisfactory, click
the OK button to display the list.

If the number of items is still too large, you can modify any of the previously entered values, or add/
remove attributes from the expression, then click Apply again to get a new item count.

Anytime you add, delete, or modify a filter expression in the Filter section, and have not yet clicked the
Apply button to apply it, the following message is shown to notify you that the changed filter
expression has not been applied:
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Whenever the message shown above is displayed, the Apply button will be active.

Note that if you are applying the filter expression from the list itself (rather through the view
definition), the Filter icon will now contain a check mark to indicate that a refined filter is currently
applied on the list:

Modifying an Existing Filter Expression

After you’ve specified your filter expression in the Filter section, it can be modified in a number of
ways.

For example:

● Change an “AND (All Of)” to an “OR (Any Of)”, or vice versa. This can be done in the following
ways:

— double-click the entry in the Filter section,
— right-click the entry, then select Modify Item,
— select the entry, then click the Modify button in the Filter section, or
— select the entry, then select the Modify selection on the Tools menu.

● Modify the value you’ve specified in one of the filter attributes. Display the data-entry dialog for an
existing attribute in one of the following ways:

— Double-click the attribute name in the Filter section,
— right-click the attribute name, then select Modify Item,
— select the attribute name, then press the Enter key,
— select the attribute name, then click the Modify button in the Filter section, or
— select the attribute name, then select the Modify selection on the Tools menu.

● Delete a filter attribute from the filter expression. You can remove a filter attribute from the filter
expression in one of the following ways:

— Right-click the desired attribute name, then select Delete Line,

— select the attribute name, then select the Delete Line selection on the Tools menu, or

— select the attribute name, then click the Delete Line button in the Filter section. Notice that this
button is one of three delete buttons provided in the Filter section:

The Delete Line button deletes only the currently selected line (filter attribute).

The Delete Branch button is active only when an “AND (All Of)” or “OR (Any Of)” entry is
currently selected; it deletes the entire “AND (All Of)” or “OR (Any Of)” branch, including all
filter attributes in that branch. The Delete Branch function is more applicable when creating a
filter expression that contains a mixture of “AND (All Of)” and “OR (Any Of)” entries; these are
explained in Combining “AND (All Of)” and “OR (Any Of)”.

The Delete All button deletes all entries in the Filter section.
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Viewing the Filter Syntax
As you are adding attributes to the Filter section to build the graphical representation of the filter
expression, Workspace is creating the syntax that the server needs to process the expression. If you have
a need to view the syntax (perhaps for debugging purposes), you can do so by selecting Show
Expression from the Tools menu.

The filter syntax is displayed on the bottom of the Filter section, for example:

The filter expression cannot be modified using the syntax — it is provided only for viewing purposes.

Note that if you are filtering on a DateTime, a time zone offset is shown following the time. This is
required by the server because it stores all times in Coordinated Universal Time (UTC). The offset is
telling the server the number of hours you are located, plus or minus, from UTC. In the example shown
above, the application is running in a locale that is -8 hours from UTC. You don’t need to be concerned
with this offset, other than to know why it’s shown in the filter syntax.

Also, if you are filtering on a DateTime, and you specify "equal to" or "not equal to" a specific date, the
syntax appears as a range because of the way the filter must be applied internally. For example:

To close the window that displays the filter syntax, select Hide Expression from the Tools menu.

Exporting Filter XML
A function is available that allows you to export the XML that represents the graphical display of a
filter definition that is shown on the Filter dialog.

This function is invoked from the Filter dialog by either using the Export Filter XML... selection on the

Tools menu, or by clicking the  button.

The Export Filter XML function is intended to be used by technical personnel in conjunction with
method calls that create or modify filters definitions in the application. For more information about this
function, see the TIBCO Workspace Components Developer Guide.
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Sorting Lists

Workspace allows you to sort information displayed in lists so that it is shown in the desired order. For
example, you may want to list all process instances that are currently “Active” first, then sort those by
started date/time, from oldest to most recent.

This example would require you to sort on two attributes: “Instance State” and “Instance Start Date”.

Workspace allows you to sort the following types of lists:

● work item list

● process instance list

● event list

● case reference list

This chapter describes sorting in general — with the exception of the specific attributes you can sort on,
sorting each type of list is essentially the same.

This chapter uses the term “items” at times to refer to either work items, process instances, or events
when describing sorting functions that apply to all list types.

Regardless the type of list, all sort specifications are defined using the sort dialog:

If a Work List Facade is deployed, attributes are displayed showing the display names.

The only difference in the sort dialog between the list types is the list of attributes that you can sort on
(as shown in the Available Attributes section).

For information about how to display the sort dialog, see Accessing the Sort Function.

If you had applied a sort order the last time you displayed a list, that same sort order will be applied
when you open that particular list again — in other words, the most recently applied sort order for each
list/view will remain persistent until you either change it or remove it. Note that persisted settings are
saved on the server, so if you log onto a different machine, those settings will be in effect on that
machine also.

If a sort order is still active, the Sort button will be shown with a check mark, and if the sort dialog is
displayed, the previously entered sort specification will still be shown.
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Accessing the Sort Function
The sort function can be accessed either from the list itself, or from the view that defines the list.

● From the list - Click the  button, or select Sort from the View menu.

A Sort function is not available from case reference lists; these lists must be sorted using
the data view wizard.

● From the view definition - When you are creating or editing a work, process, or event view using
the view wizard, a sort dialog is displayed from which you can sort the contents of the view. (For
information about creating views, see Views.) You can either specify a sort order, or click Finish to
forego sorting the list.

It’s important to understand that a sort specified in a work view or process view is the same sort
specification that you will see if you display the sort dialog from the work item list or process instance
list that is displayed by that view.

For example, if you create a work view with a sort specified, then click the Sort button on the work item
list displayed by that work view, you will see the same sort specification that was set in the view.

Conversely, if you specify a sort using the sort dialog from the work item list itself, you will see that
same sort specification if you access the sort dialog from the work view definition that displays that
work item list.

Specifying Sort Criteria
Specifying sort criteria for a list involves a number of sub-tasks.

● Selecting Sort Attributes - Allows you to choose the attributes/columns in the list to sort on.

● Specifying Sort Order - Used if you are sorting on multiple attributes — specifies which attribute to
sort on first, second, and so on.

● Specifying a Sort Direction - You can choose to display the list in ascending or descending order.

● Applying the Sort Criteria - Displays the list in the desired order.

Selecting Sort Attributes
By default, before you specify a sort for the first time, all attributes that are available to sort on are
shown in the Available Attributes section on the sort dialog. It lists an attribute for each column in the
list.

For example, the following sort dialog is for a work item list:
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The attributes available for sorting data views are the attributes that are defined as searchable when the
case data is defined in TIBCO Business Studio.

The available attributes differ for each type of list. Those available for each type of list are shown in the
tables below.

System Attributes for Work Item Lists

Attribute Name Description

Attribute #1 - #40 These attributes, which can be populated via a script in the process, can
contain various information.

Distribution Strategy Describes the way in which a work item was distributed to users. The
possible entries are:

● Allocate - The work item was sent to a specific user’s work list.

● Offer - This means the work item was offered to either an individual
user, or to a group of users. Any user to whom the work item was
offered can open the work item and work on it.

For more information, see Why Are Work Items Sent to Your Work
Item List .

Target Date A deadline date/time for the work item. For more information, see Work
Item Deadlines .

Instance Description A description of the process instance. This may or may not have been
specified, depending on how the process was defined.

ID A unique alphanumeric value identifying the process instance from which
the work item was created.

Priority Denotes the importance of the work item. This value is assigned to the
task (which results in a work item) when the process is defined.

Example: 1
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System Attributes for Work Item Lists

Attribute Name Description

Process Name The name of the process that was started to create this work item.

Start Date The date and time the work item is scheduled to start.

Example: 2010-08-25 14:30:00

Work Item ID A unique identifier for the work item. This is generated by the system
when the work item is created.

Example: 608

System Attributes for Process Instance Lists

Attribute Name(1) Description

ID Uniquely identifies the process instance.

Process Name The name of the process that was started to create this instance.

Outstanding Count This is the number of outstanding work items in this process instance.

Also see, Outstanding Work Items .

Parent Process ID The instance ID of the parent process — only applicable for re-usable sub-
processes.

Priority This is a numeric value that has been assigned to the process instance by
an administrator. The numeric value assigns a relative importance to the
process instance, which allows users to prioritize their work.

Start Date The date and time the process instance was started.

Example: 2008-08-25 14:30:00
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System Attributes for Process Instance Lists

Attribute Name(1) Description

Status Indicates the current status of the process instance.

For a list of the possible statuses, see Process Instance Status .

Note that if you sort on process instance status, the instances may not
appear in the order in which you expected. That’s because internally they
are actually sorted by a status code, rather than the alphabetic name of the
status. The following is the order in which they will appear if sorted in
ascending order:

Not_Started
Active
Suspended
Suspending
Staring
Resuming
Restarting
Cancelling
Completing
Failing
Halted
Halting

Version The version number of the process from which the instance was started.

Module Name This is the path to the XPDL file that defines the "process package".

(1) The attributes shown on the Sort dialog for process instances are listed in a tree structure,
categorized by “System” and “Custom”. System attributes contain information that the system
entered in the attribute, such as start date, current status, etc. Custom attributes represent customer-
specified fields that are added to a process when it is defined. Those fields can then be added to
forms. When a user enters information in the fields on a form (e.g., customer name, address, loan
amount, etc.), that information is stored in the custom attribute for that field. For more information,
see Custom Attributes in Process Instance Lists .

When filtering event lists, the Attributes section on the Filter dialog lists all of the filterable attributes,
which is a subset of all available event attributes. They are displayed in a tree structure categorized by
the component that writes values to each attribute. You can expand or collapse the list below each
component name, as needed, by clicking the + or - icon to the left of the component name.

To specify sort attributes, move the attributes on which you want to sort the list to the Sort Attributes
section on the sort dialog. For example, the following will cause the work item list for the “Requests”
work view to be sorted first by the data in the Priority attribute, then by the data in the Start Date
attribute:
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Attributes can be moved back and forth between the Available Attributes and Sort Attributes sections
using the following methods.

To select attributes:

● Individual attributes can be selected by clicking the desired name.

● Multiple attributes can be selected by holding down the Ctrl key while clicking the desired names.
A group of attributes can be selected by clicking one name, then holding down the Shift key and
clicking the last name in the desired group.

To move the attributes to the desired list:

● Attributes can be moved back and forth between lists by selecting the desired attribute(s), then
clicking the “” or “<“ buttons.

● An individual attribute can be moved from one list to the other by double-clicking the attribute
name.

● Attributes can also be moved from one list to the other by using a “drag and drop” method — click
the desired attribute name (or group of selected attribute names), and while holding the mouse
button, drag them to the desired list and release the mouse button.

● All attributes in the Sort Attributes section can be moved to the Available Attributes section by
clicking the “<<“ button.

Custom Attributes in Process Instance Lists

When sorting process instances, the Available Attributes section on the sort dialog can also list custom
attributes.

For example:
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Custom attributes represent customer-specified data fields that are added to a process when it is
defined. Those fields can then be added to forms. When a user enters information in the fields on a
form (e.g., customer name, address, loan amount, etc.) in an instance of the process, that information is
stored in the custom attribute for that field, in that process instance.

Using custom attributes, you could, for example, sort the process instance list so that only process
instances are displayed alphabetically by customer name.

Note, however, that only the custom attributes that are common to all of the processes that were
included in the process view when it was created are included in the list of attributes on which you can
sort.

For example, suppose ProcessA and ProcessB were included in a process view, and those processes
include these custom attributes (i.e., customer-specified data fields):

● ProcessA:

— Customer Name

— Customer Address

— Loan Amount

— Job Title

● ProcessB:

— Customer Name

— Customer Address

— Phone Number

— SSN

Only the “Customer Name” and “Customer Address” attributes will appear on the sort dialog because
those are the only ones that are common to both processes.

Also, the data type must be the same for the common attributes. For example, if all of the processes
have an attribute called “Age”, but it’s defined as a numeric attribute in one process and as a text
attribute in another process, that attribute will not appear in the list of attributes on which you can
filter. It must be the same data type in all processes for it to appear as a sortable attribute.
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Specifying Sort Order
Sort order is applicable only if you have specified multiple sort attributes. It allows you to specify that
the list be sorted first on one attribute, then on another attribute, and so on.

For example, this sort specification:

would cause process instances to be sorted as follows:

Instance Priority Instance Start Date

1 2009-10-12 10:00:25

1 2009-10-23 09:12:16

2 2009-10-10 12:04:55

3 2009-10-12 13:05:45

3 2009-10-12 16:00:55

3 2009-10-16 08:45:12

In this example, all process instances with an instance priority of 1 are listed first; those process
instances are then sorted by their start date. Then all of the process instances with an instance priority
of 2 are listed; those process instances are then sorted by their start date. And so on. (Note that for this
example both attributes are sorted in “ascending” order — for information, see Specifying a Sort
Direction.)

To change the order, move the desired attributes up or down in the Sort Attributes list. You can do this
in one of the following ways:

● select the desired sort attribute(s) in the Sort Attributes list, then click the “Up” or “Down” Order
button on the sort dialog to move the attribute(s) up or down in the list, or

● “drag and drop” the attribute(s) to the desired location in the list — select the desired attribute(s),
and while holding the mouse button, drag the attribute(s) up or down in the list, then release the
mouse button.

Specifying a Sort Direction
You can specify that items in a list be sorted in either ascending or descending order.

You can specify a sort direction for each of the attributes listed in the Sort Attributes list. They are set to
ascending order by default when you add them to the list.:
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To change the sort direction, select the desired sort attribute(s) (you can change multiple attributes at
one time) in the Sort Attributes list, then click the Ascending or Descending buttons on the sort dialog:

The icon next to the attribute name will change to indicate the new sort direction:

Applying the Sort Criteria
After specifying the sort attributes, sort order, and sort direction, click the OK button to apply the sort
criteria you’ve specified.

When you click the OK button, a check mark appears in the lower right part of the Sort icon to indicate
that the list is being sorted:

Sorting a List Using Column Headers
You can quickly and easily sort a list by the values in a column by clicking the column header. If the
column contains text, it is sorted in alphabetical order; if it is numeric, it is sorted in numerical order; if
it is a date, time, or DateTime, it is sorted in chronological order.

Once you click a column header, an arrow appears in the column header, which indicates the direction
of the sort — if the arrow is pointing up, the sort is in ascending order; if it’s pointing down, the sort is
in descending order:

Each successive click the column header, toggles between ascending and descending order.
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Depending on how your system is configured, sorting a list by clicking a column header may either
cause only the currently displayed page to be sorted, or it may cause the entire list to be sorted, even
pages that have not been displayed yet.

Note, however, if your system is configured to sort the entire list when you click a column header, there
are some columns on which you cannot sort by clicking the header. This is because when the system is
configured in that way, the list is sorted on the server (rather than locally), and some attributes cannot
be sorted by the server. If you attempt to sort a column by clicking the header, and it cannot be sorted in
that way, a message is displayed informing you it cannot be sorted (you can still sort on that column
using the Sort function; see Accessing the Sort Function).

179

TIBCO® Workspace User's Guide



User Options

User options establish default settings for each user that logs into Workspace. These include things such
as whether the work item list or process instance list is displayed when the user first logs in, whether
preview is turned on by default, the size/location of work item forms, etc.

To set your user options, click the  button on the Workspace main toolbar.

User options are divided into the following functional areas:

● Display Options - These control default display settings, such as the default language, which lists to
initially display when you log in, etc.

● Work Item Options - These control default settings for work item-related functions, such as auto-
refresh and how to display work item forms.

● Business Service Options - These control default settings for business service-related functions, such
as how to display business service forms.

● Event Options - Controls whether or not a total count is displayed on event lists.

● Appearance Options - These control default layout settings, i.e., how lists are laid out on your
screen.

Each of these functional areas has its own "page" on which you specify default settings. You can display
each of these pages by clicking the appropriate icon in the left-pane.

Note that the buttons on the bottom of the Options dialog control all pages, not just the one currently
displayed. Therefore, you can specify settings on all of the pages, then click OK once to save all
changes.

The Apply button can be used to save changes without closing the Options dialog — clicking OK saves
changes and closes the dialog.

You can use the Defaults button to return all options to their initial default values. (Initial default values
are specified in the Workspace configuration file; for information, see the TIBCO Workspace Configuration
and Customization guide.)

User Options are Stored on the Server

When you make a change to a value on the Options dialog in Workspace, then click Apply or Save, all
of the user option values are written to the server. Therefore, these settings will be experienced at any
workstation on which you log on.

Display Options
The Display options section allows you to set user options that affect the display.

● Language - Specifies the language to display in Workspace.

● Initial Display - Specifies which list to initially display when you log into Workspace.

● Default View - Specifies which work view and process view to display initially.

● Captions - Specifies what should be displayed in captions by default.

● Times - Specifies whether or not milliseconds should be displayed in the work item and process
instance lists.

These are described in the following subsections.
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Language
You can specify which language to display on all of the screens and windows in Workspace.

This option performs the same function as the Language selection field on the Workspace header. For
information about that function, see Setting the Language .

Procedure

1. On the Options dialog, click the Display icon in the left pane.

2. In the Language section, select the desired language:

A particular language appears in this list only if the “language pack” for that language has been
installed on your system, or the appropriate files have been manually translated (for details, see the
TIBCO Workspace Configuration and Customization guide).

3. Click OK to save the changes and close the Options dialog.

The language change takes effect immediately, and is persisted (i.e., the application will continue to
be displayed in the selected language until it is changed again, either using this user option, or the
Language field drop-down list on the main toolbar).

Note that the language setting on the Options dialog does not have a corresponding
setting in the Options record in the config.xml file. Workspace gets the initial default
language from the browser you are using to run Workspace.

Initial Display
The Initial Display user option allows you to specify which list is initially displayed when you log in:
work views, process views, or event views.

Procedure

1. On the Options dialog, click the Display icon in the left pane.

2. In the Initial Display section, select the desired list type.

3. Click OK to save the changes and close the Options dialog.

Default View
The Default View user option allows you to specify which specific view should be initially displayed
when the view lists are displayed.

Procedure

1. On the Options dialog, click the Display icon in the left pane.
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2. In the Default View section, choose the desired default views in the Default Work View and
Default Process View drop-down lists:

3. Click OK to save the changes and close the Options dialog.

Result

Note that if you select a view as the default view, then that view is subsequently removed, the view at
the top of the default view drop-down list is automatically selected as the new default view (the default
view drop-down list shows views in chronological order by when they were created).

Captions
The Captions user option allows you to specify whether names or descriptions of views are displayed
in the list after selecting a view.

Procedure

1. On the Options dialog, click the Display icon in the left pane.

2. In the Captions section, click the appropriate options to display either names or descriptions in the
caption for each of the list types.

3. Click OK to save the changes and close the Options dialog.

Times
The Times user option allows you to specify whether or not milliseconds are displayed in date/times in
the work item, process instance, and event lists, as well as on the Filter dialogs for those lists.

Note that this option does not cause milliseconds to be displayed in data/times in the work item
summary nor the process instance summary:

Procedure

1. On the Options dialog, click the Display icon in the left pane.
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2. In the Times section, check the Show Milliseconds check box if you would like milliseconds
displayed in date/times in the work item and process instance lists:

3. Click OK to save the changes and close the Options dialog.

Work Item Options
The Work Item options affect how work items are displayed in Workspace.

● Auto-Refresh - Specifies whether or not the auto-refresh feature on work item lists should be
enabled or disabled by default.

● Work Item Preview - Specifies the default setting of the Preview feature on the work item list.

● Work Item Forms - Specifies the type of window in which work item forms are opened.

Auto-Refresh
The Auto-Refresh option allows you to specify whether or not the auto-refresh feature on work item
lists should be enabled or disabled by default every time you log in. When enabled, work item lists are
automatically refreshed at a specified interval.

Note that this setting affects all work item lists except those on which the auto-refresh feature was set
for that individual list. For information about enabling/disabling the auto-refresh feature on individual
work item lists, see Auto-Refresh of Work Item Lists.

Procedure

1. On the Options dialog, click the Work Items icon in the left pane.

2. In the Auto-Refresh section, either check (to enable) or uncheck (to disable) the Auto-refresh lists
of work items check box to specify the default behavior of the auto-refresh feature whenever you
log in:

3. If you checked the Auto-refresh lists of work items check box, in the Auto-refresh interval field,
specify the auto-refresh interval, in seconds. The minimum allowed is 30 seconds.

4. Click OK to save the changes and close the Options dialog.
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Work Item Preview
The Work Item Preview user option specifies the default setting of the Preview feature on work item
lists, which specifies whether or not work item forms are displayed in the preview pane or in a floating
window.

When the default preview setting is specified in user options, it causes all work item lists to take on that
setting. You can then change the preview setting for an individual work item list by selecting Preview
from the View menu on the work item list. The following dialog is displayed:

Changing the preview setting using the menu shown above causes only the currently displayed work
item list to take on that setting. All others will continue to use the default setting in user options.

Changes made to individual work item lists are persistent — the setting for that specific work item list
is remembered between logins. Also note that persisted settings are saved on the server, so if you log
onto a different machine, those settings will be in effect on that machine also.

Note, however, if you change the preview setting for an individual work item list, then change the
default setting in user options, it will override the individual work item list setting. In other words, a
new preview setting in user options applies to all work item lists, even those that had been set
individually.

For more information about the Preview feature, see Introduction.

Procedure

1. On the Options dialog, click the Work Items icon in the left pane.

2. In the Work Item Preview section, select the option you would like to be set as the default for the
Preview feature on the work item list:

Notice that if you choose Show preview - dock work item forms in preview pane, additional
options are displayed (as shown above) that allow you to specify whether or not the preview pane
is automatically resized when a work item is opened in the preview pane. If you choose to resize the
preview pane, also enter a percentage (from 1% - 100%) in the % Percentage of viewing area ...
field; this specifies the amount of the viewing area the preview pane will encompass when a work
item is open. When you close the work item, the preview pane reverts to its previous size.

3. Click OK to save the changes and close the Options dialog.
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Work Item Forms
The Work Item Forms user option specifies the type of window in which work item forms are opened.
They can be opened in either a dialog or a separate browser window.

For information about the differences, see Floating Windows.

Note that this is applicable only if you are opening work item forms in a floating window; it is not
applicable if you are opening work item forms in the preview pane. For information about the preview
pane, see The Preview Pane.

Also note that you may or may not be able to control whether forms are opened in a dialog or separate
browser window using this user option, depending on the setting of an attribute in the application’s
configuration file. An administrator can set an attribute that forces work item forms to open in a dialog,
which causes this user option to be inoperable.

If workspace is configured to open work item forms in a separate browser window, but a pop-up
blocker or an error condition prevents the window from opening, the form will instead automatically
be opened in a dialog.

Procedure

1. On the Options dialog, click the Work Items icon in the left pane.

2. In the Work Item Forms section, select whether you want work item forms to open in a dialog or a
separate browser window:

3. Using the Default position and size... fields and check boxes, specify how you want the floating
work item form positioned:

You can:

● check the Full Screen check box to make the floating window/dialog full screen,
● check the Center check box to center the floating window/dialog, or
● uncheck both boxes to position the floating window/dialog anywhere on the screen.

4. If you have checked the Center check box, or unchecked both Center and Full Screen, optionally
enter values in the Left, Top, Width, and Height fields to specify the window/dialog position, in
pixels.

5. Optionally check the Remember Floating Window Position check box to specify you want the
system to remember the size and position of the window/dialog if you manually move it on your
screen.

If this check box is checked, the application will remember if you manually resize and/or re-position
the window/dialog on your screen, and will size and position future floating windows/dialogs to
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that location/size. Note, however, that it will remember this only until you restart the application.
Once it is restarted, the application will place floating windows in the size/position specified in the
Default position and size... fields.

If this check box is not checked, future windows/dialogs will all open in the position and size
specified by the Default position and size... fields — it does not remember the size and location of
windows you have manually resized/repositioned.

6. Click OK to save the changes and close the Options dialog.

Business Service Options
Business Service user options affect how you view business services.

● Recently Started Services - Specifies the number of recently started business services to display
under the Recent heading in the list of business services.

● Business Service Forms - Specifies the type of window in which business service forms are opened
— docked or floating.

Recently Started Services
The Recently Started Services user option allows you to specify how many recently started business
services should be displayed in the Recent heading in the business service list.

Procedure

1. On the Options dialog, click the Business Services icon in the left pane.

2. In the Recently Started Services section, select a number (0 - 10) to specify the maximum number of
business services you want displayed in the business service list:

3. Click OK to save the changes and close the Options dialog.

Business Service Forms
The Business Service Forms user option specifies the type of window in which business service forms
are opened.

Procedure

1. On the Options dialog, click the Business Services icon in the left pane.

2. In the Business Service Forms section, specify whether business service forms are to be docked in
the right pane, or whether they should be floating.
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If you choose to docked the forms, there is no more to specify — you can proceed to step 7.

If you choose to float the business service forms, additional options and fields are displayed,
allowing further specification of the business service forms — continue with the remainder of the
steps.

3. Select whether you want business service forms to open in a dialog or a separate browser window:

4. Using the Default position and size... fields and check boxes, specify how you want the floating
business service form positioned:

You can:

● check the Full Screen check box to make the floating window/dialog full screen,

● check the Center check box to center the floating window/dialog, or

● uncheck both boxes to position the floating window/dialog anywhere on the screen.

5. If you have checked the Center check box, or unchecked both Center and Full Screen, optionally
enter values in the Left, Top, Width, and Height fields to specify the window/dialog position, in
pixels.

6. Optionally check the Remember Floating Window Position check box to specify you want the
system to remember the size and position of the window/dialog if you manually move it on your
screen.

If this check box is checked, the application will remember if you manually resize and/or re-position
the window/dialog on your screen, and will size and position future floating windows/dialogs to
that location/size. Note, however, that it will remember this only until you restart the application.
Once it is restarted, the application will place floating windows in the size/position specified in the
Default position and size... fields.

If this check box is not checked, future windows/dialogs will all open in the position and size
specified by the Default position and size... fields — it does not remember the size and location of
windows you have manually resized/repositioned.

7. Click OK to save the changes and close the Options dialog.

Event Options
The Event user options affect how you view events in Workspace.

● Event Paging Model - Specifies whether or not a total count of events is retrieved from the server
and displayed in the list of events.
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Event Paging Model
The Event Paging Model user option is used to turn on or off the total count in the list of events.
Turning off the count provides improved performance if there are a large number of events.

Procedure

1. On the Options dialog, click the Events icon in the left pane.

2. Check the Retrieve Count of Events box to cause the total count to be retrieved from the server and
appear on the list of events. Uncheck the box to not retrieve the count.

3. Click OK to save the changes and close the Options dialog.

Appearance Options
The Appearance user options affect how components appear on the screen.

● Layout - Specifies the orientation and location of components on the Workspace screen.

● Font - Used to change the size of the font in the application.

Layout
This user option specifies which of the three layout schemes is used.

● Side-by-side - All lists are docked on the left and the right, and the view selection buttons are
displayed in the lower left part of the screen.

● Stacked - All views are displayed on the top of the screen, as tabs, and work item, process instance,
business service, and event lists are displayed on the bottom part of the screen.

● Floating Windows - All lists are displayed as floating windows. For each floating window, a button
is displayed in the task bar, which when clicked, brings the corresponding window to the front.

For more information about screen layouts, see The Workspace Screen Layout.

Procedure

1. On the Options dialog, click the Appearance icon in the left pane.

2. In the Layout section, select the appropriate option for the layout you want to use.

3. Click OK to save the changes and close the Options dialog.

Font
This user option specifies the size of the font in the application.

Procedure

1. On the Options dialog, click the Appearance icon in the left pane.

2. In the Font section, choose the size of the font you want displayed.
The font size in the Font section changes as you choose different font sizes so that you can see what
it looks like; to see the change in the rest of the application, you must log out, then log back in.

Also notice that one of the font size options is "Default". This selection causes the application to use
the font size that is currently specified in the workspaceCSS.xml file. By default, the font size in this
file is set to "Small," but it is possible that that file has been modified.

3. Click OK to save the changes and close the Options dialog.
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4. Log out of the application, then log back in to have the change take effect.
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Starting a Process

Processes are typically started via a business service — they are not normally started directly, although
the ability to do that is provided.

Directly starting an instance of a process would normally be performed by an administrator. For that
reason, the Start Process Instance button is not displayed in Workspace by default. For the button to be
displayed, the logged-in user must have the appropriate user access privilege.

Starting an Instance of a Process
Starting an instance of a process results in initiating the first task of the process. This typically results in
one or more work items being sent to one or more work lists.

The process instance is considered complete when the final task in the process is completed.

Procedure

1. Click the Start Process Instance button in the upper-left part of the Workspace screen:

This causes an Open selection to appear in a drop-down menu.

Note that once you start an instance of a process template, the name of that template may also
appear in the drop-down menu. For example:

This allows you to more easily start an instance of a process template that you commonly work
with.

2. Select the menu item Open.

The Start Process Instance dialog is displayed:
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This dialog lists all process templates to which you have access for starting instances.

Process templates that have start parameters are not shown in this list because those
processes cannot be started directly — they can be started by business services, which will
be supported in a later release of Workspace.

By default, the number of available process templates that can be listed is limited to 500.
To increase this number, change the value of the property
com.tibco.bx.management.queryMaxResultSize, as explained in the TIBCO ActiveMatrix
BPM Administration guide.

If needed, you can refresh the list by either clicking the refresh button or by selecting Refresh
Processes from the View menu.

3. Select the desired process template from the list by clicking it to highlight it.

4. Click Start to start an instance of the selected process template.

The instance of the template is started, possibly causing a work item to be sent to one or more work
item lists.

This also results in an entry being added to your process instance list. From the process instance list
you can view information about the process instance, including its progress through the process.
For information, see Process Instance List.
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